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Preface
Welcome to Cisco Policy Suite Mobile Configuration Guide. 

This document assumes a general understanding of network architecture, configuration, and operations. Instructions for 
installation and use of CPS and related equipment assume that the reader has experience with electronics and electrical 
appliance installation.

This document describes configuration tasks for the Cisco Policy Builder 7.5.0. The document assists installers, network 
operators, and network engineers to tune and configure the Cisco Policy Server 7.5.0 using the Cisco Policy Builder client 
interface. 

Audience 
This guide is best used by these readers:

 Network administrators

 Network engineers

 Network operators

 System administrators

This document assumes a general understanding of network architecture, configuration, and operations. 

Additional Support
For further documentation and support: 

 Contact your Cisco Systems, Inc. technical representative.

 Call the Cisco Systems, Inc. technical support number.

 Write to Cisco Systems, Inc. at support@cisco.com.

 Refer to support matrix at http://www.support.cisco.com and to other documents related to Cisco Policy Suite.

Terms and Definitions
This document uses certain terms and definitions specific to the CPS software application. For common Glossary of 
Terms, refer to http://wwwin.cisco.com/tech/EngCoE/cpdm/glossary.shtml. 

Version Control Software
Cisco Policy Builder uses version control software to manage its various data repositories. The default installed version 
control software is Subversion, which is provided in your installation package.
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Conventions (all documentation)
Conventions (all documentation)
This document uses the following conventions. 

Note: Means reader take note. Notes contain helpful suggestions or references to material not covered in the manual.

Caution: Means reader be careful. In this situation, you might perform an action that could result in equipment 
damage or loss of data.

Warning: IMPORTANT SAFETY INSTRUCTIONS

Means danger. You are in a situation that could cause bodily injury. Before you work on any equipment, be aware of 
the hazards involved with electrical circuitry and be familiar with standard practices for preventing accidents. Use 
the statement number provided at the end of each warning to locate its translation in the translated safety warnings 
that accompanied this device.

SAVE THESE INSTRUCTIONS

Regulatory: Provided for additional information and to comply with regulatory and customer requirements. 

Obtaining Documentation and Submitting a Service Request
For information on obtaining documentation, using the Cisco Bug Search Tool (BST), submitting a service request, and 
gathering additional information, see What’s New in Cisco Product Documentation at: 
http://www.cisco.com/c/en/us/td/docs/general/whatsnew/whatsnew.html.

Subscribe to What’s New in Cisco Product Documentation, which lists all new and revised Cisco technical 
documentation as an RSS feed and delivers content directly to your desktop using a reader application. The RSS feeds 
are a free service.

Conventions Indication

bold font Commands and keywords and user-entered text appear in bold font.

italic font Document titles, new or emphasized terms, and arguments for which you supply values are in 
italic font.

[   ] Elements in square brackets are optional.

{x | y | z } Required alternative keywords are grouped in braces and separated by vertical bars.

[ x | y | z ] Optional alternative keywords are grouped in brackets and separated by vertical bars.

string A nonquoted set of characters. Do not use quotation marks around the string or the string will 
include the quotation marks.

courier font Terminal sessions and information the system displays appear in courier font.

<   > Nonprinting characters such as passwords are in angle brackets.

[   ] Default responses to system prompts are in square brackets.

!, # An exclamation point (!) or a pound sign (#) at the beginning of a line of code indicates a 
comment line.
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First Published: June 26, 2015

Last Updated: August 14, 2015

This chapter covers the following sections:

 Overview, page 5

 Reference Data, page 6

 Services, page 7

 Policies, page 7

 Accessing the Policy Builder, page 8

Overview
Cisco Policy Suite (CPS) provides a framework for building rules that can be used to enforce business logic against policy 
enforcement points such as network routers and packet data gateways. For example, a prepaid customer (one who pays 
as they go) might be denied service or prompted to top-up when their quota has expired, whereas a postpaid customer 
(one who has an ongoing billing relationship with the service provider) might only have their service downgraded or be 
automatically billed for additional data when their particular quota has expired. 

CPS allows service providers to create policies that are customized to their particular business requirements through the 
use of the CPS Policy Builder, a web-based tool with a graphical user interface (GUI) that allows for rapid development 
of innovative new services.
5
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Reference Data
The Policy Builder GUI supports both configuration of the overall CPS cluster of virtual machines (VMs) as well as the 
configuration of services and advanced policy rules. The following sections introduces the main aspects of the PB GUI 
as laid out in three tabs on the upper right of the interface: Reference Data, Services and Policies.

Reference Data
The Reference Data tab of the PB GUI provides access for configuring various aspects of the system in order to make 
the system ready for operation. Reference Data are used to not only configure the system, but are also used to provide 
settings and parameters that are referenced by policy rules across various services; For example, Account Balances and 
Notifications are configured as Reference Data but are then referenced and reused by multiple services as needed. 
Details of the various Reference Data configuration options are described in more detail in other chapters of this guide. 

The Reference Data tab contains static system, network, and template definition. It is not directly related to policy, 
services, or use cases, but does define the reference points for the following types of information:

 Systems, cluster, and instance data

 Jdbc query string definitions

 Balance and quota definitions

 Diameter agents, clients, and defaults information

 Query strings

 Customer reference data tables (custom look up tables such as apn names)

 Notification addresses and text templates

 Policy reporting criteria

 Subscriber data repositories

 Tariff switch times
6
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Services
 Fault list - For more information, refer to CPS Operations Guide for this release.

Services
The Services tab allows for creation of reusable policy rules that control how subscribers are granted network services, 
quota and notifications. Services are broken down into three core areas: Domains, Services and Use Case Templates. 
The following section provides an overview of the Services tab, however detailed instructions on how to build a service 
are covered in later chapters of this guide. 

The creation of a new service begins with creating a Use Case Template (UCT) for the service. UCTs are comprised of 
Service Configurations specific to the service that will be created. For example, a Service Configuration might provide 
for the setup of a Gx Rule or Basic QoS. The UCT is also used to configure Use Case Initiators (UCI) which are instructions 
on when a specific Service Configuration should be in effect. An example of the UCI might be “only send this Gx Rule 
when the account balance is depleted”. Multiple UCIs can be configured for each Service Configuration allowing for 
complex logic as to when the configuration should or should not be in effect.

Once a UCT and associated UCIs are defined, it becomes the basis for Service Options, which are specific instances of 
the UCT that are populated with data specific to the service. Multiple Service Options can be created from a single UCT, 
for example, a UCT that provides for passing QoS parameters can be reused with different QoS values for different 
customers. Multiple Service Options can be layered to create the end Service. 

The Domains panel within the Services tab handles the initial interaction of the client device with the policy engine, and 
covers tasks including client authentication, default provisioning of unknown clients and qualifying a client for particular 
system defaults and services.

For more information on Services tab, refer to Services, page 161.

Policies
While the Services tab, via Use Case Templates and Service Options, makes it easy to create reusable and extensible 
services, the Policies tab allows direct access to the underlying policy engine. The Policies tab holds the CPS core 
system “Blueprint” which is composed of various “Extension Points” that break the policy engine flow into sections that 
occur within the execution of the policy. For example, the point in the policy flow where a Gx connection is received and 
parsed occurs and is processed before the point in the policy flow where the related subscriber data is evaluated.

Within the various Extension Points are “Policies” that define “Conditions” (events and data from the policy flow and 
external systems) that can then trigger “Actions” (manipulation of data and communication back to external systems). 
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Accessing the Policy Builder
Note that the configuration of services for most deployments will be handled through use of the Reference Data and 
Services tabs; advanced policies as defined on the Policies tab and discussed above are only required for complex 
deployments. It is recommended that only experienced users access the Policies tab as misconfiguration of custom 
policies can have negative impact on the operation of the system. Detailed discussion of custom policies is outside of 
the scope of this document.

Summary of Policy Tab Capabilities
 Conditional rules within specified Extension Points (Condition/Action)

 Trigger specific actions from an extensive catalog of Use Case Initiators

 Evaluate and manipulate session data as part of making policy decisions and returning services data to downstream 
systems

Advantages
 Allows for handling complex policy situations without writing custom code

 Support for custom or unusual business rules 

Considerations
 Building custom policies requires a deep understanding of the call flow and underlying CPS platform 

 Due to the flexibility of the Policy Builder, it is possible to create conflicting policies that can have a negative impact 
on system performance

Accessing the Policy Builder
The Policy Builder is the web-based client interface for the configuration of policies to the Cisco Policy Suite. Initial 
accounts are created during the software installation with the default CPS install username qns-svn and password 
cisco123. 

URL to Access Interface
 For HA: https://lbvip01:7443/pb

 For AIO: http://aio_ip:7070/pb
8
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This chapter covers the following sections:

 Overview, page 9

 Policy Builder Repository Configuration, page 9

 System Configuration, page 21

Overview
The Cisco Policy Suite provides the Policy Builder as an interface for policy management. Policies translate a Service 
Provider’s business rules into actionable, logical processing methods that the Cisco Policy Suite enforces on the network.

The Cisco Policy Suite ships with some standard base policies that serve as a starting point for customization to suit a 
Service Provider's specific business rules.

Policy Builder Repository Configuration
This section covers the following topics:

 Default Repositories, page 10

 Adding a Client Repository Definition, page 11

 Editing a Client Repository Definition, page 13

 Removing a Client Repository Definition, page 13

 Saving Policy Builder Configuration Data to a Client Repository, page 14

 Publishing the Client Repository, page 14

 Adding a Runtime Repository Definition, page 16

 Editing a Runtime Repository Definition, page 17

 Removing a Runtime Repository Definition, page 17

 Saving Policy Builder Configuration Data to a Runtime Repository, page 17

 Switching to a Different Client Repository, page 18

 Reverting Changes, page 18

The Policy Builder uses a Subversion version control repository to store the configuration data created in the UI. The data 
entered in the UI is translated into XML (Eclipse Modeling Framework xmi files) when saved.
9

Cisco Systems, Inc.      www.cisco.com



Basic Systems Configuration

 

Policy Builder Repository Configuration
As work is done in the UI, changes are saved to a temporary directory on the pcrfclient01. (The directory is specified in 
the Repository configuration dialog.) Therefore, you can log out and back in and the latest changes will remain. However, 
if someone else makes a change and commits, then your local changes are lost.

There are two options for saving configuration changes.

 Publish to Runtime

 Save to Client Repository

When saving to the client repository, the configuration is pushed to Subversion, but it is saved in a client only repository 
and not copied over to the runtime environment repository. If you 'Publish to Runtime', the configuration is saved to the 
client repository and also copied to the runtime environment repository. The CPS servers check the runtime environment 
repository for changes and will update automatically when changes are committed.

Best Practices
Typically, publishing configuration changes to a lab environment to run tests is best. And then when satisfied with the 
test results, you can publish the new configuration to a production environment.

Revert
As Subversion is a source code tracking repository, each version of a configuration is numbered and stored in the 
Subversion repository history. Therefore, it is also possible to revert to any version of a configuration. The Policy Builder 
does not have a way to do this via the GUI, but using the Subversion command line tools, any version of the configuration 
can be made the current revision. For more information, refer to Subversion documentation for how to use the command 
line tools.

Default Repositories
The 7.x deployment installs Subversion and creates a default client and runtime repository. The Subversion repositories 
are synced using Subversion's Master/Slave replication between the pcrfclient01 and pcrfclient02 nodes.

 Client - http://pcrfclient01/repos/configuration

 Runtime - http://pcrfclient01/repos/run
10
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Policy Builder Repository Configuration
The Policy Builder start screen shows a dialog that lets you define repositories and chose a repository to check out for 
editing. A repository definition named “Repository” is installed by default and uses the default Client repository 
(http://pcrfclient01/repos/configuration). The default PB user (qns-svn) with the default password is also setup. 

Adding a Client Repository Definition
1. Start the Cisco Policy Builder interface. 

2. At the Choose Policy Builder data repository... screen as shown below, use the drop-down list and select Add a 
New Repository.
11
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Policy Builder Repository Configuration
3. The Repository window appears.

The following parameters can be configured under Repository:

Table 1 Repository Parameters

Parameter Description

Name This required field uniquely identifies your repository's site with a name.

Recommendation: It is recommended to use the following format to name the 
repositories: customername_project_date, where underscores are used to separate 
customer name, project and date. Date can be entered in the format: MMDDYYYY.

Username and Password Enter a username that is configured to view Policy Builder data. The password can be 
saved for faster access, but it is less secure. A password, used in conjunction with the 
Username, permits or denies access to make changes to the repository.

Save Password Select this check box to save the password on the local hard drive. This password is 
encrypted and saved as a cookie on the server.

URL You can have several branches in the version control software to save different versions 
of configuration data. Create a branch in the version control software before assigning it 
in this screen.

Enter the URL of the branch of the version control software server that are used to check 
in this version of the data.
12
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Policy Builder Repository Configuration
Fill in the information according to your network requirements. 

4. Click OK to save your work to the local directory. 

Note: When you change screens, Cisco Policy Builder automatically saves your work. It is recommended to save your 
work to the local directory by clicking on the diskette icon or CTRL S on the keyboard. 

5. If you are ready to commit these changes to the version control software. View the Policy Builder main screen and 
select File > Save to Client Repository. 

Editing a Client Repository Definition
Use this procedure to change any of the following details of your Client Repository:

 Client repository name.

 Username, password, and password save mechanism.

 Client repository temporary save URL.

 Client repository local directory save file path.

1. Open a browser and enter the URL of the Cisco Policy Builder.

2. Use the drop-down list on the Choose Policy Builder data' screen to select the desired repository.

3. Click the Edit button.

4. View the Repository screen and make your changes.

5. Click OK to save the changes to the repository definition.

Removing a Client Repository Definition
This procedure removes a repository from Cisco Policy Builder. This procedure does not delete the actual Subversion 
repository, just the definition for access in the Policy Builder.

1. Open a browser and enter the URL of the Cisco Policy Builder.

Local Directory This value need not be changed.

This is the location on the hard drive where the Policy Builder configuration objects are 
stored in version control.

When you click either Publish or Save to Repository, the data are saved from this directory 
to the version control application specified by the URL above.

Validate on Close Select this check box to see if the values for Username, Password, or the URL are 
legitimate and unique. If not, the screen displays an error message and provides a chance 
to correct the errors.

Remove Removes the display of the repository in Cisco Policy Builder.

Note: The remove link here does not delete any data at that URL. The local directory is 
deleted.

Table 1 Repository Parameters

Parameter Description
13



Basic Systems Configuration

 

Policy Builder Repository Configuration
2. Use the drop-down list on the Choose Policy Builder data screen to select the desired repository.

3. Click Remove. A confirmation dialog appears.

4. Click OK to delete the repository.

Saving Policy Builder Configuration Data to a Client Repository
1. Open a browser and enter the URL of the Cisco Policy Builder.

2. Use the drop-down list on the Choose Policy Builder data screen to select the desired repository.

3. Click OK.

4. Make changes to Policy Configuration data as necessary.

5. Select File > Save to Client Repository...

6. Enter a commit message.

7. Click OK. The data will be saved to the client repository for later updating and publish to the runtime environment.

Publishing the Client Repository
To put changes into effect and have the Cisco Policy Builder server pick up the configuration changes made in you client 
session, use the Publish option and save the changes to the server repository. 

Note: To save the practice version, publish the client repository to the server. This is the version the server uses for 
production. 

Do not publish to the Cisco Policy Builder unless you are completely satisfied with the configuration data in your client 
repository. 

 Use the Cisco Policy Builder interface to either commit or set up a commit repository.

 Verify your work either by going to a web browser or by looking at the file config.properties. 

 Unpublish with an SVN delete and restore. 
14
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When you’re ready to put your Cisco Policy Builder changes into production, you’ll publish them to Subversion. This 
preserves version history.

1. To publish in Cisco Policy Builder, click File > Publish to Runtime Environment. Publish window appears.

2. If you have already set up the repository to publish to, just enter a commit message.

3. If you have not set up the repository, select Add New Repository from the Publish to: drop-down list and enter the 
required details for the new repository. For more information, refer to Adding a Client Repository Definition, page 11.

4. Verify the changes to Production repository:

— All changes are published to Subversion, so they are version-controlled and can be rolled back.

— To verify a publish as part of a troubleshooting process, take the URL seen in the previous screen and put it into 
a web browser (you may need to substitute the IP). The password is the same as in Cisco Policy Builder. 

— If a traditional web browser cannot access the system, you can use a command line browser from the CPS VM’s 
URL.
15
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Adding a Runtime Repository Definition
A repository definition named “Publish Repository” is installed by default and uses the default Runtime repository 
(http://pcrfclient01/repos/run). The default PB user (qns-svn) with the default password is also setup. The Runtime 
repository matches the value setup in the /etc/broadhop/qns.conf file. The qns.conf is read by all the active qns and lb 
nodes and when the qns process starts up, it checks out the configuration from the Runtime repository. 

1. Open a browser and enter the URL of the Cisco Policy Builder.

2. Use the drop-down list on the Choose Policy Builder data screen to select the desired repository.

3. Click OK.

4. Make changes to Policy Configuration data as necessary.

5. Select File > Publish to Runtime.

6. Use the drop-down list to select Add New Repository.

7. The Repository window appears. 

8. Enter the necessary values and click OK to save your work.

9. Enter a commit message and click OK to publish to the new repository or click Cancel to close the dialog.
16
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Editing a Runtime Repository Definition
1. Open a browser and enter the URL of the Cisco Policy Builder.

2. Use the drop-down list on the Choose Policy Builder data screen to select the desired repository.

3. Click OK.

4. Make changes to Policy Configuration data as necessary.

5. Select File > Publish to Runtime.

6. Use the drop-down list to select the desired repository.

7. View the Repository screen and make your changes.

8. Click OK to save the changes to the repository definition.

9. Enter a commit message and click OK to publish to the new repository or click Cancel to close the dialog.

Removing a Runtime Repository Definition
This procedure removes a runtime repository definition from the Cisco Policy Builder. This procedure does not delete the 
actual Subversion repository, just the definition for access in the Policy Builder.

1. Open a browser and enter the URL of the Cisco Policy Builder.

2. Use the drop-down list on the Choose Policy Builder data screen to select the desired repository.

3. Click OK.

4. Make changes to Policy Configuration data as necessary.

5. Select File > Publish to Runtime.

6. Use the drop-down list to select the desired repository.

7. Click Remove. A confirmation dialog appears.

8. Click OK to delete the repository.

9. Click Cancel to close the dialog.

Saving Policy Builder Configuration Data to a Runtime Repository
1. Open a browser and enter the URL of the Cisco Policy Builder.

2. Use the drop-down list on the Choose Policy Builder data screen to select the desired repository.

3. Click OK.

4. Make changes to Policy Configuration data as necessary.

5. Select File > Publish to Runtime.

6. Use the drop-down list to select the desired repository.

7. Enter a commit message.

8. Click OK. The data will be saved to the client repository for later updating and publish to the runtime environment.
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Switching to a Different Client Repository
You may have several variations of your client repository. One may reflect the configuration currently published to the 
server. Another might be developed for test purposes.

There are two ways to switch to a different repository:

 File > Switch Repository

 File > Exit

Reverting Changes
There are two main SVN repositories (repos) in the system. 

 Repository Policy Builder publish which contains ONLY the currently running set of policies. 

 Runtime repository Policy Builder which contains a copy of the currently running set of policies along with copies of 
all previous sets.

To rollback Policy Builder changes, there are two methods:

 Rollback the configuration repository Policy Builder and then perform a publish which is described in Unpublished 
Changes, page 18.

 Rollback the runtime repository Policy Builder uses and the configuration repository Policy Builder uses. For more 
information, refer to Published Changes, page 18

Unpublished Changes
If you do not want to save the changes, click the Revert link on the Policy Builder start screen. All changes that have not 
been committed to a repository will get removed.

1. Open a browser and enter the URL of the Cisco Policy Builder.

2. Use the drop-down list on the Choose Policy Builder data screen to select the desired repository.

3. Click the Revert link. A confirmation dialog appears.

Note: The Revert link is only available if there are uncommitted local changes.

4. Click OK to revert changes to the repository definition.

Published Changes
1. Check the configuration repository name Policy Builder uses (config_repo). To check the name, use the following 

steps:

a. Open a browser and enter the URL of the Cisco Policy Builder.
18
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b. In the pop-up where you connect, click the Edit.

c. This will give you a Repository pop-up window as shown below. Look at the Url to see the repository name used 
by the Policy Builder. In this example it is configuration.

d. Record the Policy Builder repository name (config_repo). In this example it is configuration.

2. To locate the ‘r’ number in the repository used by Policy Builder, execute the following command:
19
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Note: The <config_repo> value comes from Step d. on page 19.

svn log http://pcrfclient01/repos/<config_repo> | more

Example of the svn log command where <config_repo> is configuration as shown in d. on page 19.

svn log http://pcrfclient01/repos/configuration | more
------------------------------------------------------------------------
r367 | qns-svn | 2015-06-18 12:15:34 -0600 (Thu, 18 Jun 2015) | 1 line

second try
------------------------------------------------------------------------
r364 | qns-svn | 2015-06-17 15:46:19 -0600 (Wed, 17 Jun 2015) | 1 line

corrected java issue
------------------------------------------------------------------------
r361 | qns-svn | 2015-06-16 15:38:28 -0600 (Tue, 16 Jun 2015) | 1 line

Added new Policies
------------------------------------------------------------------------
r358 | qns-svn | 2015-06-16 15:06:57 -0600 (Tue, 16 Jun 2015) | 1 line

""
------------------------------------------------------------------------
r355 | qns-svn | 2015-06-16 14:58:41 -0600 (Tue, 16 Jun 2015) | 1 line

""
------------------------------------------------------------------------
r352 | qns-svn | 2015-06-16 14:52:29 -0600 (Tue, 16 Jun 2015) | 1 line

a. In the above example the comment we are looking for is in r361 which is the ‘r’ number we want to rollback to.

b. Record the config_repo ‘r_number’. In this example, it is r361.

3. Execute the following command to delete the current version from the configuration repository Policy Builder uses:

Note: Use the <config_repo> value from Step d. on page 19.

svn delete http://pcrfclient01/repos/<config_repo> -m ‘deleting for rollback’

Example of the svn delete command where <config_repo> is configuration.

svn delete http://pcrfclient01/repos/configuration -m ‘deleting for rollback’

4. Execute the following command to restore the Policy Builder configuration repository to a previous version.

Note: The <r_number> value is from Step a. on page 20 and the <config_repo> value is from Step d. on page 19. 
The ‘-m’ option should be used to add a comment indicating what is being done.

svn cp http://pcrfclient01/repos/<config_repo>@<r_number> http://pcrfclient01/repos/<config_repo> 
-m ‘rolling back to <r_number>’

Example of the svn copy command with the <r_number> set to 361 and the <config_repo> is set to configuration:

svn cp http://pcrfclient01/repos/configuration@361 http://pcrfclient01/repos/configuration -m 
‘rolling back to 361’

5. Execute the following command to verify the rollback was successful.

Note: The <config_repo> value is from Step d. on page 19.

svn log http://pcrfclient01/repos/<config_repo> | more

Example of the svn copy command:
20
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svn log http://pcrfclient01/repos/configuration | more
----------------------------------------------------------------------
r367 | qns-svn | 2015-06-18 12:15:34 -0600 (Thu, 18 Jun 2015) | 1 line
rolling back to 361
-----------------------------------------------------------------------

Note: The output should have the ‘-m’ text entered in Step 4. on page 20 as the comment.

6. Open Policy Builder and verify the polices to which we have rolled back to. Normally the customer should be able to 
verify the policies in Policy Builder.

7. Perform a publish in Policy Builder and make sure to add a comment indicating the publish is being done to complete 
the rollback. For example, “publishing to complete rollback to <r_number>”.

System Configuration
The Systems node in the Reference Data tab represents the Cisco Policy Suite runtime environment as it exists in the 
network environment.

 System: There must always be at least one system defined in the Policy Builder. The system represents the customer 
deployment. In HA, the system represents a set of PCRF clusters that share the same session database. System is 
used to define any common things across the clusters, such as load balancing, etc. 

 Cluster: Each system contains 1 or more clusters - each of which represents a single High-Availability (HA) site 
environment. A cluster is used for define the configurations related to the blades. A cluster shares the same set of 
policy directors (that communicates as a group). A customer can take a fully installed PCRF and replicate it to a 
second cluster.

Each cluster can contain node instances. A node instance corresponds to a physical node in a deployment cluster 
such as a session manager or load balancer. It is very rare that a deployed system needs to have node instances 
configured in the Policy Builder. Configurations flow downhill, meaning that if you define a Plugin Configuration for 
Unified API at the system level, each cluster and subsequently each instance gets that configuration by default.

There are two types of clusters: HA and GR. This document discusses HA clusters. For information related to GR 
clusters, refer to CPS Geographical Redundancy Guide for this release.

Note: In an HA environment you should not make any configuration in Cluster node.

Plug-in configuration done at cluster level overrides the same definition at system level. For example, if you configure 
Customer Reference Data at cluster level, it will override the Customer Reference Data configuration done at system 
level.

There is a default deployment configuration for mobile and wi-fi deployments. system-1 is the default system name and 
cluster-1 is the default cluster name.

if a customer wants to change the system name, they need to change it in qns.conf (/etc/broadhop/qns.conf) file 
also to reflect it in Policy Builder. 

-Dcom.broadhop.run.systemId=<system name>

This section covers the following sections: 

 Adding a System, page 22

 Adding a HA Cluster, page 24
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Adding a System
After installation, use this procedure to set up your Cisco Policy Builder by using an example populated with default data. 
You can change anything that does not apply to your deployment. 

1. Click Reference Data tab > Systems node to display the Systems tree.

2. Click System... under Create Child: to open System pane on the right side.

3. Fill in the Name and provide a description of this system. Enter the rest of the parameters based on your network 
requirements.

Table 2 System Parameters

Parameter Description

Name The name of the CPS system. 

Description Description of this entire system.

Session Expiration Hours If no messages are received in x hours, the session will be removed. 

Default value is 8. 
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4. If the created system needs to be used, then after publishing, following property needs to be updated in qns.conf 
configuration file.

-Dcom.broadhop.run.systemId=<system name>

where, <system name> is the system name defined in the above section.

Soft Delete Session
A soft delete session is an entry in the session database which maintains session data after session stop with an 
auto-generated unique primary key, but still maintains needed secondary keys. This allows messages which come after 
session stop to still be processed while also allowing a session with the same primary key to be immediately created. 
The CPS code determines when soft delete sessions are required and what secondary keys are needed.

Soft Delete Example (Mobile) 
A Gx session with a Gy associated session exists. A Gx CCR-T is received that terminates the CPS session, resulting in 
a soft-delete session which contains Gy session information and associated Gy secondary keys. A Gy CCR-t is received 
and the soft-delete session is loaded and updated with the charging information through the end of the session. After 
the soft delete timeout, the soft delete session is removed.

Session Expiration Minutes If no messages are received in x minutes, the session will be removed.

Default value is 0.

Timeout for Unknown Session Time in minutes hat CPS keeps a session alive after the subscriber logs off. With 
this, other network entities involved in the session can let the session close 
gracefully.

Default value is 0.

Timeout For Soft Delete Determines the time in seconds during which a 'soft delete' session is maintained 
for a CPS session after session stop. 

Default value is 30. 

Enable Multi Primary Key Select this check box to allow two primary keys to be utilized by maintaining a map 
of each separate primary key and storing the 'true' multi-primary key as a UUID 
related to the two maps. Changing this setting has a negative performance impact 
and should only be done at the request of the BU. Recommendation is to keep 
Enable Multi Primary Key unchecked.

Default is unchecked. 

Cluster link Click this link to create a cluster under this system.

Current System Link Click this link to make a copy of this system, with its clusters and instances.

Table 2 System Parameters

Parameter Description
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Adding a HA Cluster
At install time, a system, cluster, and instance are set up. If you need to change the cluster definition, or want to add 
others, use these steps. 

1. Begin with a system at the Systems node in the Reference Data tab. 

2. Click the Cluster link to set up your first cluster. 
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As some data are relevant at the cluster level, you always have at least one cluster, even if it is a cluster of one 
instance. 
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The following parameters can be configured for Cluster.

Table 3 Cluster Parameters

Parameter Description

Name The name of the cluster. This name must correspond to the value stated in the config.ini file 
on the Cisco Policy Server.

Description A brief description of the cluster.

Db Write Concern Controls the write behavior of sessionMgr and for what errors exceptions are raised. Default 
option is OneInstanceSafe. For more information, refer to mongo db documentation.

Failover Sla Ms This parameter is used to enter the amount of time to wait before starting failover database 
handling. The time is in milliseconds.

Replication Wait Time This option specifies a time limit, in milliseconds, for the write concern. This parameter is 
applicable only if you select TwoInstanceSafe in Db Write Concern.

This parameter causes write operations to return with an error after the specified limit, even 
if the required write concern eventually succeeds. When these write operations return, 
MongoDB does not undo successful data modifications performed before the write concern 
exceeded the replication wait time limit. This time is in milliseconds.

Trace Db Size Mb Determines the size in MegaBytes of the policy_trace database capped collection. 

Default value is 512.

Min Key Cache Time 
Min

The minimum amount of time in minutes to keep a secondary key for a session. 

Default value is 2000.

Max Timer T P S Default value is 2000.

Broadcast Msg Wait 
Timer Ms

The amount of time in milliseconds for the Policy Engine to wait between sending each 
Broadcast Policy Message.

Default value is 50. 

Max Sessions Per 
Shard

This is the maximum number of shard per session.

Lookaside Key Prefixes To improve Gx/Rx lookup and caching performance, we can add the lookaside key prefixes. 
For more information, refer to Lookaside Key Prefixes, page 27.

Admin Database 

Primary Database IP 
Address

The IP address of the Session Manager database that holds session information for Cisco 
Policy Builder and Cisco Policy Server.

Secondary Database IP 
Address

The IP address of the database that provides fail over support for the primary database. 

This is the mirror of the database specified in the Primary IP Address field. Use this only for 
replication or replica pairs architecture. This field is present but deprecated to maintain 
downward compatibility.

Port Port number of the database for Session data. By default, the value is 27717.

Endpoint Database

Primary Database IP 
Address

The IP address of the Session Manager database that holds session information for Cisco 
Policy Builder and Cisco Policy Server.

Secondary Database IP 
Address

The IP address of the database that provides fail over support for the primary database. 

This is the mirror of the database specified in the Primary IP Address field. Use this only for 
replication or replica pairs architecture. This field is present but deprecated to maintain 
downward compatibility.

Port Port number of the database for Session data. By default, the value is 27717.
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Lookaside Key Prefixes
In order to identify the correct shard for subscriber lookup/query, the PCRF needs to know the secondary key (which is 
internally stored in secondary key cache) for mapping and the exact shard that will be queried for subscriber data. This 
helps prevent the system from scanning/querying all the available shards in the system to fetch the subscriber record. 
Reducing the data range for scanning/querying leads to enhanced system performance.

The following four keys should be added so that the secondary keys for session binding are stored in the secondary key 
cache.

 diameter

 RxTGPPSessionKey

 FrameIpv6

 USuMSubscriberIdKey - This key should be added only when SPR is used.

 MSBMSubscriberIdKey - This key should be added only when balance is used.

Trace Database

Primary Database IP 
Address

The IP address of the sessionmgr node that holds trace information which allows for 
debugging of specific sessions and subscribers based on unique primary keys. 

Secondary Database IP 
Address

The IP address of the database that provides fail over support for the primary database. 

This is the mirror of the database specified in the Primary IP Address field. Use this only for 
replication or replica pairs architecture. This field is present but deprecated to maintain 
downward compatibility.

Port Port number of the database for Session data. By default, the value is 27717.

Data Centre Deprecated

Common Time 
Changes

Deprecated

Table 3 Cluster Parameters

Parameter Description
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This would prevent the system from scanning/querying all the available shards in the system to fetch the subscriber 
record which eventually leads to enhanced system performance.

3. From the Systems tree, open up the cluster that you just added and check the plug-in configurations.

Any of the configurations you specify here are used at the cluster level only and cascade down to the instance level 
if no configuration is set on the instance. 

At this point, the plug-ins are available to the cluster but are not configured. 

Click on any one of them to open the detailed page in the right pane, and check and set your own configuration data. 
However, there is rarely a need to use the Threading Configuration or the Async Threading Configuration unless 
instructed to do so. 

4. If the created cluster needs to be used, then after publishing, following property needs to be updated in qns.conf 
configuration file.

-Dcom.broadhop.run.clusterId=<cluster name>
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where, <cluster name> is the cluster name defined in the above section.

Adding an Instance
1. Begin with a Cluster at the Systems node in the Reference Data tab.

2. Under Create Child:, click Instance link to open Instance pane.

3. Fill in the Name and an a description. 

4. From the Systems tree, open up the instance node that you just added and check the plug-in configurations.

At this point, plug-ins are available but not configured at the instance level. 

Click on any one of them to open the detailed page in the right pane and check and set your own configuration data. 

Any of the configuration data you have here are used at the instance level, overriding any plug-ins set at the system 
level or the cluster level. 
29



Basic Systems Configuration

 

System Configuration
30



 

Plug-in Configuration
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Last Updated: August 14, 2015

This chapter covers the following sections:

 Overview, page 31

 Threading Configuration, page 32

 Async Threading Configuration, page 33

 Customer Reference Data Configuration, page 35

 Balance Configuration, page 36

 Diameter Configuration, page 39

 Voucher Configuration, page 42

 Unified API Configuration, page 43

 Notification Configuration, page 43

 Audit Configuration, page 45

 USuM Configuration, page 46

 LDAP Configuration, page 50

Overview
In CPS, reference data is considered information that is needed to operate the policy engine, but not used for evaluating 
policies. For example, under the Reference Data tab in Cisco Policy Builder, are the forms used to define systems, 
clusters, and instances, and to set times and dates used for tariff switching. The policy engine needs to refer to these 
data only to process policies correctly, but they do not define the policy itself.

Cisco Policy Builder provides core plug-ins for customizing and optimizing your installation. 

 Configurations set at the system level are system-wide except as noted in the bullet items below. 

 Configurations set at the cluster level apply to that cluster and the instances in it. A value set here overrides the same 
value set at the system level.

 Configurations set at the instance level apply to the instance only and override the same value set at the cluster or 
system level. 

Select the Create Child action in a Plug-in Configuration node in the Systems tree to define them. You can change any 
of the variables from the default, or choose not to use a plug-in, as necessary. 
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When you create a system from the example, the following configuration stubs appear at the cluster and instance level.

Threading Configuration
A threading configuration utility is provided for advanced users and future development.

Click Threading Configuration from right pane to add the threading configuration to the system. If you are planning to 
run the system with higher TPS, then you need to configure Threading Configuration. For further information, contact 
your Cisco Technical Representative. 

The Threading Plugin is for Mobility. The only value to set is “rules”. It controls the total number of threads in the Policy 
Engine that are executing at any given time. Default value is 50. 

Never set it below 50, but it can be set higher to help increase performance in certain situations. 
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An example configuration is shown below:

The following parameters can be configured under Threading Configuration:

Async Threading Configuration
You are always required to select this configuration, but no changes to it are necessary. Click Async Threading 
Configuration from right pane to add the configuration in the system.

Use the defaults for the Async Threading Plugin. Similar to the Threading Plugin, the Async configuration controls the 
number of asynchronous threads operating in the Policy Engine. The Policy Engine handles two basic types of messages 
- synchronous and asynchronous. Synchronous messages block and expect a response. Asynchronous messages are 
sent into the Policy Engine but do not expect a response and therefore the Policy Engine can defer those to worker 
threads that operate along side the main Policy Engine threading execution without causing too much traffic for 
performance.

Table 1 Threading Configuration Parameters

Parameter Description

Thread Pool Name Name of the Cisco thread pool.

Threads Threads to set in the thread pool. You can set Rules Thread to 50/100 depending on call 
flow (based on number of lookup and per transaction round trip time).

 rules = 50; Queue Size = 0; Scale By Cpu Core = unchecked

 rules = 100; Queue Size = 0 (If TPS is > 2000 per QNS depending on call model used 
e.g. if LDAP is enabled); Scale By Cpu core = unchecked

Queue Size Size of the queue before they are rejected.

Scale By Cpu Core Select this check box to scale the maximum number of threads by the processor cores.
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Note: Always select the link for Async Threading Configuration to configure your QPS system.

The following parameters can be configured under Async Threading Configuration.

Table 2 Async Threading Configuration

Parameter Description

Default Processing Threads The number of threads that are allocated to process actions based on priority.

Default Action Priority The priority assigned to an action if it is not specified in the Action Configurations 
table.

Default Action Threads The number of threads assigned to process the action if it is not specified in the 
Action Configurations table.

Default Action Queue Size The number of actions that can be queued up for an action if it is not specified in 
the Action Configurations table.

Default Action Drop Oldest 
When Full

When checked, the oldest queued action is dropped from the queue when a new 
action is added to a full queue. Otherwise, the new action to add is ignored.

This check box applies to all the threads specified in the fields above. To drop a 
specific thread, leave this unchecked and use the Action Configurations table.

Action Configurations Table

Action Name The name of the action. This must match the implementation class name.

Action Priority The priority of the action. Used by the default processing threads to determine 
which action to execute first.

Action Threads The number of threads dedicated to processing this specific action.

Action Queue Size The number of actions that can be queued up.

Action Drop Oldest When Full For the specified action only:

When checked, the oldest queued action is dropped from the queue when a new 
action is added to a full queue. Otherwise, the new action to add is ignored.
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Customer Reference Data Configuration
Before you can create a customer reference data table, configure your system to use the Customer Reference Data Table 
plug-in configuration.

You only have to do this one time for each system, cluster, or instance. Then you can create as many tables as needed.

Click Customer Reference Data Configuration from right pane to add the configuration in the system.

Here is an example:

 HA example: 

— Primary Database IP Address: sessionmgr01

— Secondary Database IP Address: sessionmgr02

— Database Port: 27717

 AIO example: 

— Primary Database IP Address: localhost or 127.0.0.1

— Secondary Database IP Address: NA (leave blank)

— Database Port: 27017

The following parameters can be configured under Customer Reference Data Configuration.

Table 3 Customer Reference Data Configuration

Parameter Description

Primary Database IP Address IP address of the primary sessionmgr database.

Secondary Database IP 
Address

Optional, this field is the IP address of a secondary, backup, or failover sessionmgr 
database. 
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Click Balance Configuration from right pane to add the configuration in the system.

Database Port Port number of the sessionmgr. It should be the same for both the primary and 
secondary databases.

Db Read Preference Read preference describes how sessionmgr clients route read operations to 
members of a replica set. You can select from the following drop-down list: 

 Primary: Default mode. All operations read from the current replica set primary.

 PrimaryPreferred: In most situations, operations read from the primary but if it is 
unavailable, operations read from secondary members.

 Secondary: All operations read from the secondary members of the replica set.

 SecondaryPreferred: In most situations, operations read from secondary 
members but if no secondary members are available, operations read from the 
primary.

For more information, refer to 
http://docs.mongodb.org/manual/core/read-preference/.

Connection Per Host Number of connections that are allowed per DB Host. 

Default value is 100.

Table 3 Customer Reference Data Configuration

Parameter Description
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The following parameters can be configured under Balance Configuration.

Table 4 Balance Configuration Parameters

Parameter Description

Balance Database Primary IP 
Address

IP address of the sessionmgr database.

Balance Database Secondary IP 
Address

Optional, this field is the IP address of a secondary, backup, or failover sessionmgr 
database. 

Database Port This is required. This is the port the Balance database uses, that is, the port of 
sessionmgr.

Db Write Concern Controls the write behavior of sessionmgr and for what errors exceptions are 
raised. Default option is OneInstanceSafe.

Db Read Preference Read preference describes how sessionmgr clients route read operations to 
members of a replica set. You can select from the following drop-down list: 

 Primary

 PrimaryPreferred

 Secondary

 SecondaryPreferred

For more information, refer to 
http://docs.mongodb.org/manual/core/read-preference/.

Failover Sla Ms This parameter is used to enter the amount of time to wait before starting failover 
database handling. The time is in milliseconds.

Max Replication Wait Time Ms This option specifies a time limit, in milliseconds, for the write concern. This 
parameter is applicable only if you select TwoInstanceSafe in Db Write Concern.

This parameter causes write operations to return with an error after the specified 
limit, even if the required write concern eventually succeeds. When these write 
operations return, MongoDB does not undo successful data modifications 
performed before the write concern exceeded the replication wait time limit. This 
time is in milliseconds.

Default Minimum Dosage Time 
Based

This field is optional but recommended. 

This is the minimum amount of time that is granted for a reservation, assuming 
quota is not exhausted. 

If you want to manage subscriber balances on the basis of time used, check with 
the network device administrator and have this value be slightly larger than the 
minimum amount of time the network device such as an SCE or ISG accepts for a 
reservation.

Default Minimum Dosage 
Volume Based

This field is optional but recommended. 

This is the minimum amount of volume that is granted for a reservation, assuming 
quota is not exhausted. 

If you try to make a reservation for 1 KB, and your minimum is 10 KB, the router 
rejects it because it is too small an amount to bother with.
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Expired Reservations Purge 
Time (minutes)

The amount of time a record of expired reservations is retained and Cisco MsBM 
attempts to charge them. Note that expired reservations are charged only if 
sufficient quota is still available; that is, expired reservations do not retain the lock 
on quota that current reservations do. The default value is 0.

Recurring Refresh Max Delay 
(minutes)

The amount of time refreshing of recurring quotas are staggered across randomly, 
for sessions that are not actively using quota but are still established. This 
parameter is used in cases where subscribers always have a session, but might not 
be using their quota actively. This allows staggering of recurring refreshes where 
the customer has set all their subscribers to refresh at the same time, say midnight. 
It avoids spiking the CPU. The default value is 0.

Reduce Dosage on Threshold When checked, reservation dosages are reduced as an Cisco MsBM threshold is 
approached. This way, a dosage does not pass a threshold by a large amount 
before notification of the breach is sent out. When unchecked, normal dosages is 
granted. Recall that when enabled, messaging becomes much more chatty, but 
threshold breach accuracy is enhanced.

Submit Balance Events To 
Reporting

Submits balance transaction to the policy engine, and these can be reflected in 
reporting.

Remote Database

Name String - Name of the remote database.

Key Prefix Key prefix to be match for the remote database to be selected for lookup.

Connections Per Host Number of connections that can be created per host.

Default value is 5.

Db Read Preference Read preference describes how sessionmgr clients route read operations to 
members of a replica set. You can select from the following drop-down list: 

 Primary

 PrimaryPreferred

 Secondary

 SecondaryPreferred

For more information, refer to 
http://docs.mongodb.org/manual/core/read-preference/.

Primary Ip Address IP address of the remote sessionmgr database.

Secondary Ip Address Optional, this field is the IP address of a secondary, backup, or failover sessionmgr 
database. 

Port Port number of the remote sessionmgr database. It should be the same for both the 
primary and secondary databases.

Backup Db Host On Local Site String - The host name of backup database for remote balance for current site.

Default is sessionmgr01.

Backup Db Port on Local Site The port number of backup database for remote balance for current site.

Default value is 27719.

Table 4 Balance Configuration Parameters

Parameter Description
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If you have a Geo-Redundancy setup, you need to click Backup Db Configuration. It will store back up of entire balance 
records. In the event that the primary Balance DB goes down, CPS will check the balance record on both secondary and 
backup dbs, and take the latest version for processing. 

The following parameters can be configured under Backup Db Configuration.

Diameter Configuration
This sections covers the following topics:

 Full Environment Verify, page 39

 All in One Verify, page 40

Full Environment Verify
Verify that the Diameter feature is installed in full environment. If not installed, follow these instructions to install the 
feature.

1. Take backup of directory /etc/broadhop/license/.

2. From directory /opt/broadhop/installer run script set_config.sh. It initializes default mobile setup (i.e., initializes the 
/etc/broadhop directory to a default configuration). 

Table 5 Backup Db Configuration Parameters

Parameter Description

Backup Db Host Default value is sessionmgr01.

Backup Db Port Default value is 27719.

Backup Db Monitor Interval In Sec Used in thread which updates the primary balance DB (when primary 
balanceDB is available after fail over) with 'BackupBalance' db records. 

Default value is 3 sec.

Rate Limit  Used to control the TPS (with how much TPS reconciliation should happen 
once primary balance db is up).
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Primarily the general setup is used when we need to have Radius endpoint to run radius calls. If we need to have diameter 
calls, then refer to 4. on page 40, but that setup does not give high performance in case of high load of diameter calls. 
To get high performance, you must select general_mobile which has extra diameter endpoints that can help to support 
high volume of diameter calls. 

Radius calls are not supported in this setup.

3. Restore the license backup taken above to /etc/broadhop/license/ directory.

There are four types of licenses:

 MOBILE_CORE — This is used for Gx calls i.e., diameter calls. So by selecting this license type, you have enabled 
both radius and diameter calls.

 RADIUS_AUTH — This license is used to enable Radius setup where it supports radius calls. If enabled individually, 
it does not enable any x_core license.

 SP_CORE — This license is used for SP-WiFi and radius calls. Currently, this license is not used in CPS setup.

 FIXED_CORE — This license is used for broadband setup and radius calls. Currently, this license is not used in CPS 
setup.

4. Verify that the Diameter plug-in configuration is installed on the Cisco Policy Server and Cisco Policy Builder.

a. Add the following feature to /etc/broadhop/iomanager01/features and /etc/broadhop/iomanager02/features 
on pcrfclient01:

com.broadhop.diameter2.service.feature

b. Add the following feature to /etc/broadhop/pcrf/features on pcrfclient01:

com.broadhop.diameter2.local.feature

c. Add the following feature to /etc/broadhop/pb/features:

com.broadhop.client.feature.diameter2

d. After modifying the feature files, execute the following commands:

/var/qps/install/current/scripts/build/build_all.sh

/var/qps/install/current/scripts/upgrade/reinit.sh

All in One Verify
If the feature is missing, add the feature as shown below. These instructions are applicable to only All-In-One solutions:

a. Add the following features to /etc/broadhop/pcrf/features file:

com.broadhop.diameter2.service.feature

com.broadhop.diameter2.local.feature

b. Add the following feature to /etc/broadhop/pb/features file:

com.broadhop.client.feature.diameter2

c. After modifying the feature files, execute the following commands:

/var/qps/install/current/scripts/build_all.sh
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puppet apply -v --modulepath “/etc/puppet/modules:/etc/puppet/env_config/modules” --pluginsync 
/etc/puppet/manifests/init.pp

1. Add the plug-in Diameter Configuration in Cisco Policy Builder. Click Diameter Configuration from right pane to add 
the configuration in the system.

The following parameters can be configured under Diameter Configuration. 

For more information, refer to Diameter Configuration, page 55.

Table 6 Diameter Configuration Parameters

Parameter Description

Stale Session Timer Once the session is created in CPS and if the CPS doesn't receive any 
response from PCEF within this timer then CPS will remove the 
session. Default stale session timer is 180 minutes. 

NOTE: Stale Session Timer is in minutes.

Use V9 Event Trigger Mapping/Rel8 Usage 
Monitoring Supported check box

Select the check boxes for Rel8 Usage Monitoring Supported.

 If Use V9 Event Trigger Mapping check box is not selected, the 
event trigger mapping ID (33) from 3GPP TS 29.212 V11.10.0 
(2013-09) is used.

 If Use V9 Event Trigger Mapping check box is selected, the event 
trigger mapping ID (26) from 3GPP TS 29.212 V9.5.0 (2013-09) 
is used.
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Voucher Configuration
Click Voucher Configuration from right pane to add the configuration in the system.

The voucher plug-in take the following defaults:

 HA example: 

— Primary: sessionmgr01

— Secondary: sessionmgr02

— Port: 27718

 AIO example: 

— Primary: localhost or 127.0.0.1

— Secondary: NA (leave blank)

— Port: 27017

The following parameters can be configured under Voucher Configuration.

Table 7 Voucher Configuration

Parameter Description

Primary Database IP Address The IP address of the Session Manager database that holds voucher information 
for Cisco Policy Builder and Cisco Policy Server.

Secondary Database IP Address The IP address of the database that provides fail over support for the primary 
database. 

This is the mirror of the database specified in the Primary Database IP Address 
field. 

Database Port Port number of the sessionmgr. It should be the same for both the primary and 
secondary databases.

Disable Vouchers Select the check box to disable voucher configuration.
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Unified API Configuration
Click Unified API Configuration from right pane to add the configuration in the system.

The following parameters can be configured under Unified API Configuration.

Notification Configuration
Notification in Cisco Policy Builder relates to pushing messages from Cisco Policy Builder to subscribers. Use messages 
to alert the subscriber to issues as well as opportunities on their network. Not only can you alert subscribers, but you can 
also send messages to any address you wish, perhaps system monitoring addresses.

Currently, Cisco Policy Builder offers following notification types:

 Apple iOS devices/iPhone® push (iOS devices)

 Email (IMAP only)

 SMS notification (SMPP v 3.4)

 Realtime Notification

Table 8 Unified API Configuration Parameters

Parameter Description

Fields To Wrap With Cdata Tags This is a CSV separated string.

The Unified API now can handle CDATA fields. Use the Plug-in configuration 
in Policy Builder to set CDATA fields for the main Unified API.

The property ua.cdata.fields is used to set the fields that should be 
wrapped in CDATA tags for the client CommFactory to properly send and 
receive API requests.

-Dua.cdata.fields=networkId,password,data,oldNetworkId,oldPassword
,newPassword is the default.

Submit Requests To Audit Log Select the check box to log requests to API in audit log.

Default is True (checked).

Submit Read Requests To Audit Log Select this check box to log read requests in audit log.

Default is False (unchecked).
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Notification Configuration
 Google Cloud Messaging

Click Notification Configuration from right pane to add the configuration in the system.

The following parameters can be configured under Notification Configuration.

Table 9 Notification Configuration Parameters

Parameter Description

Apple Push Notification Configuration Select this check box to configure the connection for a push to an 
Apple iOS device or iPhone. For more information, refer to 
Chapter, Notification Configuration.

Email Notification Configuration Select this check box to configure the connection for an email 
notification. For more information, refer to Chapter, Notification 
Configuration.

SMS Notification Configuration Select this check box to configure the connection for a SMS 
notification. For more information, refer to Chapter, Notification 
Configuration.

Realtime Notification Configuration Select this check box to configure the connection for a realtime 
notification. For more information, refer to Chapter, Notification 
Configuration.

Google Cloud Messaging Configuration Select this check box to configure the connection for a google 
cloud messaging notification. For more information, refer to 
Chapter, Notification Configuration.
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Audit Configuration
Click Audit Configuration from right pane to add the configuration in the system.

The following parameters can be configured in General Configuration pane under Audit Configuration:

For more information related to other parameters like Queue Submission Configuration, Database Configuration, 
Shard Configuration under Audit Configuration, refer to CPS Operations Guide for this release.

Table 10 Audit Configuration Parameters

Parameter Description

Capped Collection check box Select this check box to activate capped collection function.

Capped Collection Size By default, the Audit History uses a 1 GB capped collection in Mongo Db. The 
capped collection automatically removes documents when the size restriction 
threshold is hit. 

Configuration in Policy Builder is done in GB increments. It is possible to enter 
decimals, for example, 9.5 will set the capped collection to 9.5 GB.

Log Read Requests check box Select this check box if you want read requests to be logged.

Include Read Requests In Query 
Results check box

Select this check box only if you want to include read requests to be displayed in 
query results.

Disable Regex Search check box If you select this check box, the use of regular expressions for queries is turned 
off in the Policy Builder configuration.

Search Query Results Limit This parameter limits the search results.
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USuM Configuration
Click USuM Configuration from right pane to add the configuration in the system.

The following parameters can be configured in Spr Configuration pane under USuM Configuration:

Table 11 USuM Configuration Parameters - 1

Parameter Description

Spr Configuration

Disable Regex Search Not applicable leave to default.

Enable Avp Regex Search Not applicable leave to default.

Exclude Suspended Subscribers 
From Policy

In case of subscriber state is Suspended, SPR will not validate IMSI.

Search Query Results Limit Used to limit search if we are not passing any IMSI/MSISDN (NetworkID) in control 
center to list subscriber.

Default value is 1000.

Max Number Of Locations To 
Store In History

Not applicable leave to default.

Last Visited Date Threshold Not applicable leave to default.
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The following parameters can be configured in Policy Engine Submission Configuration pane under USuM 
Configuration:

Table 12 USuM Configuration Parameters - 2

Parameter Description

Enable check box Leave it to default.

Message Queue Size Queue to hold data to generate internal SPR Refresh events for policy engine 
during Create, Update, Delete of subscriber.

Message Queue Sleep Sleep before popping next batch for generating SPR Refresh events for policy 
engine for RAR processing.

Message Queue Batch Size Batch size for fetching number of subscriberIds in one go for generating SPR 
Refresh events for policy engine for RAR processing.

Message Queue Pool Size Message queue pool size to consume the data from queue and generate SPR 
Refresh events.

Notification Rate Limit Rate limiting for generating SPR Refresh events. SPR Refresh events is used to 
generate RAR for active session where subscriber data has been change.
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The following parameters can be configured in Database Configuration pane under USuM Configuration:

Table 13 USuM Configuration Parameters - 2

Parameter Description

Database Configuration

Use Minimum Indexes It is used to decide what all indexes need to be created on SPR collection by 
default, and here we need all the indexes to be created (We can check this when 
subscriber is very low e.g. < 50K).

Default value is unchecked.

Db Write Concern Controls the write behavior of sessionmgr and for what errors exceptions are 
raised. Default option is OneInstanceSafe.
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Db Read Preference Read preference describes how sessionmgr clients route read operations to 
members of a replica set. You can select from the following drop-down list: 

 Primary

 PrimaryPreferred

 Secondary

 SecondaryPreferred

For more information, refer to 
http://docs.mongodb.org/manual/core/read-preference/.

Failover Sla Ms This parameter is used to enter the amount of time to wait before starting failover 
database handling. The time is in milliseconds.

Max Replication Wait Time Ms This option specifies a time limit, in milliseconds, for the write concern. This 
parameter is applicable only if you select TwoInstanceSafe in Db Write Concern.

This parameter causes write operations to return with an error after the specified 
limit, even if the required write concern eventually succeeds. When these write 
operations return, MongoDB does not undo successful data modifications 
performed before the write concern exceeded the replication wait time limit. This 
time is in milliseconds.

Shard Configuration

Primary Ip Address String - Primary Host Address. 

Secondary Ip Address String - Secondary Host Address.

Port Default value is 27720.

Table 13 USuM Configuration Parameters - 2

Parameter Description
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Click Add to add a new row on Remote Database Configuration pane. The following parameters can be configured in 
Remote Database Configuration pane under USuM Configuration:

LDAP Configuration
Click LDAP Configuration from right pane to add the configuration in the system.

Table 14 USuM Configuration Parameters - 2

Parameter Description

Name String - Name of the remote database.

Key Prefix Key prefix to be match for the remote database to be selected for lookup.

Connections Per Host Number of connections that can be created per host.

Default value is 5.

Db Read Preference Read preference describes how sessionmgr clients route read operations to 
members of a replica set. You can select from the following drop-down list: 

 Primary

 PrimaryPreferred

 Secondary

 SecondaryPreferred

For more information, refer to 
http://docs.mongodb.org/manual/core/read-preference/.

Primary Ip Address IP address of the remote sessionmgr database.

Secondary Ip Address Optional, this field is the IP address of a secondary, backup, or failover sessionmgr 
database. 

Port Port number of the remote sessionmgr database. It should be the same for both 
the primary and secondary databases.

Default value is 27720.
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Click Ldap Server Configuration to open a pane as shown below:

The following parameters can be configured under LDAP Server Configuration:

Table 15 LDAP Server Configuration Parameters - 1

Parameter Description

Ldap Server Assign this to the LDAP Server Set.

Search User Dn Set this to the user DN for connecting to the LDAP server. An example is 
cn=manager,ou=accounts,o=profile.

Search User Password Set this to the password for connecting to the LDAP server.

Note: The same password must apply to all servers defined in this configuration.

Auth Type Select the LDAP authorization type required by the LDAP server.

Default is SIMPLE.

Initial Connections Set the initial connections to “50”. This represents the number of connections 
from a load balancer to the LDAP server(s).
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Add entries to the LDAP Servers to represent the primary and secondary connections from the CPS system to the LDAP 
servers. 

The following parameters can be configured under LDAP Servers:

Retry Count Set this to the total number of “tries” the system should execute for a given LDAP 
query. For example, a value of 2 would indicate one try and then on timeout one 
more attempt.

Retry Time Ms Set this to the time period when the policy engine will retry to a second load 
balancer to send the request. 

Note: Setting this value too low will result in a large number of additional requests. 
This value should be set to a value close to the SLA provided by the LDAP server 
in servicing requests.

Max Failover Connection Age Ms Set this value to the time period a secondary connection will be utilized before 
checking to determine if the original primary server is available. An example value 
is 60000ms (1minute).

Binds Per Second Set this to the maximum rate at which to connect to the LDAP server. Setting this 
to a high value may result in extra load on the peer LDAP server.

Health Check Interval Ms Set this to the period of time to generate a health check message. An example 
value is 5000ms (5 seconds).

Health Check Dn Set this to the health check DN sent on the health check LDAP query.

Health Check Filter Set this to the filter sent on the health check LDAP query.

Health Check Attrs Set this to a comma delimited list of attributes to retrieve in the LDAP health check 
query.

Health Check Select this check box to enable the health check.

Number Consecutive Timeouts 
For Bad Connection

Set this to the number of timeouts that will trigger a bad connection and force a 
reconnection.

Table 16 LDAP Server Configuration Parameters - 2

Parameter Description

Priority The priority of the server when sending requests. Higher number is equal to higher priority.

Address IP address of the server to send requests.

Port Port address of the LDAP Server.

Connection Rule This setting is not currently used.

Table 15 LDAP Server Configuration Parameters - 1

Parameter Description
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Auto Reconnect This setting is not currently used.

Timeout Ms Set this to the SLA for queries for the LDAP server. Recommended value for timeout is 5000 
milli-seconds.

Bind Timeout Ms Set this to the SLA for binds to the LDAP server.

Table 16 LDAP Server Configuration Parameters - 2

Parameter Description
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First Published: June 26, 2015

Last Updated: August 14, 2015

This chapter covers the following section:

 Diameter Configuration, page 55

 Diameter Stack Configuration, page 66

 Diameter Clients, page 74

 Diameter Defaults, page 87

Diameter Configuration
The Diameter Configuration section allows for the configuration of the diameter plug-in. It is recommended to configure 
the diameter plug-in at system level.

This section covers the following topics:

 Inbound Message Overload Handling, page 59

 Next Hop Routing, page 62

 Message Timeout, page 64

In order to define a Diameter Configuration at system level you need to perform the following steps:

1. Login into Policy Builder.

2. Select Reference Data tab.

3. From the left pane, select Systems.

4. Select and expand your system name.

5. Select Plugin Configurations.
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6. Select Diameter Configuration action.

In order to define a Diameter Configuration at cluster level you need to perform the following steps:

1. Login into Policy Builder.

2. Select Reference Data tab.

3. From the left pane, select Systems.

4. Select and expand your system name.

5. 5.Select and expand your cluster name. If no cluster has been created, create one by selecting the Cluster action.

6. Select Plugin Configurations.

7. Select Diameter Configuration action.

Note: If a cluster has a Diameter Configuration section then its settings will completely override all the Diameter 
Configuration section settings at system level.
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The following parameters can be configured under Diameter Configuration.

Table 1 Diameter Configuration Parameters

Parameter Description

Stale Session Timer This timer is armed every time a message is received or sent for any given Gx 
session. When the timer expires (or more precisely within the next minute after 
the timer expires) a Gx RAR having the Re-Auth-Request-Type AVP set to 
AUTHORIZE_ONLY (0) message is triggered for that Gx session. If a Gx RAA is 
received having Result-Code AVP value set to 
DIAMETER_UNKNOWN_SESSION_ID (5002) the Gx session is deemed as stale 
and removed from the PCRF internal database. Default value is 180. If a Gx RAA 
is received having Result-Code AVP value set to DIAMETER_SUCCESS (2001) 
the timer is reset.

Note:

 This timer unit is minute.

 Stale Gx session removal will trigger the PCRF session termination 
procedure for any other diameter sessions that were bound to the Gx 
session.

Use V9 Event Trigger Mapping This option allows for a different set of list of valid values and their interpretation 
to be used for the Event-Trigger enumerated AVP in order to accommodate the 
change that occurred in the Gx specification between 3GPP TS 29.212 v9.5 
(and prior) and 3GPP TS 29.212 v9.7 (and following including v10, v11 and 
v12). Default value is checked. List of valid values is provided in Table 2 on 
page 57.

Note:

 The Event-Trigger AVP list of valid values and their interpretation defined in 
3GPP TS 29.212 v9.6 is not supported.

 Use V9 Event Trigger Mapping checked uses 3GPP TS 29.212 v9.5 as a 
reference while 3GPP TS 29.212 v110.10 is used as a reference when not 
checked.

Rel8 Usage Monitoring Supported This option allows for the Gx usage monitoring feature to be supported even 
when the PCEF advertises support for Rel8 feature under Supported-Features 
AVP in Gx CCR-i. Default value is checked.

Table 2 Use V9 Event Trigger Mapping Valid Values

Interpretation - Use V9 Event Trigger Mapping 
is checked

Value Interpretation - Use V9 Event Trigger Mapping is 
not checked

SGSN_CHANGE 0 SGSN_CHANGE

QOS_CHANGE 1 QOS_CHANGE

RAT_CHANGE 2 RAT_CHANGE

TFT_CHANGE 3 TFT_CHANGE

PLMN_CHANGE 4 PLMN_CHANGE

LOSS_OF_BEARER 5 LOSS_OF_BEARER

RECOVERY_OF_BEARER 6 RECOVERY_OF_BEARER
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IP_CAN_CHANGE 7 IP_CAN_CHANGE

QOS_CHANGE_EXCEEDING_AUTHORIZATION 11 QOS_CHANGE_EXCEEDING_AUTHORIZATION

RAI_CHANGE 12 RAI_CHANGE

USER_LOCATION_CHANGE 13 USER_LOCATION_CHANGE

NO_EVENT_TRIGGERS 14 NO_EVENT_TRIGGERS

OUT_OF_CREDIT 15 OUT_OF_CREDIT

REALLOCATION_OF_CREDIT 16 REALLOCATION_OF_CREDIT

REVALIDATION_TIMEOUT 17 REVALIDATION_TIMEOUT

UE_IP_ADDRESS_ALLOCATE 18 UE_IP_ADDRESS_ALLOCATE

UE_IP_ADDRESS_RELEASE 19 UE_IP_ADDRESS_RELEASE

DEFAULT_EPS_BEARER_QOS_CHANGE 20 DEFAULT_EPS_BEARER_QOS_CHANGE

AN_GW_CHANGE 21 AN_GW_CHANGE

SUCCESSFUL_RESOURCE_ALLOCATION 22 SUCCESSFUL_RESOURCE_ALLOCATION

RESOURCE_MODIFICATION_REQUEST 23 RESOURCE_MODIFICATION_REQUEST

PGW_TRACE_CONTROL 24 PGW_TRACE_CONTROL

UE_TIME_ZONE_CHANGE 25 UE_TIME_ZONE_CHANGE

USAGE_REPORT 26 TAI_CHANGE

TAI_CHANGE 27 ECGI_CHANGE

ECGI_CHANGE 28 CHARGING_CORRELATION_EXCHANGE

CHARGING_CORRELATION_EXCHANGE 29 APN_AMBR_MODIFICATION_FAILURE

USER_CSG_INFORMATION_CHANGE 30 USER_CSG_INFORMATION_CHANGE

DEFAULT_EPS_BEARER_QOS_MODIFICATION
_FAILURE

31 NA

NA

33 USAGE_REPORT

34 DEFAULT_EPS_BEARER_QOS_MODIFICATION_
FAILURE

35 USER_CSG_HYBRID_SUBSCRIBED_INFORMATI
ON_CHANGE

36 USER_CSG_HYBRID_UNSUBSCRIBED_INFORM
ATION_CHANGE

37 ROUTING_RULE_CHANGE

39 APPLICATION_START

40 APPLICATION_STOP

42 CS_TO_PS_HANDOVER

43 UE_LOCAL_IP_ADDRESS_CHANGE

44 HENB_LOCAL_IP_ADDRESS_CHANGE

45 ACCESS_NETWORK_INFO_REPORT

Table 2 Use V9 Event Trigger Mapping Valid Values

Interpretation - Use V9 Event Trigger Mapping 
is checked

Value Interpretation - Use V9 Event Trigger Mapping is 
not checked
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Inbound Message Overload Handling
This feature provides a mechanism for the PCRF protection in case more traffic than can be handled is received. It 
provides a way to prioritize the incoming messages and selectively process them.
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The following parameters can be configured under Inbound Message Overload Handling:

Table 3 Inbound Message Overload Handling Parameters

Parameter Description

Default Priority Default priority to be assigned to an incoming message if no specific one is 
defined in the Message Handling Rules table. 

Default value is 0.

Message Sla Ms This is the Spending-Limit-Answer in milliseconds. This defines the no. of 
milliseconds associated with an incoming event/message within which LB has 
to be submit it to QNS for processing, failing which the Default Discard 
Behavior is applied.

Default value is 1500 ms.

Inbound Message Queue Size Number of messages waiting to be processed before the inbound overload 
feature is activated. 

Default value is 15000.

Default Instance Rate Limit This defines the Rate at which incoming messages are staggered before 
being submitted to the QNS.

Default value is 0.

Emergency Message Priority Default priority assigned to messages related to an emergency session.

Default value is 0.

Default Discard Behavior Default behavior to be applied to an incoming message if no specific one is 
defined in the Message Handling Rules table. 

 MESSAGE_DROP (default): Silently discards the request.

 DIAMETER_TOO_BUSY: Sends a response message having Result-Code 
AVP value set to DIAMETER_TOO_BUSY (3004)

Apply Discard Behavior For 
Emergency Messages

Indicates if Emergency Messages can be discarded under overload 
conditions.

Default value is not checked.

Message Handling Rules Defines specific inbound message overload handling rules based on different 
criteria. For more information, refer to Table 4 on page 61.
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Table 4 Message Handling Rules Parameters

Parameter Type Attribute Description

INPUT Diameter Client Diameter client defined under Diameter Clients section. This 
field is optional, but is used so that different clients (based on 
realms) can have different priorities. For more information, refer 
to Diameter Clients, page 74.

Protocol Specific application id value to be used for scoring. This is to 
match Auth-Application-Id AVP value. For more information, 
refer to Table 5 on page 62.

Command Code Specific command code value to be used for scoring. This is to 
match the Command-Code field. These command codes map 
to different types of Diameter messages (CCR = 272, RAR = 
258, etc).

Default value is 0.

Request Type Specific request type value to be used for scoring. This is to 
match the value of the CC-Request-Type AVP only for CCR 
messages. 

 0 (default): Request Type not used for scoring

 1: INITIAL_REQUEST (1)

 2: UPDATE_REQUEST (2)

 3: TERMINATION_REQUEST (3)

OUTPUT Priority Priority value assigned to the message. Higher numerical value 
will be having higher priority

Default value is 0.

Per Instance Tps Transactions per second limit per process. This is the TPS that 
these messages are limited to. Note that this is per CPS 
process, so if there are 20 qns VM's with 1 qns java process, 
the total TPS is this number x 20. 

The actual system's transaction per second limit can be 
calculated using the following formula:

Per Instance Tps x Number of instances per VM x Number of 
VMs

Default value is 0.

Discard Behavior Behavior to be applied to an incoming message. 

 MESSAGE_DROP (default): Silently discards the request.

 DIAMETER_TOO_BUSY: Sends a response message 
having Result-Code AVP value set to 
DIAMETER_TOO_BUSY (3004)
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Next Hop Routing
This feature provides support for interworking with a DRA that is not configured in topology hiding mode. This is required 
because while the DRA will advertise its own origin host and realm values when the diameter connection is established 
all the diameter application messages will feature the actual host's origin host and realm (i.e. PCEF, TDF, AF). PCRF needs 
a way to figure out which particular DRA connection should use in order to deliver a message to the desired host.

While selecting the peer that is used to deliver the request (with or without using the Next Hop Routes table), load 
balancing across the peers having the same rating is done. Load balancing starts from the peers having highest rating 
and covers all the peers in a round robin manner. If none is UP, load balancing is tried with the peers having the second 
highest rating and again covers all the peers in a round robin manner and so on.

Table 5 Protocols

Attribute Description

GY_V8 Standard Gy application as per 3GPP TS 32.299

GX_SCE Custom Gx implementation

RF_V10 Not supported

RF_VERIZON Not supported

RX_TGPP Standard Rx application as per 3GPP TS 29.214

SH_TGPP Standard Sh application as per 3GPP TS 29.329

SY_V11 Standard Sy application as per 3GPP TS 29.219

GX_HUAWEI Custom Gx implementation

SD_V11 Standard Sd application as per 3GPP TS 29.212

GX_TGPP (default) Standard Gx application as per 3GPP TS 29.212

GXX_TGPP Not supported

GX_ALLOT Custom Gx implementation

RX_CLIENT Local MINE adapter

GY_V8_PROXY Gy proxy implementation as per RFC 3588

GX_TGPP_PROXY Gx proxy implementation as per RFC 3588

SY_TGPP_PROXY Sy proxy implementation as per RFC 3588

SY_OCS Sy Proxy from PCRF end

GY_RECHARGE_WALLET Support Gy client functionality with external OCS (ECUR model only)

SY_PRIME Custom Sy implementation as per RFC 3588

RX_TGPP_PROXY Rx proxy implementation as per RFC 3588
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Note: Next Hop Routes table is used only for PCRF initiated requests. The response messages for any incoming request 
will always be delivered on the same connection where the request was received or will not be delivered at all. This is in 
order to avoid asymmetric routes.

The following parameters can be configured under Next Hop Routing table:

While populating the Next Hop Routes table it is recommended that only one entry is created for each Next Hop Realm 
value - Application Id value pair while all the DRA host names are provided as a list under Next Hop Hosts field. This is 
not a requirement though.

Note:

 The order in which the routes are provisioned in the Next Hop Routes table is relevant. While looking for a DRA 
connection that could be used to deliver a particular message the table is checked top to bottom.

 The order in which the DRA hosts are provisioned in the Next Hop Hosts field for any given next hop route is not 
relevant. The DRA host having the highest rating (priority) value will be used. In case multiple hosts have the same 
rating, one will be randomly selected. Refer to Diameter Stack Configuration, page 66 for more details about host 
rating.

Table 6 Next Hop Routing Parameters

Parameter Description

Next Hop Realm DRA realm name as received in Origin-Realm AVP in CER message. 

Next Hop Hosts DRA hosts name list as received in Origin-Host AVP in CER message.

Application Id Diameter application id advertised as being supported by the DRA. It contains 
information that identifies the particular service that the service session belongs to.

Destination Realms Pattern Actual destination realm name pattern as received in Origin-Realm AVP in AAR 
message. The pattern needs to follow the standard Java regular expression syntax 
described here.

Destination Host Pattern Actual destination host name pattern as received in Origin-Host AVP in AAR 
message. The pattern needs to follow standard Java pattern conventions. The 
pattern needs to follow the standard Java regular expression syntax described 
here.
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Message Timeout
This section allows for the configuration of different message timeout value and retry count on a per diameter application 
basis.

The following parameters can be configured under Message Timeouts table.

Note: If the timeout and retry count is not configured than the default generic values (diameter.default.timeout.ms and 
diameter.default.retry.count parameters) defined in /etc/broadhop/qns.conf are used. If the default generic values 
are not defined than the default hard-coded value of Timeout Ms = 3000 ms and Retry Count =1 is going to be used.

Grouping and Wildcarding for Realm based Routing Tables
CPS supports grouping of realms and application identifiers using wildcarding and assigns it to a group of next hop peers. 
CPS routes outgoing messages by selecting the peer with highest priority.

CPS uses standard Java pattern characters in Next Hop Realm column of Next Hop Routes table configuration. For more 
information, refer to http://www.vogella.com/tutorials/JavaRegularExpressions/article.html#regex.

Table 7 Message Timeout Parameters

Parameter Description

Application Id Auth-Application-Id AVP value. It contains information that identifies the particular 
service that the service session belongs to.

Default value is 0.

Timeout Ms Expiry time in milliseconds defined by the service. CPS retries the message if there 
is no response received within the mentioned timeout. Number of retries is the 
Retry Count.

Default value is 0.

Retry Count Configured message retry count. If set to zero the retry is disabled. 

Default value is 1.
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An example configuration for Grouping and Wildcarding in the Next Hop Routing table is shown below:

Destination Realm and Destination Hosts are used to map with the Peer configuration as defined in the Diameter 
Stack.The figure given below shows the mapping of the message containing the Realm from a peer to a protocol or 
interface. For more information on peer configuration, refer to Diameter Stack Configuration, page 66.
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Since CPS supports multiple standard and proprietary interfaces, this table helps in deriving the correct processing 
protocol component based on the Application Id and the message processed in CPS Policy Engine.

In the above figure, Rating column in the Peers section defines the criteria for selecting between two or more Peers in 
the connected state. By default, the Rating value is set to 1. The higher the rating value, the higher is the priority assigned 
to the peer. 

Diameter Stack Configuration
This section allows for the creation of the stacks that will handle the diameter traffic. Depending on your particular 
requirements one or more stacks can be created.

This section covers the following topics:

 Settings, page 69
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 Inbound Peers, page 71

 Outbound Peers, page 73

In order to define a Diameter stack at system level you need to perform the following steps:

1. Login into Policy Builder.

2. Select Reference Data tab.

3. From the left pane, select Systems.

4. Select and expand your system name.

5. Select and expand Plugin Configurations.

6. Select Diameter Configuration. 

7. From the right pane, click Diameter Stack under Create Child.

In order to define a Diameter stack at cluster level you need to perform the following steps:

1. Login into Policy Builder.

2. Select Reference Data tab.

3. From the left pane, select Systems.

4. Select and expand your system name.

5. Select and expand your cluster name.

6. Select and expand Plugin Configurations.

7. Select Diameter Configuration.
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8. From the right pane, click Diameter Stack under Create Child.

The following parameters can be configured under Diameter Stack:

Table 8 Diameter Stack Parameters

Parameter Description

Name Local stack name. This is only used within the Policy Builder GUI to identify the diameter 
stack.

Realm Local realm for the diameter stack. This value is going to set as Origin-Realm AVP value 
in all the diameter messages originated from this stack.

Accept Undefined Peer This allows for any incoming diameter peer connection request to be accepted by the 
stack provided the peer realm is provisioned under inbound realms. For more details on 
Inbound Peers check Inbound Peers, page 71. 

It is recommended that Accept Undefined Peer option is disabled on any production 
system.

Default value is checked.

Local End Points This configures other stack parameters.

Local Host Name The host local name where this stack is going to be created.

Note: If Local Host Name value doesn't map to a valid IP the stack will bind to localhost 
(127.0.0.1).

Instance Number Indicates the Instance number of the QNS process on Load Balancer for which this entry 
applies. On a Load Balancer each QNS process is assigned an Instance Number.
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Settings
This section allows for the provisioning of the different timers available at diameter stack level.

Advertised Diameter 
FQDN

This value is going to be set as Origin-Host AVP value in all the diameter messages 
originated from this stack.

The Advertised Diameter FQDN value needs to map to a valid IP address because that IP 
address is going to be set as Host-IP-Address AVP value in CER/CEA. As per RFC 3588 
Host-IP-Address is a mandatory AVP in CER/CEA.

Listening Port The port the stack will be listening to on the host identified by Local Host Name attribute. 
Default value is 3868.

Local Bind Ip Allows the stack to bind to a different IP than the one that Local Host Name value maps 
to. When provisioned Local Bind Ip value overrides the Local Host Name value.

Table 8 Diameter Stack Parameters

Parameter Description
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The following parameters can be configured under Settings:

Auto Provision Avp Parser
This section allows for provisioning of the necessary information needed to parse the Cisco vendor specific 
SN-Transparent-Data AVP value.

Table 9 Settings Parameters

Parameter Description

User Uri As Fqdn Sets the Origin-Host AVP value in CER/CEA to the user URI value instead of FQDn value. 
Default value is not set.

Stop Timeout Ms Determines how long the stack waits for all resources to stop. The delay is in 
milliseconds. 

Default value is 10000.

Cea Timeout Ms Determines how long it takes for CER/CEA exchanges to timeout if there is no response. 
The delay is in milliseconds. 

Default value is 10000. 

Iac Timeout Ms Determines how long the stack waits before retrying the communication with a peer that 
has stopped answering DWR messages. The delay is in milliseconds. 

Default value is 5000.

Dwa Timeout Ms Determines how long it takes for a DWR/DWA exchange to timeout if there is no 
response. The delay is in milliseconds. 

Default value is 10000.

Dpa Timeout Ms Determines how long it takes for a DPR/DPA exchange to timeout if there is no 
response. The delay is in milliseconds. 

Default value is 5000.

Rec Timeout Ms Determines how long it takes for the reconnection procedure to timeout. The delay is in 
milliseconds. 

Default value is 10000.
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The following parameters can be configured under Auto Provision Avp Parser:

Inbound Peers
This section allows for the provisioning of the diameter peers that are allowed to initiate connections towards PCRF. The 
PCRF will not initiate diameter connections with these peers.

Peer name and peer realm are independently checked against the two tables.

Table 10 Auto Provision Avp Parser Parameters

Parameter Description

AVP Name The AVP name whose value needs to be parsed using the field separator and value 
separator. For example, “abcd=xyz##lmno=pqrst”

Field Separator String value used as a token to split pairs of attribute and values. In the above example, 
# is the field separator.

Value Separator String value used as a token to split pairs of attribute and values. In the above example, 
= is the value separator.
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The following parameters can be configured under Inbound Peers:

       When PCRF is configured to work with a DRA the actual system's host name doesn't need to be provisioned in the Peers table 
for the message to be answered.

Table 11 Inbound Peers Parameters

Parameter Description

Peers Defines which peer names are allowed to initiate connections towards PCRF.

Local Host Name Identifies the local host name of the Load Balancer which identifies and will allow an 
incoming connection from the Peer.

Instance Number Indicates the assigned number of the QNS process that will initiate a connection with 
the Outbound Peer.

Note: Local Host Name and Instance Number should be specified if the intention is for 
only a single QNS process on LB to allow/initiate a connection with the said peer, else 
Instance number can kept as “0”. In which case all the QNS processes on LB shall 
attempt/allow connection with the peer.

Default value is 0.

Rating Priority assigned to this peer for delivering a PCRF initiated request. The higher the 
rating value, the higher is the priority assigned to the peer. In other words it is more likely 
for that peer to be used when PCRF initiates a request.

Default value is 1.

Port Range Should be specified only when the underlying transport connection Is SCTP and not 
required when the same is TCP.

Response Timeout Message time out value associated with this peer.

Default value is 3000.

Name Pattern Origin-Host AVP value in CER needs to validate against this pattern in order for the 
connection to be established. If that doesn't happen the CER is silently discarded and 
the TCP connection is reset by PCRF.

Name pattern check will not happen if Accept Undefined Peer option described in 
Table 8 on page 68 is checked.

The Name Pattern needs to follow the standard Java regular expression syntax 
described here.

Realms Defines which peer realms are allowed to initiate connections towards PCRF.

Peer Type Not used with inbound realms.

Processing Protocol Mapping between the realm name and the specific PCRF logic that should be applied 
for the message. For more information on processing protocol, refer to Table 5 on 
page 62.

Rating Priority assigned to this realm for delivering a PCRF initiated request. 

Default value is 0. 

Stats Alias Whatever the statistics that gets generated for the respective realm will get the name 
that is configured in “Stats Alias”.

Name Pattern Origin-Realm AVP value in CER needs to validate against this pattern in order for the 
incoming message to be processed. If that doesn't happen the message is silently 
discarded and the TCP connection is reset by PCRF.

The Name Pattern needs to follow the standard Java regular expression syntax 
described here.
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       When PCRF is configured to work with a DRA the actual system's origin realm name does need to be provisioned in the Peers 
table for the message to be processed. If it is not provisioned than PCRF shall send an error response containing the 
Result-Code AVP with value DIAMETER_APPLICATION_UNSUPPORTED (3007). 

Outbound Peers
This section allows for the provisioning of the diameter peers towards whom the PCRF will initiate diameter connections.

Peer name and peer realm are independently checked against the two tables.

The following parameters can be configured under Outbound Peers:

Table 12 Outbound Peers Parameters

Parameter Description

Peers Defines which peer names are allowed to initiate connections towards PCRF.

Local Host Name Identifies the local host name of the Load Balancer which initiates a connection with the 
said Peer.

Instance Number Indicates the assigned number of the QNS process that will allow an incoming 
connection from the Peer.

Default value is 0.
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       When PCRF is configured to work with a DRA the actual system's host name doesn't need to be provisioned in the Peers table 
for the message to be answered.

       When PCRF is configured to work with a DRA the actual system's origin realm name does need to be provisioned in the Peers 
table for the message to be processed. If it is not provisioned than PCRF shall send an error response containing the 
Result-Code AVP with value DIAMETER_APPLICATION_UNSUPPORTED (3007). 

Diameter Clients
The Diameter Clients section allows for the creation of different clients identified by their realm. The clients defined in 
this section can be further used while configuring a policy so that different clients get different service configuration 
objects.

In order to define a Diameter Client you need to perform the following steps:

1. Login into Policy Builder.

Rating Priority assigned to this peer for delivering a PCRF initiated request. The higher the 
rating value, the higher is the priority assigned to the peer. In other words it is more likely 
for that peer to be used when PCRF initiates a request.

Default value is 1.

Port Range Should be specified only when the underlying transport connection Is SCTP and not 
required when the same is TCP.

Response Timeout Message time out value associated with this peer.

Default value is 3000.

Name Peer host name. Peer host name needs to be mapped to a valid IP address or the 
diameter connection is not initiated. By default, the connection is initiated on the 
standard diameter port (3868). If a different port needs to be used than the peer name 
shall be defined using the host:port format. 

Default value is “default”.

Realms Defines which peer realms are allowed to initiate connections towards PCRF.

Peer Type This indicates which diameter server to use when there are multiple target servers for 
the same protocol. This is only used with SY_PRIME processing protocol.

Processing Protocol Mapping between the realm name and the specific PCRF logic that should be applied 
for the message. For more information on processing protocol, refer to Table 5 on 
page 62.

Rating Priority assigned to this realm for delivering a PCRF initiated request. This attribute is 
not currently used. 

Default value is 0. 

Stats Alias Whatever the statistics that gets generated for the respective realm will get the name 
that is configured in “Stats Alias”.

Name Pattern Origin-Realm AVP value in CER needs to validate against this pattern in order for the 
incoming message to be processed. If that doesn't happen the message is silently 
discarded and the TCP connection is reset by PCRF.

The Name Pattern needs to follow the standard Java regular expression syntax 
described here.

Table 12 Outbound Peers Parameters

Parameter Description
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2. Select Reference Data tab.

3. From the left pane, select Diameter Clients.

4. Select Summary.

5. Create the specific client that corresponds to your interface. If there is no specific client for your interface select the 
generic Diameter Clients.

6. Provide values for at least the mandatory attributes.

Note: The mandatory fields are marked with a “*” on the upper left corner of the field name label.

Once you have done that you can use the diameter client to filter the service objects that are going to be used in a policy. 

More details about each client field and attribute will be provided in the following sections dedicated to each type of 
client.

In order to filter a Service Option based on the Diameter Client you need to perform the following steps:

1. Login into Policy Builder.

2. Select Services tab

3. From the left pane, select Services.

4. Expand Service Options tree.

5. Select and expand your service option.

6. Select the service option object.

7. Select the Value cell corresponding to the Diameter Client Display Name.

8. Click the “…” button. 
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9. Select the Diameter Client from the pop-up window.

10. Click OK.

For more details about how to define a service option refer to Services chapter.

Note: If your service configuration object doesn't have a Diameter Client attribute it means it is not diameter related and 
it can't be filtered out based on diameter client.

Currently, the following diameter client types are supported:

 Diameter Clients, page 77

 Gx Clients, page 78

 Rx Clients, page 85

 Gy Clients, page 86

Note:

 The diameter client feature is mainly for use with inbound realms.

 No validation is done as to whether a realm is unique for a specific client type. If multiple clients are defined for the 
same realm the behavior may be unpredictable.

 The interface specific diameter clients are built on top of the generic Diameter Clients. They add specific behavior 
and this is why they should always be used in the context of the specific interface.
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Diameter Clients
This generic diameter client object is supposed to be used for any interface that doesn't have a matching specific 
diameter client.

The following parameters can be configured under generic Diameter Client: 

Table 13 Generic Diameter Client Parameters

Parameter Description

Name The client name that is going to be used to reference this particular client in the 
service configuration object.

Realm Pattern The pattern that peer realm name should match in order for this diameter client to be 
used. The pattern needs to follow the standard Java regular expression syntax 
described here.

The first choice for Realm Pattern value should always be the exact peer realm name 
whenever possible.

Copy Current Diameter Client This action creates a new diameter client that is an exact copy of the current 
diameter client. The only difference between the original and the copy is that 
“-Copy” is appended to the name of the copy.

The Copy action works exactly the same for all types of diameter clients.
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Gx Clients
This specific diameter client object is supposed to be used only in relation with the Gx interface. It adds Gx specific 
features to the generic diameter client already described in Diameter Clients, page 77.

Basic Options
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The following parameters can be configured for Basic Options under Gx Client:

Table 14 Gx Client Parameters - Basic Options

Parameter Description

Add Subscriber Id Adds Subscription-Id grouped AVP in Gx CCA-i message with one of the 
following Subscription-Id-Type AVP value and Subscription-Id-Data AVP 
value depending on the selection. The values will be copied from the incoming 
Gx CCR-i message if available. 

 NONE (default): No Subscription-Id grouped AVP in Gx CCA

 IMSI: END_USER_IMSI (1)

 MSISDN: END_USER_E164 (0)

 NAI: END_USER_NAI (3)

Rx PCC Rule Flow Direction Behavior Controls how the Flow-Direction AVP value under Flow-Information grouped 
AVP is derived. This option is only used for Rx dedicated bearers.

 Derive Flow-Direction (default): Flow-Direction AVP is derived based on 
Flow-Description AVP value and Flow-Status AVP value. This option is 
used only in case the PCEF advertised support for Rel10 feature under 
Supported-Features AVP. For more information refer to Table 15 on 
page 80.

 3GPP Gx Rel11 Compliant: Flow-Direction AVP is derived as per 3GPP TS 
29.212 v11

 Exclude Flow-Direction: Flow-Direction AVP is not set.

Emergency Called Station Ids The list of APNs that are allowed to initiate IMS emergency calls as per 
procedures described in 3GPP TS 29.212.

Controls Session Lifecycle Decides whether all the other sessions bound to the current Gx session get 
terminated upon Gx session termination. 

Default value is checked.

Load By Imsi If checked, attempts to load the session by IMSI (Subscription-Id-Data AVP 
value under Subscription-Id grouped AVP where Subscription-Id-Type AVP 
value is END_USER_IMSI (1)). 

Default value is unchecked.

Load By Nai If checked, attempts to load the session by NAI (Subscription-Id-Data AVP 
value under Subscription-Id grouped AVP where Subscription-Id-Type AVP 
value is END_USER_NAI (3)). 

Default value is unchecked.

Load By Msisdn If checked, attempts to load the session by MSISDN (Subscription-Id-Data 
AVP value under Subscription-Id grouped AVP where Subscription-Id-Type 
AVP value is END_USER_E164 (0)). 

Default value is unchecked.

Load By Framed Ip  If checked, attempts to load the session by IP v4 address 
(Framed-IP-Address AVP value). 

Default value is unchecked.
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Advanced Options

Cisco Pending Transaction Retry
StarOS 16 introduces optional custom behavior for handling overlapping Gx transactions so that the potential race 
conditions that can occur on Gx interface are to be handled deterministically.

This feature introduces a new error indication to allow the transaction originator to determine if a re-attempt of the 
transaction is appropriate. The PCRF shall send an error response to the PCEF containing the Experimental-Result-Code 
AVP with Cisco specific value DIAMETER_PENDING_TRANSACTION (4198) if the PCRF expects a response to a pending 
request that it initiated. The PCRF shall also have the ability to retry the request message for which it received an error 
response containing the Experimental-Result-Code AVP with Cisco specific value DIAMETER_PENDING_TRANSACTION 
(4198).

Load By Ip V6 Prefix If checked, attempts to load the session by IP v6 address (Framed-IPv6-Prefix 
AVp value). 

Default value is not checked.

Session Chained If checked, it does not attempt to terminate the Gx session by sending a Gx 
RAR to PCEF.

Default value is unchecked.

Remove Realm In User Id Mapping If checked, removes the realm from the NAI (if present) before attempting to 
load the session by username. For more details on NAI see RFC 2486. 

Default value is unchecked.

Exclude Sponsor Identity Avp If checked, it does not add the Sponsor-Identity AVP to the 
Charging-Rule-Definition grouped AVP. This option is used only in case the 
PCEF advertised support for SponsoredConnectivity feature under 
Supported-Features AVP. 

Default value is unchecked.

Load By Called Station Id If checked, attempts to load the session by IMSI and APN. In order for this 
option to be effectively used 'Load By Imsi' option (described above) needs to 
be checked. 

Default value is unchecked.

Re-install Rule on Monitoring Key 
Change

If checked, attempts to re-install a charging rule in case the only AVP value that 
changed for a PreConfiguredRule is the monitoring key value. 

Default value is not unchecked.

Table 15 Flow-Direction AVP Values

Priority Criteria Flow-Direction AVP Value

1 Flow-Description AVP value contains “permit in” UPLINK (2)

2 Flow-Description AVP value contains “permit out” DOWNLINK (1)

3 FlowStatus AVP value is ENABLED (2) BIDIRECTIONAL (3)

4 FlowStatus AVP value is ENABLED_UPLINK (0) UPLINK (2)

5 FlowStatus AVP value is ENABLED_DOWNLINK (1) DOWNLINK (1)

Table 14 Gx Client Parameters - Basic Options

Parameter Description
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Refer to the CISCO StarOS 16 and CISCO ASR5500 documentation for more details.

Default value (if enabled) is 1.

Max Pending Transaction Retry Count does not include the initial request. For example, in the above case the system will 
send a initial message and if it fails, it will send the same message 1 more time (retry).

Note: PCRF will cache and retry only one message per Gx session. If due to Rx IMS session interaction multiple Gx RAR 
messages are being evaluated while another Gx RAR message is already pending than PCRF will not reply on the Rx IMS 
session. 

Sponsored Profile
The default monitoring key name format used to track the usage when the AF provides sponsored data connectivity to 
the subscriber is:

_<Sponsor-Id>_< Rx-Session-No>

where:

 <Sponsor-Id>: Sponsor-Identity AVP value under the Sponsored-Connectivity-Data grouped AVP.

 <Rx-Session-No>: Counts how many Rx sessions have bound so far to the Gx session by the time the current Rx 
session is created. This is an attribute of the Rx session stored on PCRF side and it doesn't change during the Rx 
session lifetime. The value starts from zero and it increases with one for each new Rx session that binds.

This feature allows for customization of the monitoring key name. The monitoring key name matching the 
Sponsor-Identity AVP value and Application-Service-Provider-Identity AVP value will be used instead of the default one.

This option is used only in case the PCEF advertised support for SponsoredConnectivity feature under 
Supported-Features AVP.
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Rx Based QoS Upgrade of Default Bearer
This provides an option to over-ride Throttle with Boost for same priority values received in Dynamic-PCC-Request-QoS.

The following restrictions apply for this feature:

 This feature is applicable for QoS uplift on Default Bearer only.

 This feature overrides the earlier implementation of QoS uplift done in CPS 7.0.5 and earlier versions.

Count of Flow Description in one Charging Rule
CPS now supports the ability to split Flow Information received from the Traffic Detection Function (TDF) in a CCR-Update 
across multiple Charging Rules and sent over the Gx interface. 

This release provides the ability for CPS to distribute the TFTs across multiple CRNs. The distribution of TFTs keeps the 
Uplink and Downlink flows together in the same CRN. The number of TFTs per CRN is configurable. By default, CPS is 
configured to allow 8 TFTs per CRN.

The following parameter can be configured:

Table 16 Count of Flow Descriptions in one Charging Rule Parameters

Parameter Description

Count of TFT’s in one Charging Rule One TFT is equivalent to or denotes one Flow-Description AVP received in 
the message.
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Charging Rule Retry
Upon failure of installation of any/all of the TFTs across one or both CRNs, a configurable retry timer is activated with a 
configurable number of retries for the TFTs marked as “INACTIVE”. The number of retries and the timer interval between 
each retry is configurable.

The following parameters can be configured under Charging Rule Retry:

Upon failure to install TFTs even after retry, all remaining flows are removed (if there were any successfully installed) 
followed by termination of the Sd Session. After a refresh, CPS attempts to re-establish the Sd-Session. CPS also marks 
the failed flows as INACTIVE.

Table 17 Charging Rule Retry Parameters

Parameter Description

Retry Interval The delay between retry attempts. 

The default interval is 10 secs. Also, by default, the value is capped at 15 secs 
(configurable). If value is less that 15 secs, then the retries will be scheduled at second 
level granularity. If value is greater than 15 secs, then granularity is of 1 minute (overdue 
retry events are checked every minute rather than each second). 

Max Retry Attempts The maximum times retry is attempted for a rule.

Default value is 3 attempts.

Backoff Algorithm The back-off algorithm used while determining the actual delay between retry attempts. 

Currently only one option is supported:

 Constant Interval: Causes the configured retry interval to be used (without and 
change) for delay for all retry attempts (other options like exponential back-off 
where retry interval increases exponentially are currently not 
supported/implemented).
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Custom Dynamic Rule Name
For an Rx call a different Rx dedicated bearer is created for each Media-Sub-Component grouped AVP in the incoming 
Rx AAR message. This feature allows for customization of the Rx dedicated bearer name based on the 
AF-Application-Identifier AVP value and Media-Type AVP value received in Rx AAR message.

The default Rx dedicated bearer name format is:

_<Rx-Session-No>_<MCD-No>_<Flow-Number>_<partialRulename>_<Media-Type>

where:

 <Rx-Session-No>: Counts how many Rx sessions have bound so far to the Gx session by the time the current Rx 
session is created. This is an attribute of the Rx session stored on PCRF side and it doesn't change during the Rx 
session lifetime. The value starts from zero and it increases with one for each new Rx session that binds.

 <MCD-No>: Media-Component-Number AVP value under Media-Component-Description grouped AVP for the 
current Media-Sub-Component grouped AVP.

 <Flow-Number>: Flow-Number AVP value for the current Media-Sub-Component grouped AVP.

 <partialRulename>: Partial Rule Name value matching the current Af Application Id and Media Type values for the 
current Media-Sub-Component grouped AVP or “AF” if no match.

 <Media-Type>: Media-Type AVP value for the current Media-Sub-Component grouped AVP.

Note: Only the <partialRulename> part can be customized.
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Rx Clients
This specific diameter client object is supposed to be used only in relation with the Rx interface. It adds Rx specific 
features to the generic diameter client already described in Diameter Clients, page 74.

The following parameters can be configured under Rx Client:

Table 18 Rx Client Parameters

Parameters Description

Session Binding Attribute Allows the Rx sessions initiated by this client to bind to the Gx session by other 
attribute than the IP address as per 3GPP TS 29.214. For more information, refer 
to Table 19 on page 86.

Emergency URN List The list of URNs that are used to indicate that a AF session relates to emergency 
traffic as per procedures described in 3GPP TS 29.214.

Override AF App Id with URN for 
Emergency sessions

Overrides the AF-Application-Identifier AVP value with the Service-URN AVP 
value for emergency calls. This option is provided in order to overcome the lack 
of AF-Application-Identifier AVP value in Rx AAR in case of IMS emergency calls.

Default value is unchecked.

Validate Flow-Description AVP 
Value

When checked, CPS validates the Flow-Description AVP values received as part 
of Media-Sub-Component based on restrictions provided in the 3GPP 29.214 
Release 11 specification. If the Flow-Description value does not comply with the 
format specified, then the AAR request is rejected with FILTER_RESTRICTIONS 
(5062) value in Experimental-Result-Code. 

When the check box is unchecked, CPS does not validate the Flow-Description 
AVP value and simply forwards it is as is to PCEF as part of generated rules.

Default value is unchecked.
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       “IMSI and APN” and “MSISDN and APN” session binding attribute values are provided in order to support non 3GPP TS 29.214 
compliant Rx clients.

Gy Clients
This specific diameter client object is supposed to be used only in relation with the Gy interface. It adds Gy specific 
features to the generic diameter client already described in Diameter Clients, page 74.

Table 19 Session Binding Attribute Values

Session Binding Attribute value Description

IP Address (default) Attempts to bind by:

 1: Framed-IP-Address

 2: Framed-IPv6-Prefix

IMSI and APN IMSI value and APN value from incoming request

MSISDN and APN MSISDN value and APN value from incoming request
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The following parameters can be configured under Gy Client:

      Both of the above mentioned flags help in binding the Gy session to correct Gx session when multiple Gx sessions exist for 
the same user.

In both cases User Id is:

Diameter Defaults
The Diameter Defaults section provides global default values for different modules of the system.

In order to define a Diameter Default you need to perform the following steps:

1. Login into Policy Builder.

2. Select Reference Data tab.

3. From the left pane, select Diameter Defaults.

4. Select Summary.

5. Create the specific default object according to your needs.

6. Provide values for at least the mandatory fields.

Note:

 The mandatory fields are marked with a “*” on the upper left corner of the field name label.

 There should be at most one object for each diameter default type or the results will be unpredictable. The Policy 
Builder GUI does not enforce this restriction though.

This section covers the following topics:

 Custom AVP Profile, page 88

 ToD Schedule, page 93

Table 20 Gy Client Parameters

Parameters Description

Load By Realm And User Id If checked, attempts to load the session by realm (Origin-Realm AVP value) and 
User Id. 

Default value is unchecked.

Load By Apn And User Id If checked, attempts to load the session by APN (Called-Station-Id AVP value) and 
User Id. 

Default value is unchecked.

User Id AVP Value

IMSI Subscription-Id-Data AVP value under Subscription-Id grouped AVP where Subscription-Id-Type AVP 
value is END_USER_IMSI (1)

MSISDN Subscription-Id-Data AVP value under Subscription-Id grouped AVP where Subscription-Id-Type AVP 
value is END_USER_E164 (0)

NAI Subscription-Id-Data AVP value under Subscription-Id grouped AVP where Subscription-Id-Type AVP 
value is END_USER_NAI (3)
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 Sd Push Rules, page 95

 Gx Profile, page 96

 MPS Profile, page 101

 Rx Profile, page 103

Custom AVP Profile
This feature allows the Service Provider to extend the Diameter dictionary with new vendor specific AVPs along with a 
source for that AVP and a destination where the AVP is going to be used.

The feature itself consists of two components:

 Custom Avp Table

 Avp Mappings

Custom Avp Table
This table allows for the definition of the custom AVP with all the standard attributes of an AVP.

The following parameters can be configured under Custom Avp Table:

Table 21 Custom Avp Table Parameters

Parameter Description

AVP Name Any string that will be used to identify this custom AVP.

Avp Code AVP Code combined with Vendor Id field, identifies the attribute uniquely.

 1 - 255: Backward compatibility with Radius, without setting the Vendor Id field.

 256 - above: Used for Diameter, and are allocated by IANA.

Vendor Id It indicates whether Vendor Id field is there in the AVP or not.

Vendor Code Vendor Id value as assigned by IANA. The Vendor Id bit, known as the Vendor-Specific bit, 
indicates whether the optional Vendor Code field is present in the AVP header. When set the 
AVP Code belongs to the specific vendor code address space.

Mandatory Bit Indicates whether support of the AVP is required. If this Bit is checked, then Diameter Client, 
Server, Proxy and Translation Agent must support the handling of this AVP.
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Avp Mappings
This table allows for the mapping between the source and the destination for the custom AVP (defined in the previous 
section). Multiple attributes can be used to identify both the source for the custom AVP value as well as the destination 
where the AVP is going to be used.

The following mappings are supported:

 Custom AVP to Custom AVP Mapping: Maps a custom AVP to another custom AVP.

 3gpp / spr AVP to 3gpp AVP Mapping: Maps a 3GPP AVP or a SPR attribute to a 3GPP AVP.

 3GPP / SPR AVP to Custom AVP Mapping: Maps a 3GPP AVP or a SPR attribute to a custom AVP.

Custom AVP to Custom AVP Mapping

Protected Bit Indicates the need for encryption for end-to-end security. If this bit is checked indicates that 
AVP data is encrypted for end-to-end security.

Vendor Id Bit Indicates whether the optional Vendor-ID field is present in the AVP header. 

Data Type Any valid basic AVP data format:

 Float32Avp

 Float64Avp

 Integer32Avp

 Integer64Avp

 OctetStringAvp

 Unsigned32Avp

 Unsigned64Avp

 UTF8String

Table 21 Custom Avp Table Parameters

Parameter Description
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The following parameters can be configured under Custom AVP to Custom AVP Mapping:

Response value for Source Cmd Type and Target Cmd Type is not currently supported.

3gpp / spr AVP to 3gpp AVP Mapping

Table 22 Custom AVP to Custom AVP Mapping Table Parameters

Parameter Description

Source Avp Name of AVP that has to be looked up for possible mapping.

Source App Id The Application Interface Id (Gx) in numeric format (16777238) on which the Source AVP is 
received.

Source Cmd Code The command code of the message on interface Source APPID that contains the Source 
AVP.

Source Cmd Type The message indicated by Source Command Code is a request or response. Types: 

 Request

 Response

Origin Host This field contains the identification of the source point of the operation.

Origin Realm This field contains the identification of the realm of the operation originator.

Target Avp AVP Name that is actually mapped to Source AVP.

Target App Id Target Application Identifier (Sy - 16777302 - for this release).

Target Cmd Code The command code of the message that goes on Target APPID and have Target AVP.

Target Cmd Type The message having Target Command Code request or a response.

Types: 

 Request

 Response

Destination Host This field contains the identification of the destination point of the operation.

Destination Realm This field contains the realm of the operation destination.
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The following parameters can be configured under 3gpp / spr AVP to 3gpp AVP Mapping:

Response value for Source Cmd Type and Target Cmd Type is not currently supported.

3GPP / SPR AVP to Custom AVP Mapping

Table 23 3gpp / spr AVP to 3gpp AVP Mapping Table Parameters

Parameter Description

Source Avp Name of AVP that has to be looked up for possible mapping.

Is SPR AVP? Check if the source is an SPR attribute. The Source AVP originates from a Source Command 
or from Subscriber profile in Subscriber Profile Repository.

Default value is unchecked.

Source App Id The Application Interface Id (Gx) in numeric format (16777238) on which the Source AVP is 
received.

Source Cmd Code The command code of the message on interface Source APPID that contains the Source 
AVP.

Source Cmd Type The message indicated by Source Command Code is a request or response. Types: 

 None

 Request

 Response

Origin Host This field contains the identification of the source point of the operation.

Origin Realm This field contains the identification of the realm of the operation originator.

Target Avp AVP Name that is actually mapped to Source AVP.

Target App Id Target Application Identifier (Sy - 16777302 - for this release).

Target Cmd Code The command code of the message that goes on Target APPID and have Target AVP.

Target Cmd Type The message having Target Command Code request or a response.

Types: 

 Request

 Response

Destination Host This field contains the identification of the destination point of the operation.

Destination Realm This field contains the realm of the operation destination.
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The following parameters can be configured under 3GPP / SPR AVP to Custom AVP Mapping:

Response value for Source Cmd Type and Target Cmd Type is not currently supported.

Table 24 3GPP / SPR AVP to Custom AVP Mapping Table Parameters

Parameter Description

Source Avp Name of AVP that has to be looked up for possible mapping.

Is SPR AVP? Check if the source is an SPR attribute. The Source AVP originates from a Source Command 
or from Subscriber profile in Subscriber Profile Repository.

Default value is unchecked.

Source App Id The Application Interface Id (Gx) in numeric format (16777238) on which the Source AVP is 
received.

Source Cmd Code The command code of the message on interface Source APPID that contains the Source 
AVP.

Source Cmd Type The message indicated by Source Command Code is a request or response. Types: 

 None

 Request

 Response

Origin Host This field contains the identification of the source point of the operation.

Origin Realm This field contains the identification of the realm of the operation originator.

Target Avp AVP Name that is actually mapped to Source AVP.

Target App Id Target Application Identifier (Sy - 16777302 - for this release).

Target Cmd Code The command code of the message that goes on Target APPID and have Target AVP.

Target Cmd Type The message having Target Command Code request or a response.

Types: 

 Request

 Response

Destination Host This field contains the identification of the destination point of the operation.

Destination Realm This field contains the realm of the operation destination.
92



  
Diameter Configuration

Diameter Defaults
ToD Schedule
This feature allows for different PCC rules to be installed on a per time-of-day basis. Based on the defined schedules 
PCRF will look ahead one scheduled interval every time the policy is re-evaluated and will schedule for each PCC rule 
an activation time using the Rule-Activation-Time AVP and de-activation time using the Rule-Deactivation-Time AVP.

 Both Start Time and End Time need to be defined in hh:mm 24hr format.

 UE time zone (3GPP-MS-TimeZone AVP) if available, takes precedence over PCRF time-zone.

 ToD schedule should be complete for 24 hours.

 There should be no overlapping between the different schedule Switch Times.

 First charging schedule should start at mid-night with start-time value as 00:00 and last schedule should end on 
next mid-night with end-time value as 23:59. Time entry with 23:59 is rounded up to the next minute to complete 
the 24 hour schedule.

The ToD Schedule can be referenced only from a PreDefinedRule, PreDefinedRuleBase or a PreConfiguredRule 
service configuration object. 

In order to use a ToD Schedule in a Service Option you need to perform the following steps:

1. Login into Policy Builder.

2. Select Services tab.

3. From the left pane, select Services.

4. Expand Service Options tree.

5. Select and expand your service option.

6. Select the service option object.

7. Select the Value cell corresponding to the ToD Schedule.
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8. Push the “…” button.

9. Select the ToD Schedule from the pop-up window. 

10. Click OK.

For more details about how to define a service option refer to Services chapter.
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Sd Push Rules
This section supports the Sd solicited reporting scenario when the TDF-Information grouped AVP is not sent from the 
PCEF to the PCRF in a Gx CCR-i. For more information on Sd solicited reporting refer to 3GPP TS 29.212.

The following parameters can be configured under Sd Push Rules:

Note:

 The first choice for Gx Host Pattern value should always be the exact peer realm name whenever possible.

 No Sd session is initiated if there's no match for the input columns in the Sd Push Rules table.

Table 25 Sd Push Rules

Parameter Type Message Attribute AVP

Input Gx CCR-i Gx Realm Origin-Realm

Gx Host Pattern Origin-Host

Output Sd TSR TDF Realm Destination-Realm

TDF Host Destination-Host
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Gx Profile
This section provides default values to be used for Gx default bearer QoS parameters as well as some specific behavior 
related to default bearer QoS.
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The following parameters can be configured under Gx Profile:

Table 26 Gx Profile Parameters

Parameter Description

Push Pre Configured Rule Options Controls whether the configured default bearer QoS will be installed on 
the default bearer or on the secondary bearers.

 PushOnDefaultBearerQoS (default)

 PushWithUpgradedDefaultBearerQoS

Logical Apn Allows for a default APN name to be defined. This APN name is going to 
be further used as an input into the AF Application Id Validation feature 
described below. The APN value will be set based on the available data 
and the priorities described below.

 1: A policy derived AVP having the same value as the Logical Apn

 2: Called-Station-Id AVP from incoming Rx AAR

 3: Called-Station-Id AVP from Gx session

Gx Client QoS Exclusion List Gx client names that are allowed not to have a default bearer QoS 
installed. In case a default bearer QoS has not been configured in the 
policy and the Gx client name has not been added to this list an error 
response will be sent to the PCEF containing the Result-Code AVP value 
DIAMETER_ERROR_BEARER_NOT_AUTHORIZED (5143).

Grant Requested QoS Controls whether the requested QoS should be granted or not as the 
default bearer QoS. 

Default value is unchecked.

Grant Requested Qos Over Global Qos If this option is selected then the requested QoS should be granted even 
if the global QoS is provisioned. There are three type of QoS, first is taken 
from service second is from default QoS and third one is from request. If 
this flag is checked then requested QoS will take priority over default 
QoS.

Default value is unchecked.

Global Default Granted QoS

Qci The QoS class identifier identifies a set of IP-CAN specific QoS 
parameters that define QoS, excluding the applicable bitrates and ARP. 
It is applicable both for uplink and downlink direction. The QCI values 0, 
10 – 255 are divided for usage as follows:

 0: Reserved

 10-127: Reserved

 128-254: Operator specific

 255: Reserved

Max Req Bandwidth UL It defines the maximum bit rate allowed for the uplink direction.

Max Req Bandwidth DL It defines the maximum bit rate allowed for the downlink direction.

Guaranteed Bit Rate UL It defines the guaranteed bit rate allowed for the uplink direction.
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ARP
Select the Arp type from the drop-down list to open parameters for the corresponding selection. ARP is used to indicate 
the priority of allocation and retention.

Guaranteed Bit Rate DL It defines the guaranteed bit rate allowed for the downlink direction.

Apn Agg Max Bit Rate UL It defines the total bandwidth usage for the uplink direction of non-GBR 
QCIs at the APN.

Apn Agg Max Bit Rate DL It defines the total bandwidth usage for the downlink direction of 
non-GBR QCIs at the APN.

Table 26 Gx Profile Parameters

Parameter Description
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The following parameters can be configured under Arp:

Table 27 ARP Parameters

Selection Parameters Description

Allocation Retention 
Priority

Priority Level The priority level is used to decide whether a bearer establishment 
or modification request can be accepted or needs to be rejected in 
case of resource limitations (typically used for admission control of 
GBR traffic). The AVP can also be used to decide which existing 
bearers to pre-empt during resource limitations. The priority level 
defines the relative importance of a resource request. Values 1 to 15 
are defined, with value 1 as the highest level of priority.

 Values: 1 to 8 - assigned for services that are authorized to 
receive prioritized treatment within an operator domain.

 Values: 9 to 15 - Can be assigned to resources that are 
authorized by the home network and thus applicable when a UE 
is roaming.

Preemption 
Capability

If it is provided within the QoS-Information AVP, the AVP defines 
whether a service data flow can get resources that were already 
assigned to another service data flow with a lower priority level. If it 
is provided within the Default-EPS-Bearer-QoS AVP, the AVP 
defines whether the default bearer can get resources that were 
already assigned to another bearer with a lower priority level.

 0: This value indicates that the service data flow or bearer is 
allowed to get resources that were already assigned to another 
service data flow or bearer with a lower priority level.

 1: This value indicates that the service data flow or bearer is not 
allowed to get resources that were already assigned to another 
service data flow or bearer with a lower priority level. This is the 
default value applicable if this AVP is not supplied.

Preemption 
Vulnerability

If it is provided within the QoS-Information AVP, the AVP defines 
whether a service data flow can lose the resources assigned to it in 
order to admit a service data flow with higher priority level. If it is 
provided within the Default-EPS-Bearer-QoS AVP, the AVP defines 
whether the default bearer can lose the resources assigned to it in 
order to admit a pre-emption capable bearer with a higher priority 
level.

 0: This value indicates that the resources assigned to the 
service data flow or bearer can be pre-empted and allocated to 
a service data flow or bearer with a higher priority level. This is 
the default value applicable if this AVP is not supplied.

 1: This value indicates that the resources assigned to the 
service data flow or bearer shall not be pre-empted and 
allocated to a service data flow or bearer with a higher priority 
level.

Application QoS Policy Af Application 
Identifier

It contains information that identifies the particular service that the 
AF service session belongs to. This information may be used by the 
PCRF to differentiate QoS for different application services.

Media Type Applicable Media-Type (session level or specific to 
Media-Component-Description). The list includes Audio, Video, 
Data, Application, Control, Text, Message, and Other.
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Relaxed USAGE_REPORT Event-Trigger Handling
Use this check box to enable the functionality for supporting old event-trigger value (26) for usage report. This 
configuration will be applicable only when CPS is configured to use R10 event-trigger values by unchecking the 'Use V9 
Event Trigger Mapping' flag in Diameter Configuration, page 55.

Peers using Event-Trigger value (26) for USAGE_REPORT
This table contains the list of realm and host entries for which CPS will support old event-trigger value (26) for 
USAGE_REPORT.

Reservation Priority 
QoS Policy

Reservation Priority The Reservation Priority includes the priority value of the related 
priority service. The Reservation Priority is populated with a default 
value if the priority value is unknown.

Base MPS QoS/Base 
MPS QoS Gx

Qci The QoS class identifier identifies a set of IP-CAN specific QoS 
parameters that define QoS, excluding the applicable bit rates and 
ARP. It is applicable both for uplink and downlink direction. The QCI 
values 0, 10 – 255 are divided for usage as follows:

 0: Reserved

 10-127: Reserved

 128-254: Operator specific

 255: Reserved

MPS QoS MPS Id The MPS Id contains the national variant for MPS service name 
indicating an MPS session.

Media Type Applicable Media-Type (session level or specific to 
Media-Component-Description). Select from drop-down list. The 
list includes Audio, Video, Data, Application, Control, Text, 
Message, and Other.

Table 27 ARP Parameters

Selection Parameters Description
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The following parameters can be configured under Relaxed USAGE_REPORT Event-Trigger Handling:

MPS Profile
This section provides default values to be used if MPS feature is needed to support eMPS priority. The MPS Profile 
provides MPS attributes required for priority service provisioning. The priority level value from Service configuration takes 
precedence over MPS Profile value.

Note: There must be at least one Mps Profile defined under Mps Profiles.

Table 28 Relaxed USAGE_REPORT Event-Trigger Handling Parameters

Parameters Description

Realm Pattern The pattern that peer realm name should match in order for this diameter client to be used. 
The pattern needs to follow the standard Java regular expression syntax described here.

The first choice for Realm Pattern value should always be the exact peer realm name 
whenever possible.

Host Pattern Host name pattern as received in Origin-Host AVP in AAR message. The pattern needs to 
follow standard Java pattern conventions. The pattern needs to follow the standard Java 
regular expression syntax described here.
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The following parameters can be configured under Mps Profile:

For additional information on 3GPP specifications refer to http://www.3gpp.org/DynaReport/29212.htm.

The above link is compliant with Release 11.

Table 29 Mps Profile Parameters

Parameter Description

Ims Apn List of IMS APNs for which the MPS feature is supported. 

This field can accommodate several Ims Apn that are used to match with the incoming service 
request for priority service. The values that are received by the Default Bearer QoS are looked up 
for a suitable Ims Apn match. If the APN value of a Gx session request matches IMS APN, IMS 
signaling priority from EMPS service is used as priority level.

Mps QoS For information on parameters under Mps QoS, refer to Table 27 on page 99.
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Rx Profile
This section provides default values as well as specific values to be used by the different QoS parameter mapping 
functions at PCRF as per 3GPP TS 29.213. This section also provides a mechanism to authorize the Rx IMS sessions.
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Basic Options

Default QoS Policy
Provides the values to be used during the derivation of the Maximum Authorized Data Rates, Authorized Guaranteed Data 
Rates, Maximum Authorized QoS Class per IP flow or bidirectional combination of IP flows in the PCRF and for calculating 
the Maximum Authorized/Guaranteed Data Rates, QCI and ARP in the PCRF whenever the “as set by the operator” phrase 
is used in the algorithm description.

For description of different parameters under Default QoS Policy, refer to Table 26 on page 97.

MPS QoS Policy
Provides a way to derive QoS attributes for MPS sessions based on some other AVP values. 

For description of different parameters under MPS QoS Policy, refer to Table 27 on page 99.

Note: A Media-Type having an empty label shall be used only to get the output values to be used for default bearer QoS.

Application QoS Policy
Provides a way to derive Rx dedicated bearers QoS attributes based on AF-Application-Identifier AVP value as per 3GPP 
TS 29.213. 

For description of different parameters under Application QoS Policy, refer to Table 26 on page 97 and Table 27 on 
page 99.

Codec QoS Policy
Provide a way to derive Rx dedicated bearers QoS attributes based on Codec-Data AVP value as per 3GPP TS 29.213.

For description of different parameters under Codec QoS Policy, refer to Table 26 on page 97 and Table 27 on page 99.

The additional parameter Codec Data contains codec related information known at the AF. This information is encoded 
as follows:

The first line of the value of the Codec Data consists of either the word “uplink” or the word “downlink” (in ASCII, without 
quotes) followed by a new-line character. The semantics of these words are the following:

 “uplink” indicates that the SDP was received from the UE and sent to the network.

 “downlink” indicates that the SDP was received from the network and sent to the UE.

For example:
1. Codec Data value used as the search key in this table is the 4th group (of numbers) from the 3rd line of the 

Codec-Data AVP string value.

In the example below only the value 116 is going to be used as a search key in the Codec QoS Policy table.

uplink
offer
m=audio 50000 RTP/AVP 116 107 97 115 111 110
a=rtpmap:116 AMR-WB/16000
a=rtpmap:107 AMR-WB/16000
a=rtpmap:97 AMR/8000
a=rtpmap:115 AMR/8000
a=rtpmap:111 telephone-event/16000
a=rtpmap:110 telephone-event/8000
a=curr:qos local none
a=curr:qos remote none
a=des:qos mandatory local sendrecv
a=des:qos optional remote sendrecv
a=sendrecv
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a=ptime:20
a=maxptime:240

2. Only the first Codec-Data AVP value is used.

Reservation Priority QoS Policy
Provides a way to derive Rx dedicated bearers QoS attributes based on Reservation-Priority AVP value as per 3GPP TS 
29.213.

For description of different parameters under Reservation Priority QoS Policy, refer to Table 26 on page 97 and 
Table 27 on page 99.

Af Application Id Validation
Provides a way to authorize the Rx IMS sessions. In case there's not a match between the AVP values below in the table 
the PCRF shall send an error response to the AF containing the Experimental-Result-Code AVP with value 
REQUESTED_SERVICE_NOT_AUTHORIZED (5063) as per 3GPP TS 29.214.

Note: 

 Called-Station-Id AVP value is retrieved from the Gx session the Rx session binds to.

 If the incoming Rx AAR message contains multiple flows having different AF-Application-Identifier AVP value or 
Media-Type AVP value and any of these flows is not authorized than the PCRF shall send an error response as 
described above.

 If no AF-Application-Identifier AVP is present in the incoming request the validation is skipped.

Advanced Options
You can get access to these features by creating child objects to your Rx profile object.

Note: There should be at least one object of each type for any Rx profile object or the results will be unpredictable. The 
Policy Builder GUI does not enforce this restriction though.

Sponsored Data Charging Parameters
The Sponsored Data Charging Parameters allows you to configure specific charging parameters for the Sponsored Data 
scenarios depending on some AVPs from the incoming Rx AAR. These parameters are going to be set under 
Charging-Rule-Definition grouped AVP.

The required charging parameters are as follows:

 Rating-Group

 Reporting-Level

 Online

 Offline

 Metering-Method

Interface AVP Value

Gx Refer to Logical APN attribute under Gx Profile, page 96.

Rx AF-Application-Identifier

Media-Type
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To map the above mentioned parameters the following keys are used:

 Sponsor-Id

 Application-Service-Provider-Identity

 Media Type

These keys are applicable for Sponsored Data Charging Parameters only.

The mapping configuration for the charging parameters is configured under Policy Builder > Reference Data tab > 
Diameter Defaults > Rx Profile.
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In the Sponsor Data Charging table, user defines the parameter values in all the columns including the values for the key 
parameters such as - Sponsor Identity, App Service Provider Identity and Media Type. 

Default Sponsor Data Charging
Defines the default values for the sponsor data charging parameters under Charging-Rule-Definition grouped AVP to be 
used in case there's no match in the Sponsor Data Charging. This configuration is optional. Default value is unchecked.

The following parameters can be configured under Sponsor Data Charging:

Table 30 Sponsor Data Charging Parameters

Parameter Description

Service Identifier The identity of the service or service component the service data flow in a PCC rule 
relates to.

Rating Group The charging key for the PCC rule used for rating purposes.

Online It defines whether the online charging interface from the PCEF for the associated PCC 
rule is enabled. The default charging method provided by the CPS takes precedence 
over any pre-configured default charging method at the PCEF.

 Enable: This value is used to indicate that the online charging interface for the 
associated PCC rule is enabled.

 Disable: This value is used to indicate that the online charging interface for the 
associated PCC rule is disabled.

Offline It defines whether the offline charging interface from the PCEF for the associated PCC 
rule is enabled.The default charging method provided by the CPS takes precedence 
over any pre-configured default charging method at the PCEF.

 Enable: This value is used to indicate that the offline charging interface for the 
associated PCC rule is enabled.

 Disable: This value is used to indicate that the offline charging interface for the 
associated PCC rule is disabled.

Metering Method The Metering-Method AVP (AVP code 1007) is of type Enumerated, and it defines what 
parameters shall be metered for offline charging. The PCEF may use the AVP for online 
charging in case of decentralized unit determination and having three values:

 DURATION (0): This value shall be used to indicate that the duration of the service 
data flow shall be metered.

 VOLUME (1): This value shall be used to indicate that volume of the service data 
flow traffic shall be metered.

 DURATION_VOLUME (2): This value shall be used to indicate that the duration and 
the volume of the service data flow traffic shall be metered.
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Dynamic Rule Charging Parameter
The Dynamic Rule Charging Parameters allows you to configure different charging parameters for the Rx dedicated 
bearers. Charging parameters are defined for dynamic PCC rules so that the service provider can properly charge

Reporting Level The Reporting-Level AVP is of type Enumerated, and it defines on what level the PCEF 
reports the usage for the related PCC rule.There are three types of reporting levels:

 SERVICE_IDENTIFIER_LEVEL (0): This value shall be used to indicate that the 
usage shall be reported on service id and rating group combination level, and is 
applicable when the Service-Identifier and Rating-Group have been provisioned 
within the Charging-Rule-Definition AVP and Rating-Group AVP have been 
provisioned within the Charging-Rule-Definition AVP. Applicable for offline 
charging.

 RATING_GROUP_LEVEL (1): This value shall be used to indicate that the usage 
shall be reported on rating group level, and is applicable when the Rating-Group 
has been provisioned within the Charging-Rule-Definition AVP and Rating-Group 
AVP have been provisioned within the Charging-Rule-Definition AVP. Applicable 
for offline charging.

 SPONSORED_CONNECTIVITY_LEVEL (2): This value shall be used to indicate that 
the usage shall be reported on sponsor identity and rating group combination 
level, and is applicable when the Sponsor-IdentityAVP, 
Application-Service-Provider-Identity AVP and Rating-Group AVP have been 
provisioned within the Charging-Rule-Definition AVP. Applicable for offline 
charging. 

Precedence This determines the order, in which the service data flow templates are applied at 
service data flow detection at the PCEF. A PCC rule with the Precedence AVP with 
lower value shall be applied before a PCC rule with the Precedence AVP with higher 
value. 

Sponsor Identity Sponsor-Identity AVP value under the Sponsored-Connectivity-Data grouped AVP.

App Service Provider App Service Provider Id is same as Sponsor-Identity. its an AVP under the 
Sponsored-Connectivity-Data grouped AVP.

Media Type Applicable Media-Type (session level or specific to Media-Component-Description). 
Select from drop-down list. The list includes Audio, Video, Data, Application, Control, 
Text, Message, and Other.

Table 30 Sponsor Data Charging Parameters

Parameter Description
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for the traffic. For each Media-Sub-Component grouped AVP under Media-Component-Description grouped AVP in an 
AAR request PCRF installs a dynamic charging rule. The charging parameters for these dynamic PCC rules are not 
included in the AAR message so they are pulled out from the configuration.

In the Charing Parameters table, user defines the parameter values in all the columns including the values for the key 
parameters such as - Af Application Identity and Media Type. 
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Default Charging Parameters
Defines the default values for the charging parameters under Charging-Rule-Definition grouped AVP to be used in case 
there's no match in the Charging Parameters table. This configuration is optional. Default value is unchecked.

For description of different parameters under Dynamic Rule Charging Parameters, refer to Table 30 on page 107.

Note: 

 An empty value being selected in either of Online, Offline or Metering Method drop-boxes means no value is defined 
for that attribute so it will not be added to the Charging-Rule-Definition grouped AVP. Default value for all these three 
attributes is empty.

 The same parameters can be configured using an RxChargingParameterSTGConfiguration service configuration 
object.
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This chapter covers the following sections:

 Gx Interface Configuration, page 111

 Gy Interface Configuration, page 117

 Sy Interface Configuration, page 120

 Rx Interface Configuration, page 128

 Sd Interface Configuration, page 132

 LDAP Interface Configuration, page 142

Gx Interface Configuration
Use-Case:
The below example shows how to create a Gx service wherein the PCRF mirrors the QoS received from the 
PCEF/Gateway. When Credit-Control-Request (Initial) message is received by the PCRF, it sends the same QoS 
parameters back to the PCEF in the Credit-Control-Answer (Initial) message.

1. Open the Policy builder GUI.

2. Go to Services tab.

3. Under Use Case Templates, click Summary and then create a child use case template.

4. In this example, MirrorQoS is the name of the new template.
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5. In the newly created template, under Service Configurations section, click the Add button, this will list all the AVP's 
available on the PCRF and then select the following two objects from the gx section (as shown in the screenshot 
below).

a. DefaultBearerQoS

b. DefaultBearerQoSActions
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6. Go to the services section and then under Service Option tab, a new service option (having the same name as the 
template created above) would be available i.e. MirrorQoS. Create a child Service Option and name it MirrorQoS as 
well.

7. Upon clicking Create Child option, the below mentioned pop-up window appears which essentially contains the Gx 
Service Configuration Objects that were added to the template earlier and Click OK.
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8. Do not make any changes to the 1st object DefaultBearerQoS. Since we have to mirror the QoS that is sent by the PCEF, 
we do not have to provision or configure any QoS parameters in this case.

9. For the 2nd object DefaultBearerQoSActions, from the drop-down list, select the Action as 'Mirror' for all the AVP's. 
This is needed since we have to mirror the QoS as received from the PCEF. Set all the AVP's to mirror.

10. Go to Services and create a child service MirrorQoS.
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11. Update the Code and Name as MirrorQoS, uncheck the Balance Service for the newly created MirrorQoS service.

12. Click Add and select the MirrorQoS service created earlier.
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13. Click File and select Publish to Runtime Environment. This will make the newly created service available to all the 
qns nodes for processing.

14. In order to verify that the newly created service is available for use, open the control center GUI, go to the 
Subscribers section and select Create Subscriber.

15. Enter the IMSI/MSISDN and the Name of the subscriber, click Save & Continue.
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16. Go to the Services section.

17. Click on the Add section which lists the available services, select the new services created above i.e. 'MirrorQoS'.

18. Click Save and run a test call to verify that the QoS parameters are mirrored by PCRF in Credit-Control-Answer 
(Initial) message back to the PCEF.

Gy Interface Configuration
The Diameter Gy reference point is located between the OCS and the PCEF. The CPS supports using the Gy reference 
point for usage monitoring of the on-board OCS known as the Multi-service Balance Manager (MsBM) against a PCEF.

CPS uses the Gy RatingGroup Service Configuration Object within the Use Case Templates to hold the configuration 
parameters for Gy. The below example shows how to setup a Gy RatingGroup that will be sent upon a CCR-i request 
from the PCEF. The Gy RatingGroup service option would then be added to a service along with a Gx rule or QoS (refer 
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to Gx Interface Configuration, page 111 for details on how to create a valid Gx service).

The following example is based on the ASR5000 acting as the PCEF supporting the Enhanced Charging Service (ECS) 
mechanism for Gy “Pull” Usage Monitoring. The RatingGroup configuration for Gy will work in a similar method with any 
supported PCEF using the Gy interface.

Use Case Configuration:
1. Open the Policy Builder GUI.

2. Go to the Services tab.

3. Under Use Case Templates, click Summary and then create a child use case template.

4. Name the new template Gy.

5. In the newly created template, under the Service Configurations section, click the Add. This will list all the service 
configuration objects available on the PCRF and then select the RatingGroup object from the 'gy' section as shown 
below.

Note: There is no need to configure anything in the actual template, all parameters will be set as part of configuring the 
actual Service Option which will be added to the service.
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6. Whenever a new Use Case Template is created, a corresponding empty Service Option container is created as well. 
Go to the Services section and then under Service Options find the “Gy” folder, which represents the new Gy Use 
Case Template created above. Create a child Service Option and name it Gy.

Below is a description of the parameters necessary to support the ASR5000 ECS Usage Monitoring for a volume 
quota service.

Table 1 Rating Group Parameters

Parameter Description

Rating Group Corresponds to a value configured on the ASR5000 that represents which data should be 
monitored.

RG Type Rating Group Type supports one of two values, either “volume” or “time”.

Dosage How much quota to initially give the client (in bytes).

Balance Code

Final Unit Action In our example, we will use TERMINATE as the default Final Unit Action on quota depletion 
which will send a CCR-u with the final usage for the rating group; other options supported 
include NONE (no action taken) RESTRICT_ACCESS (send a Restriction Filter Rule and 
Filter ID) and REDIRECT (send a Redirect Address of Redirect Address Type).
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Priority and Diameter Client do not need to be set. Priority can be used to set the priority for the RatingGroup if multiple 
RatingGroups are on a service. 

Tariff Switch Model and Tariff Change Time are outside the scope of this document. 

Note: If Tariff Switch Model is not set, any value set in Tariff Change Time is ignored.

Validation Steps
1. Create a new service in Policy Builder that contains a Gx rule service configuration and the Gy RatingGroup service 

configuration.

Note: The Gx rule must be a rule defined on the PGW that is associated with a Gy service to the CPS as the OCS.

2. Per the Gy pull model, when the PCEF receives the appropriate Gx rule, it will initiate a CCR-i to the OCS which will 
reply back with the RatingGroup service option values in a CCA.

3. Using tcpdump, verify that the CCA contains the appropriate values as defined in the RatingGroup.

Sy Interface Configuration
The Sy reference point is located between the Policy and Charging Rules Function (PCRF) and the Online Charging 
System (OCS). The Sy reference point enables transfer of information relating to subscriber spending from OCS to PCRF 
and supports the following functions:

 Request of policy counter status reporting from PCRF to OCS.

 Notifications of policy counter status change from OCS to PCRF.

 Cancellations of policy counter status reporting from PCRF to OCS.

Since the Sy interface resides between PCRF and OCS in the HPLMN, roaming with home routed or visited access as 
well as non-roaming scenarios is supported in the same manner.

Use-Case:
The below example explains how to subscribe to the OCS (Online charging system) counter status updates from the 
PRCF side by initiating 'Spending Limit Request (SLR)' message. 

1. Make the configuration changes as described in Gx Interface Configuration, page 111.

2. Open the Policy builder GUI.

3. Go to the Services tab.

Validity Time Sets a session timer for the Gy quota grant; even if quota is not exhausted, the PCEF must 
check back in at the end of the validity time (in seconds).

Volume Quota Threshold PCEF will check back in with OCS when the Volume Quota Threshold has been reached; 
value must be set as less than the overall Dosage (in bytes)

Quota Holding Time Amount of time the quota should be available on the PCEF without activity from the user 
(in seconds)

Quota Consumption 
Time

Idle traffic threshold time (in seconds); only used with time quota rating groups.

Use Shared Bucket Used in a shared quota use case, in which the same account balance and rating group can 
be used within a shared group of users (false by default).

Table 1 Rating Group Parameters

Parameter Description
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4. Under Use Case Templates, click Summary and then create a child use case template.

5. In this example, Sy is the name of the new template.

6. In the newly created template, under Service Configurations section, click the Add button, this lists all the service 
configuration objects available on the PCRF and then select the following object from the 'sy' section (as shown in 
the screenshot below).

a. SpendingLimitReport
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7. Go to the services section and then under Service Option tab, a new service option (having the same name as the 
template created above) would be available i.e. Sy. Create a child Service Option and name it Sy as well.

8. Upon clicking Create Child option, the below mentioned pop-up window appears which essentially contains the 'sy' 
Service Configuration Objects that were added to the template earlier. Click OK. Name the Child Service 
Configuration object as 'Sy'.
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9. Update the Subscriber Id column as Session MSISDN. Based on user requirements, other identifiers like IMSI etc. 
can also be used.
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10. Update the Realm column with the Sy peer realm (OCS Realm) where the message needs to be sent from PCRF. In 
this configuration, we are not specifying any counter name in the 'Identifier' columns which means that the PCRF 
subscribes to all the counter statuses available on the OCS for the subscriber.

11. Go to Services and create a child service 'Sy'.

12. Update the Code and Name as Sy, uncheck the Balance Service for the newly created Sy service (unless explicitly 
needed for the use-case being developed).
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13. Click Add and select the 'Sy' service created earlier.

14. Click Add and select the MirrorQoS Gx Service created in the Gx Interface Configuration, page 111.

— By adding the Gx interface 'MirrorQoS' service, PCRF will mirror the QoS for this subscriber.

— By adding the Sy interface 'Sy' service, PCRF will subscribe with OCS for all counters per user.

— Both these Gx/Sy service options together will generate a successful end to end subscriber call.
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15. Click File and select Publish to Runtime Environment. This will make the newly created service available to all the 
qns nodes for processing.

16. In order to verify that the newly created service is available for use, open the control center GUI, go to the 
Subscribers section and select Create Subscriber.

17. Enter the IMSI/MSISDN and the Name of the subscriber, click Save & Continue.
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18. Go to the Services section.

19. Click on the Add section which lists the available services, select the new services created above i.e. 'Sy'.

20. Click Save and run a test call to verify the following:
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— QoS parameters are mirrored by PCRF in Credit-Control-Answer (Initial) message back to the PCEF.

— PCRF sends Spending Limit Request message to the PCS on the Sy interface, receives Spending Limit Answer 
message from the OCS.

Rx Interface Configuration
The Rx reference point is used to exchange application level session information between the Policy and Charging Rules 
Function (PCRF) and the Application Function (AF). This information is part of the input used by the PCRF for the Policy 
and Charging Control (PCC) decisions. 

The PCRF exchanges the PCC rules with the Policy and Charging Enforcement Function (PCEF) and QoS rules with the 
Bearer Binding and Event Reporting Function (BBERF).

The PCRF provides network control regarding the service data flow detection, gating, QoS and flow based charging 
(except credit management) towards the PCEF. The PCRF receives session and media related information from the AF 
and informs AF of traffic plane events.

When a new AF session is being established and media information for this AF session is available at the AF and the 
related media require PCC supervision, the AF shall open an Rx Diameter session with the PCRF for the AF session using 
an AA-Request command, unless an Rx session has already been established for the AF session. 

The AF shall provide the full IP address of the UE using either Framed-IP-Address AVP or Framed-Ipv6-Prefix AVP, and 
the corresponding Service Information within Media-Component-Description AVP(s). The AF shall indicate to the PCRF 
as part of the Media-Component-Description whether the media IP flow(s) should be enabled or disabled with the 
Flow-Status AVP.
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The AF may include the AF-Application-Identifier AVP into the AA-Request in order to indicate the particular service that 
the AF session belongs to. This AVP can be provided at both AF session level, and Media-Component-Description level. 
When provided at both levels, the AF-Application Identifier provided within the Media-Component-Description AVP will 
have precedence.

Use Case:
The below scenario explains configuration of the Rx parameters necessary for the establishment of a dedicated bearer 
and calculating/deriving the QoS for the Dynamic Charging rule names which PCRF sends to the PCEF via Gx RAR 
message.

1. Go to the Reference Data section in the policy builder GUI.

2. Under Diameter Defaults section, create a child Rx Profile.

3. Under Default QoS Policy section, update the mandatory AVP's as shown below (as required).
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NOTE: The Default QoS Policy section is used when there is no Application QoS Policy or Codec QoS Policy 
defined or when the incoming call doesn't match the configured values (w.r.t AF ID or other parameters).

4. Incase AF ID specific QOS handling is needed, below tables needs to be updated. If the AF-ID received in AAR message 
from the AF matches the AF Application Identifier configured under Application QoS Policy section, then the PCRF uses 
QOS attributes from this table to populate the dynamic rule QoS AVP's which is then sent to the PCEF for dedicated bearer 
establishment.
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5. Under the newly created Rx profile, create a child Dynamic Rule Charging Parameters and update the following 
fields (as per requirements, the values in the tables will be modified):

a. Update the default Dynamic Rule Charging Parameters:
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— This is used in case the provisioned values (AF Identifier based) do not match the incoming AAR message, 
essentially signifying that the AF ID in the AAR message is not provisioned or AAR message did not contain AF 
Identifier.

b. Update AF ID specific Dynamic Rule Charging Parameters.

— This is used in when the incoming AAR contains AF Identifier that is provisioned in the below table.

The above defined configuration is system wide applicable or based on a particular Rx Client if needed. To validate 
this, execute a basic VOLTE call with the standard Gx configuration and verify that the CPS is able to handle the 
incoming AAR message on the Rx interface and can trigger dynamic charging rules on the Gx interface towards the 
PCEF via RAR message.

Sd Interface Configuration
The Sd reference point is located between the Policy and Charging Rules Function (PCRF) and the Traffic Detection 
Function (TDF). 

For the solicited application reporting, the Sd reference point is used for:
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 Establishment and termination of TDF session between PCRF and TDF.

 Provisioning of Application Detection and Control rules from the PCRF for the purpose of traffic detection and 
enforcement at the TDF.

 Usage monitoring control of TDF session and of detected applications and reporting of the start and the stop of a 
detected applications traffic and transfer of service data flow descriptions for detected applications, if deducible, 
from the TDF to the PCRF. 

For the unsolicited reporting, the Sd reference point is used for:

 Establishment and termination of TDF session between PCRF and TDF.

 Reporting of the start and the stop of a detected application's traffic and transfer of service data flow descriptions 
for detected applications, if deducible, and transfer of Application instance identifier, if service data flow descriptions 
are deducible, from the TDF to the PCRF.

The PCRF may provide ADC Rules to the TDF by using Sd interface. 

Once the start or stop of the application's traffic, matching one of those ADC Rules, is detected, if PCRF has previously 
subscribed to the APPLICATION_START/APPLICATION_STOP Event-Triggers, unless a request to mute such a 
notification (Mute-Notification AVP) is part of the corresponding ADC Rule, the TDF shall report the information regarding 
the detected application's traffic to the PCRF and apply the enforcement actions, if defined within the corresponding 
ADC Rule.
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Use Case:
The below example shows how to initiate an Sd session from PCRF towards the TDF by sending a Predefined ADC Rule via 
TDF-Session-Request (TSR) message to the TDF and getting a successful TDF-Session-Answer (TSA) message on the PCRF.

1. Open the Policy builder GUI.

2. Make the configuration changes as described in Gx Interface Configuration, page 111.

3. Go to Services tab.

4. Under Use Case Templates, click Summary and then create a child use case template. In this example, Sd is the 
name of the new template.

5. In the newly created template, under Service Configurations section, click the Add button. This will list all the 
service configuration objects available on the PCRF and then select the following object from the 'sd' section (as 
shown in the example).
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— ADCPredefinedRule
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6. Go to the services section and then under Service Option, a new service option (having the same name as the 
template created above) would be available i.e. Sd. Create a child Service Option and name it Sd as well.
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7. Upon clicking Create Child option, the below mentioned pop-up window appears which essentially contains the 'sd' 
Service Configuration Objects that were added to the template earlier. Click OK. Name the Child Service 
Configuration object as 'Sd'.

8. Update the Rule Name column with the ADC Rule that is provisioned on the TDF and which the PCRF needs the TDF 
to enforce.

Note: The rule which is being configured here MUST be already provisioned on the TDF else it will lead to an error 
response from the TDF (unknown rule name).
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In this example, we assume that test-rule-1 is provision on TDF.

9. Go to Services and create a child service 'Sd'.
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10. Update the 'Code' and 'Name' as Sd. Uncheck the 'Balance Service' for the newly created Sd service (unless 
explicitly needed for the use-case being developed).

11. Click Add and select the 'Sd' service created earlier.
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12. Click Add and select the 'MirrorQoS' Gx Service created in the Gx Interface Configuration, page 111.

— By Adding Gx interface 'MirrorQoS' service - PCRF will mirror the QoS for this subscriber.

— By Adding Sd interface 'Sd' service - PCRF will trigger TSR request with ADC rule towards TDF.

— Both Gx/Sd service options together will generate successful end to end subscriber call.

13. Click File > Publish to Runtime Environment. This will make the newly created service available to all the qns nodes 
for processing.

14. Select Reference Data tab, under Diameter Defaults, and create a child Sd Push rule.

15. In order to initiate connections towards the TDF on Sd interface, the below table needs to be populated with origin 
and remote Host/Realm configuration. 
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— The Sd service/template defined earlier in this guide will send messages to the TDF based on the host/realm 
configuration defined here. For more information on how to configure the below table, refer to Diameter 
Defaults.

16. In order to verify that the newly created service is available for use, open the Control Center GUI, select Subscribers 
tab and select Create Subscriber.

17. Enter the IMSI/MSISDN in Credential field and the Name of the subscriber, click Save & Continue.

18. Go to the Services section.
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19. Click add which will list the available services, select the new services created above i.e. 'Sd'.

20. Click Save and run a test call to verify that the: 

— QoS parameters are mirrored by PCRF in Credit-Control-Answer (Initial) message back to the PCEF.

— PCRF sends TDF-Session-Request message to the TDF on the Sd interface (with the Predefined ADC rule), 
receives TDF-Session-Answer message from the TDF.

LDAP Interface Configuration
For more information on LDAP Interface Configuration, refer to Domains, page 143.
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This chapter covers the following sections:

 Overview, page 143

 Strategies for Defining Domains, page 144

 Defining a Domain, page 144

 Creating a Custom Reference Data (CRD) table for APN mapping, page 154

 Validation Steps, page 157

Overview
The Access Point Network (APN) attribute is sent to the CPS PCRF on the diameter Gx CCR-I message or within the Gy 
CCR-I message.   Generally, an operator will desire to define specific subscriber profile rules and service definitions that 
apply to all subscribers that are attached to the given APN.   Within CPS, the APN profile rules are defined in the Domains 
section of the Services tab is shown below:

The Domain definition within the system controls the following behavior:

 Retrieves the user profile from the CPS SPR database. This step is optional and depends upon whether the operator 
is storing subscriber profiles in the CPS SPR database.

 Retrieves a user profile from an external data source via the LDAP/Ud protocols or the Diameter Sh protocol.

 Defines the default service(s) that are assigned to a user's session under the given conditions. For information on 
services, refer to Services, page 161.
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Strategies for Defining Domains
There are two strategies that can be used when creating Domains for APN profiles. These approaches are:

1. Define one domain per logical APN. This approach is the most flexible and preferred approach for production 
deployments. The approach uses an APN mapping table to map the APN value to a logical APN. This allows all similar 
APNs to have the same profile. An example, is mapping “data_1” to “DATA”.    

Note: Definition of an APN to logical APN mapping table is required to utilize this strategy. Defining this mapping 
table is shown at the end of this chapter.

2. Define one default domain for the system. This approach should only be utilized if multiple APNs are not defined or 
for proof of concept/demonstration environment systems.

Defining a Domain
Defining a domain requires selecting the Domain section under Services tab and the clicking Domain from the right pane 
as shown below. 
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Defining the General Attributes of the Domain
Once the Create Child: Domain action is selected, the following screen appears for data entry:

The following parameters can be configured under General tab.

Table 1 General tab Parameters

Parameter Description

Name This is a short textual name of the domain that describes the APN that is mapped into 
this domain node. For example, VOLTE would imply this domain contains all VOLTE 
sessions. This name should be short and descriptive for an end user to find the 
associated business rules.

Restrictions: After a domain is defined changing the name of an APN will invalidate all 
existing sessions attached to the APN. The system does not prevent name changes and 
as a result this restriction must be enforced as part of the business process in using the 
system. If a name change is required then impacted sessions must be deleted from the 
session data store manually.

Is Default This indicates that this domain is the “default” domain if the incoming message does 
not map to any of the other domains. 

Restrictions: The system must have at least one default domain to ensure that all new 
sessions map to a domain. The preferred approaches are (1) to create a default domain 
with a restricted service definition or (2) assign the default domain to the most common 
domain (e.g. DATA).

Authorization This section defines whether the local CPS SPR should be used for profile retrieval. 
There are a number of options that are available in this section to support non-mobile 
use cases. For more information refer to Authorization, page 146.
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Authorization
The only valid options for use in a mobile configuration are:

 USuM Authorization: Select this option if a local CPS SPR lookup should be executed upon new session creation.

The following parameters can be configured under USuM Authorization:

 Allow All Users: Select this option if the local CPS SPR lookup should be executed. 

All other options should not be used in a mobile configuration. One option must be selected.

Table 2 USuM Authorization Parameters

Parameter Description

User ID Field Set this to either Session MSISDN or Session IMSI dependent upon which credential is 
used to store the data in the SPR.

Password Field

Remove Db Lookup Key 
Field 

This field is optional and should be only used in conjunction with USuM remote DB 
functionality. If this functionality is enabled then the key field should match the user id 
field.
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Defining the Provisioning Attributes of the Domain
For mobile configurations the provisioning attributes tab should not be set as shown below:

Defining the Additional Profile Data of the Domain

Retrieving a Subscriber Profile from an LDAP/Ud Server
For retrieving a connection from an LDAP/Ud server it is necessary to define the following sets of data to enable this 
retrieval:
147



Domains

 

Defining a Domain
LDAP Server Set Definition
Within the Ldap Server Sets section on the Reference Data tab, create an LDAP Server Set. The Ldap Server Set 
represents a connection to a logical set of LDAP servers that is reusable across Domain definitions. As a result, most 
deployments will have only one Ldap Server Set defined in this section.

The following parameters can be configured under Ldap Server Set:

Table 3 Ldap Server Set Parameters

Parameter Description

Name A textual description of the LDAP connection. This should be something easily 
recognizable as the name of the LDAP server containing the subscriber profiles.

Use Asynchronous Operations This should be is checked (true). Setting to unchecked (false) can result in 
unpredictable performance and is not supported.
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LDAP Configuration
Within the Systems section on the Reference Data tab, create a new plugin configuration for Ldap Configuration. Under 
the Ldap Configuration create a child Ldap Server Configuration.

The following parameters can be configured under Ldap Server Configuration:

Table 4 Ldap Server Configuration Parameters

Parameter Description

Ldap Server Assign this to the Ldap Server Set created in the previous step.

Search User Dn Set this to the user DN for connecting to the LDAP server. An example is 
cn=manager,ou=accounts,o=profile.

Search User Password Set this to the password for connecting to the LDAP server. 

Note: The same password must apply to all servers defined in this configuration.
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Add entries to the LDAP Servers to represent the primary and secondary connections from the CPS system to the LDAP 
servers. The following parameters can be configured:

Auth Type Select the LDAP auth type required by the LDAP server. 

Default value is SIMPLE.

Initial Connections Set the initial connections to “50”. This represents the number of connections from a 
load balancer to the LDAP server(s).

Max Connections Set this value to the same value as the initial connections. 

Retry Count Set this to the total number of “tries” the system should execute for a give LDAP 
query. For example, a value of 2 would indicate one try and then on timeout one more 
attempt.

Retry Timer Ms Set this to the time period when the policy engine will retry to a second load balancer 
to send the request. 

Note: Setting this value too low will result in a large number of additional requests and 
this value should be set to a value close to the SLA provided by the LDAP server in 
servicing requests.

Max Failover Connection Age 
Ms

Set this value to the time period a secondary connection will be utilized before 
checking to determine if the original primary server is available. An example value is 
60000 ms (1minute).

Binds Per Second Set this to the maximum rate at which to connect to the LDAP server. Setting this to 
a high value may result in extra load on the peer LDAP server.

Health Check Interval Ms Set this to the period of time to generate a health check message. An example value 
is 5000 ms (5 seconds).

Health Check Dn Set this to the health check DN sent on the health check LDAP query.

Health Check Filter Set this to the filter sent on the health check LDAP query.

Health Check Attrs Set this to a comma delimited list of attributes to retrieve in the LDAP health check 
query.

Health Check Set this to checked (true) to enable the health check.

Default is checked.

Number of Consecutive 
Timeouts for Bad Connection

Set this to the number of timeouts that will trigger a bad connection and force a 
reconnection.

Table 5 LDAP Servers

Parameter Description

Priority The priority of the server when sending requests. Higher number is equal to higher 
priority.

Address The IP address of the server to send requests.

Connection Rule This setting is not currently used.

Auto Reconnect This setting is not currently used.

Timeout Ms Set this to the SLA for queries for the LDAP server.

Bind Timeout Ms Set this to the SLA for binds to the LDAP server.

Table 4 Ldap Server Configuration Parameters

Parameter Description
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Setting Up Additional Profile Data
Within the Additional Profile Data tab of the Domain, select Generic Ldap Search in the upper right corner to select 
that this Domain should retrieve data from an LDAP query. 
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The following parameters can be configured under Additional Profile Data:

Table 6 Additional Profile Data Parameters

Parameter Description

Profile Mappings In the profile mappings table add one row for each attribute that is retrieved from the 
LDAP server.

External Code The LDAP attribute name to retrieve.

Mapping Type The mapping of the data to an internal CPS data type. The following data types are 
supported:

 Service: Selecting this type will add a service to the user profile with the code 
returned on the LDAP attribute.

 ChargingId: Selecting this type will allow the External Charging Id retriever to 
retrieve the LDAP value. This attribute would only be used if the local balance 
database is enabled and provisioned with the external charging ID and the 
charging id is defined in the LDAP server.

 SubscriberIdentifier: Selecting this type will allow the “An external subscriber id 
exists” condition within a policy to return the subscriber id.

 SubscriberAttribute: Selecting this type will add a policy derived AVP with the 
external code mapped to the code field and the value mapped to the value field. 
This attribute type is the most common type to set in the profile mappings.

Regex Expression and 
Regex Group

If parsing of the incoming AVP is required then a regular expression and regular 
expression group can be defined to support retrieval of the parsed values.

Ldap Server Set Associate the LDAP server set defined in the LDAP Server Set Definition.

Base Dn This should be set to the Base DN sent in the LDAP query. If not defined then the 
request will not contain a base DN.

Note: This string supports string replacement using the find / replace of strings with 
variables from the policy state as defined in the “Replacement Rules” table.

Filter This should be set to the Filter sent in the LDAP query. If not defined then the request 
will not contain a filter.

Note: This string supports string replacement using the find / replace of strings with 
variables from the policy state as defined in the “Replacement Rules” table.

Dereference Policy Set this to the dereference policy that the LDAP query requires. 

Default value is NEVER.

Avp Code to Disable Query This is an optional field that controls whether to disable the LDAP query. This is often 
used in conjunction with Custom Reference Data tables and other session attributes to 
optionally disable an LDAP query. If the calculated CRD AVP has a value (ignoring case) 
of “true” then the LDAP query is skipped.

Profile Refresh Interval 
(mins)

Set this value to automatically refresh a profile by querying the profile after a specified 
delay. 

Replacement Rules In the replacement rules table, add one row per replacement string to substitute into 
the Base DN or Filter string on a request by request basis. 

Replacement String The literal string used in the “From” operation. The best practice is to use a symbol 
(e.g. $) at the front of the string to ensure uniqueness in the find and replacement 
operation.

Replacement Source The source of the data for the “To” operation. The most common examples are 
“Session MSISDN” and “Session IMSI”.
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Defining the Location Attributes of the Domain
The content of the location attributes tab is only required if the “Define one domain per logical APN” strategy is used in 
defining domains. If this strategy is selected then the following attributes should be set on the location form:

The following parameters can be configured under Locations tab:

Defining the Advanced Rules of the Domain
There are only three fields that should be set on this form when supporting a mobile configuration: 

 If the deployed system is using the CPS USuM subscriber database then there are two options:

— Default Service: The default service applies if the user profile exists in the local SPR and the profile has no 
associated services.

— Unknown Service: The unknown service applies if the user profile lookup failed against the local SPR. 

Table 7 Locations Tab Parameters

Parameter Description

Location Matching Type This attribute should be set to AVP value. The AVP value matching type allows the 
information from a Custom Reference Data table (CRD) to be used in the domain 
assignment.

Location Matching Type 
Table

One entry should be added with a name equal to the logical APN and the mapping value 
equal to the CRD column code (e.g. logical_apn) with a “\” and then the logical APN 
value.

The Timezone attribute is not used in mobility configurations and should be left blank.
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 Otherwise set the Anonymous Service to apply a service to users that map to this Domain.

Creating a Custom Reference Data (CRD) table for APN mapping
If the “Define one domain per logical APN” strategy is used for defining domains, then creation of a CRD table is required 
to perform this mapping. Since this is custom to each deployment an individual deployment may define the CRD table 
with a slightly different structure, but the basic definition should be similar to what is described in the following sections.
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Define the APN Mapping Search Table Group
On the Customer Reference Data Tables section of the Reference Data tab of the Policy Builder, add a new Search 
Table Group. 

The following parameters can be configured under Search Table Group:

Table 8 Search Table Group Parameters

Parameters Description

Name Set to recognizable name to indicate that this is the APN mapping search table group. An 
example is “APN Mapping”.

Evaluation Order Set to “0” to ensure that this group is processed before other search tables are processed.

Results Column

Name Set to logical_apn. This is the name of the AVP that will be populated into the policy engine 
representing the logical APN. The name must not have spaces or special characters. Best 
practice is to use “_” character for spaces and lower case letters in place of mixes case 
or all upper case letters.

Display Name Set to “Logical APN” or equivalent display name for use in reference data screens. This 
field is only used for display purposes and as a result can contain spaces and special 
characters.

Use In Condition Set this to “true” which is a checked value.

Default Value Set this to the default logical APN to if a match is not found in the mapping table. An 
example of this value is “DATA”.
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Define the APN Mapping Custom Reference Table
On the “APN Mapping” search table group, create a new Custom Reference Table.

The following parameters can be configured under CRD Table:

Table 9 CRD Table Parameters

Parameter Description

Name Set this to “apn_mapping” or an equivalent table name to contain the mapping data. The 
name should not have spaces or special characters. A best practice is to use “_” character 
for spaces and lower case letters in place of mixes case or all upper case letters.

Display Name Set this to “APN Mapping” or equivalent display name for use in reference data screens. 
This field is only used for display purposes and as a result can contain spaces and special 
characters.

Cache Results Set this to “true” which is a checked value.

Best Match This should be set to “false” unless regular expression or defaulting with “*” matches is 
used in the key fields.

Evaluation Order Set to “0” to ensure that this group is processed before other search tables are processed.

Columns For more information, refer to Table 10 on page 157.
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Load Data into the APN Mapping Table
After successfully publishing the configuration to the running system, new APN(s) are defined by entering the data via 
the Control Center GUI or via API calls (On how to access Control Center, refer to CPS Installation Guide for this release). 
An example of the definition is shown below:

Validation Steps
The following validation steps are designed to verify whether the “Define one domain per logical APN” approach to APN 
Profiles is properly configured or not. We will create two domains and map them to a default service based on two 
different APNs.

Table 10 Columns Table

Name Parameter Example

apn Name apn

Display Name APN

Key true

Required true

Bind to Session/Policy State Field Gx APN

logical_apn Name logical_apn

Display Name Logical APN

Required true
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Steps
The ability to generate a Gx CCR-i from two different APNs. The actual APN names are not important however they must 
be different.

1. Configure the CRD table as described in Creating a Custom Reference Data (CRD) table for APN mapping, page 154 
above. 

2. Publish the configuration to the running environment. This is required before data can be loaded into the CRD tables.

3. The actual CRD data to be evaluated is located in the Control Center interface (refer to Load Data into the APN 
Mapping Table, page 157). In the control center, make sure there are two different logical APN groups with each 
group mapping to the Gx APN value that will be passed in the CCR-i. Navigate to the table in Control Center and 
map each Gx APN to different logical APNs (for example: column apn might have “data.apn.com” and would map 
to logical APN “DATA” while another “apn” row might map to logical APN “VOICE”).

4. Configure two different PB domains, one for DATA and one for VOICE as described in Defining a Domain, page 144.

5. In each domain, in the Location tab, configure the Location Mapping Type of AVP Value to map logical_apn\DATA 
on the DATA domain and logical_apn\VOICE on the VOICE domain as described in Defining the Location Attributes 
of the Domain, page 153.

6. Set the default or anonymous service on the domain's Advanced tab to match the service required for the domain. 

7. Generate Gx CCR-i from each different APN, validate that the service assigned to the client matches the 
default/anonymous service for the domain. As per the log below, check that the (location) debug message shows 
“Location found for avp matching: logical_apn\DATA”:

[20XX-XX-XX 12:34:50,025] ===============================================
POLICY RESULT SUCCESS:
        session action = Create
        domainId = location_test
        locationId = apn
        SERVICES: DefaultDataService
        TRIGGER: Message: com.broadhop.diameter2.messages.DiameterRequestMessage
                Application Id: Gx (16777238)
                Command Code: Gx_CCR-I (272)
                Dest host: null
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                Dest realm: pcrf.cisco.com
                Device protocol: GX_TGPP
                End to end id: 3024
                Hop by hop id: 6001
                Origin host: pcef-gx
                Origin realm: pcef.cisco.com
                Origin state: 0
                Stack name: null
                Session-Id: .;1096298393;1
                Session-Id: .;1096298393;1
                Auth-Application-Id: 16777238
                Origin-Host: pcef-gx
                Origin-Realm: pcef.cisco.com
                Destination-Realm: pcrf.cisco.com
                CC-Request-Type: 1
                CC-Request-Number: 1
                RAT-Type: 1000
                IP-CAN-Type: 0
                Called-Station-Id: data.apn.com
                Framed-IP-Address: 0x010108f0
                Framed-IPv6-Prefix: 0x004020010b68001400000000000000000000
                3GPP-SGSN-Address: 0x01010101
                3GPP-SGSN-MCC-MNC: 71617
                Supported-Features:
                                Vendor-Id: 10415
                                Feature-List-ID: 1
                                Feature-List: 1
                Subscription-Id:
                                Subscription-Id-Type: 1
                                Subscription-Id-Data: 1234567890
                Subscription-Id:
                                Subscription-Id-Type: 0
                                Subscription-Id-Data: AAAA.BBBB.CCCC
                QPS-Internal-Route-Record-Host: pcef-gx
                QPS-Internal-Route-Record-Realm: pcef.cisco.com
        DEBUG MSGS:
                INFO   : (core) Tagging message with ID: GX_TGPP
                INFO   : (core) Lock obtained on key: diameterSessionKey:.%3B1096298393%3B1
                INFO   : (core) Start session triggered
                INFO   : (gx) Rel8 feature supported on session .;1096298393;1
                INFO   : (gx) Creating new diameter session .;1096298393;1
                INFO   : (custrefdata) Adding AVP [GetLogicalApn/logical_apn], value: DATA
                INFO   : (location) Location found for avp matching: logical_apn\DATA
                INFO   : (auth) Success ALLOW_ALL authorization
                INFO   : (core) No service is associated, added default service code: 
DefaultDataService for session
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First Published: June 26, 2015

Last Updated: August 14, 2015

This chapter covers the following sections:

 Overview, page 161

 Service Example, page 163

 Service Screens, page 165

 Customer Reference Data Tables, page 177

Overview
In CPS, a 'Service' it what is assigned to a subscriber (in USuM) to define how that subscriber is treated. Some basic 
examples of services would be a 'GOLD' user might get a high upload/download speed whereas a 'BRONZE' user would 
get a low one. Other examples would include having one type of user be redirected to a portal when their Quota is 
exhausted whereas another type would only have their speed downgraded.

As the Service maps as closely as possible to how a Service Provider wants to classify their customers, the Service in 
CPS is flexibly defined to allow configuration at different levels. 

Below is an overview of the different objects referenced in the Services tab in PB. The detailed description of each object 
is provided in below sections.

This section covers the following topics:

 Service, page 162

 Service Option, page 162
161
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Overview
 Service Configuration, page 162

 Use Case Template, page 163

 Use Case Option, page 163

Service
 A service is effectively just a 'code' to label the service and a collection of Service Options which contain the 

definition of what a service 'is'.

 What a Customer Service Representative assigns to a subscriber to describe the user's plan.

 Multiple services can be assigned to a single subscriber

 If multiple services are assigned to a subscriber, the service options are combined between all assigned services. 
Therefore, there is no logical difference between a subscriber with:

— A single service with 10 service options 

— 10 services with 1 option each 

Service Option
 Provides the concrete values which can be re-used for multiple services. 

For example, one subscriber might have one service option which describes the values for 10MB Upload/Download 
speed and another subscriber which describes 1MB Upload/Download speed. Continuing the example from above, 
10MB could be assigned to a GOLD service and 1MB could be assigned to BRONZE.

 What values are configurable in a Service Option are setup by the Use Case Template object. The Use Case Template 
can provide defaults to the Service Option or hide values in Service Configuration objects not necessary for certain 
use cases.

 If a Service Configuration's value is not defined in a Service Option, the value from the Use Case Template will be 
used.

Service Configuration
 The low-level configuration objects used by the CPS code to drive functionality. These objects are used to drive 

functionality in the system. The whole point of the Service > Service Option > Use Case Template chain of 
functionality is to flexibly configure these Service Configuration objects which the code uses to drive system logic.

 These objects are defined by the CPS code.

 Types of service configurations:

— PriorityConfiguration: Only 1 allowed to be active at a time. If multiples priority configurations are added, highest 
priority is used. 

These are used in cases where only a single value makes sense. For example, when sending an 'Accept' message, 
we can only have one template and multiples don't make sense. 

Objects of this type will always have a priority field. If multiple priority configurations are added, the highest priority 
object will be used.

Example: AccessAcceptConfiguration, RegisterMacAddress

— GroupConfiguration (most common): Only 1 per 'Group Name' are allowed to be active. If multiple configurations 
are added highest priority per 'Group Name' is used. 
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These are used in cases where a configuration only makes sense for a single 'group' (key). For example, if it makes 
sense to control the upload/download speed based on the network type (cell, wifi, etc) a service configuration to 
control network speed with a group set for cell/wifi would allow multiple service configurations to be added.

These objects will always have a group field as well as a priority field. For each unique group value, the highest 
priority will be used.

Example: IsgServiceConfiguration, All Diameter Configurations, OneTimeUsageCharge

— ServiceConfiguration: Multiples allowed. If multiple configurations are added, all are used. 'Modify' functionality 
in PB for Use Case Options/Service Options can override values conditionally.

Example: AutoChargeUpAccounts, AutoProvisionQuota, BalanceRateConfiguration

Use Case Template
 Defines the Service Configuration objects to be set by a Service Option and can provide default values and/or hide 

values which don't need to be set by a use case.

 Optionally contains 'Initiators' (Conditions) which define when the template is active.

 Created by an advanced user (usually Engineering/AS).

 Makes Service Option and Service creation easier.

For example, a Use Case Template setup to create different Upload/Download speeds might include a 'DefaultBearer' 
QoS Service Configuration object. The user creating a Use Case Template could default and/or hide the values for 'ARP' 
and other values not directly related to upload/download speed if they knew they were not required for a customers use 
case. This would allow the creation of the Service Option to be much simpler.

Use Case Option
 A child of Use Case Template used to add/modify Service Configurations objects when certain conditions occur.

 Provides a way to separate Service Configurations within a use case based on conditions.

 Contains the same functionality of a Use Case Template.

 Can add new service options or modify service options from parent Use Case Template.

For example, if a users upload/download speed should be decreased when they are out of quota. A Use Case Option 
would be added with a condition indicating the user is out of quota. The service configurations in the use case options 
could have a higher priority than those in the use case template so they would override the normal values. The service 
option would then allow setting both the normal upload/download speed and the upload/download speed when the user 
is out of quota. 

Service Example
The below diagram illustrates how a 'Service Configuration' object called PredefinedRule can be flexibly configured as 
part of a service. For those unfamiliar, a predefined rule is just a identifier sent to the PCEF which controls a users 
upload/download speed (QOS) among other things. 

In this case, the service gold is assigned a Service Option called 10MB Fair Use. This service option results in a rule being 
passed to the PCEF called 10MB by default and switching the rule to 5MB when the users quota is depleted.

Notice that it would be quite easy to add another service option for 20MB Fair use, etc. 
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The Use case template defines the low level information that a 'PredefinedRule' should be created and by default its 
priority is 5. This rule is default and always present. Additionally, a Use Case Option defaults that another PredefinedRule 
of priority 10 should be added. The higher priority results in the new rule name being switched when quota is depleted.

The below diagram is functionally equivalent to the above diagram, however, instead of using a Use Case Option to define 
what happens when a user is depleted, they setup another Use Case Template.

This could have an advantage if a customer wanted services for a large combination of values (10MB default with any 
combination of 1MB-9MB depleted speed). Additionally, to support a use case where the end user could be 
independently assigned a default speed and a depleted/downgrade speed. A service for 10MB default and 5MB 
depleted could be setup which would also be functionally equivalent.    
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Service Screens
This flexibility in the service model allows mapping a CPS very closely to the Service Providers concept of a service.

Service Screens
The following screens setup the example seen in the previous section. Service 'Gold' with two separate service options. 
Note that the 'Predefined Rule' that is part of the setup is just an example, so not all fields on the Predefined Rule will be 
described. 

For example, you should know that a 'Rule Name' is a label and can be assigned to a subscriber on a PCEF. The PCEF is 
responsible for defining what the rule 'means'. In this example, we make the assumption that the PCEF has rules setup 
for '10_MB' and '5_MB' which control the users QoS (Quality of Service - effectively upload/download speed) to 10MB 
upload/download and 5MB upload/download respectively. 

Note: The subtle difference between 10MB and '10_MB' is to ensure that it is clear which name is used for internal 
reference and which is sent to the PCEF.

This section covers the following topics:

 Services, page 166

 Service Options, page 170

 Use Case Templates, page 172
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Services

The following parameters can be configured under Service:

Table 1 Service Parameters

Parameter Description

Code This is what is saved on the subscriber. It defaults to 'default'. This value is the link between 
the Services assigned a subscriber in Control Center and the Service in Policy Builder. This 
value should not be updated if existing users have it assigned as the 'link' will be broken. 
Instead, the name should be updated.

Name This is the name displayed in Control Center.

Enabled If this value is unchecked, the service will not be evaluated by the Policy Engine and will not be 
displayed in Control Center.

Default value is checked (true).
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Service Options Table
This table displays a read only version of the service options associated to the Service. Service Options can be added 
or removed to the service.

Suppress in Portal If this value is checked, this Service will not be displayed in the Portal. This is specific for SP 
Wifi call flows.

Default value is unchecked (false).

Balance Service If this value is checked, the Service will run through balance processing. This will result in one 
database read/write against the balance database. Performance will improve (due to fewer 
database read/writes). 

For the services which don't rely on Balance/Quota, this value should be unchecked.

Default value is checked (true).

Add to Sub 
Accounts

If this value is checked, this service will be considered to be also assigned to any 'subaccounts' 
associated to the main subscriber. This could be useful if you had a family plan where the QoS 
should be controlled at the main subscriber level and 'trickle down' to the family sub accounts 
rather than being set at each individual level.

Default value is unchecked (false).

Table 2 Service Options Table Parameters

Parameter Description

Name The name of the associated Service Option.

Use Case Template The name of the associated use case template.

Add Allows adding another Service Option to this service. The add dialog shows the Use 
Case Template > Service Option hierarchy on the left and a preview of the parameters 
set by the Service Option/Use Case Template on the right. Refer to the example on 
next page.

Remove Removes a Service Option from the Service.

Up/Down Arrow Allows moving a Service Option up or down. This only affects the ordering of service 
options in the list and won't functionally affect the resolution of services.

Table 1 Service Parameters

Parameter Description
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View Service Option Parameters
This hyperlink displays a dialog which displays a consolidated list of the Service Configuration Parameters combined 
from the Use Case Template and the Service Options. This view is useful for simple service options/use case templates. 
However, since it does not show the distinction between different Service Configuration objects, it can be difficult to read 
for more complicated configurations.
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Service Options
The service option dialog allows setting the concrete values for service configuration parameters used in the Use Case 
Template. The groups under service options are Use Case Templates. Adding a new Use Case Template will add a new 
group under Service Options so you can provide concrete values for the Use Case Templates.

The following parameters can be configured under Service Option:

Table 3 Service Option Parameters

Parameters Description

Name This is the name of the service option which will be referenced by the Service.

Use Case Template This is a link which allows quickly seeing the associated Use Case Template and 
going straight to this Use Case Template. 

Note: You can use the 'left' arrow in the Policy Builder toolbar to go 'back' to the 
service option after clicking into the Use Case Template.

Service Configurations This is a list of the 'Service Configuration' objects which are to be set as part of the 
Service Option. This list can usually be used 'as is' upon creation. The Service 
Configuration objects from the Use case template will be used as a default and any 
values set here will 'override' the use case template.

 Add: This allows adding a new Service Configuration that has been added to 
the Use Case Template. This is only really useful when a new Service 
Configuration object was added to a Use Case Template after this service 
option was created and you now what to override some values on this new 
object.

 Remove: This is only really useful if you don't want to use your configured values 
at all and just use the values from the Use Case Template. In that case you can 
just remove the Service Configuration Objects and the values from the Use Case 
Template will be used. 

PreDefinedRule Parameters These are the parameters being overridden from the use case template.
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Add This allows adding a parameter from the Use Case Template even if it is not marked 
as 'Allow Override'. It also allows customizing a parameter that didn't exist 
previously in the Use Case Template or was removed from the Service Option.

Remove This allows removing a parameter from the Service Option. This means that the 
value specified for the Use Case Template's version of this parameter will be used.

Display Name This column shows the 'Display Name' of the parameter. This name can be updated 
by either the Service Option or the Use Case Template to make it clearer for users 
to understand what this value does. The 'true' name of the field can be seen by 
hovering over the cell.

Value This is the value of the parameter which should be set. If there is a value set in the 
'Pull Value From…' column, this value will be used as the default and overridden with 
the 'Pull Value From…' information.

Pull Value From... This allows setting this value dynamically through AVP's, Customer Reference Data 
or the 'Policy State'. For more information, refer to Table 4 on page 172.

Table 3 Service Option Parameters

Parameters Description
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Use Case Templates
Use case templates form the basis of a service and are in general more complicated than creating a service or service 
option. For more information on creating Use Case Templates, contact your Cisco Technical Representative.

Table 4 Pull Value From...

Parameter Description

Subscriber AVP Code This allows pulling values from AVPs on the subscriber. This field now also supports 
AVP's on the subscriber's session and 'Policy Derived AVP's added in policies.

Customer Reference Data 
Column

This allows pulling the value from the Customer Reference Data table's column 
specified.

Note: Customer Reference Data takes care of which 'row' in the column is 
matched, so this will end up specifying a single value.

Bind to Session/Policy State This allows pulling the value from the state of the system. This uses any of the 
preconfigured 'Policy State Data Retrievers' which are plug-in code that knows 
how to get a certain value from the system.
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The following parameters can be configured under Use Case Template:

Table 5 Use Case Template Parameters

Parameter Description

Name This is the name used to identify the Use Case Template. It can be changed.

Service Configuration This is where you add the Service Configuration objects needed to configure your use case. 

 Add: The Add button brings up the full list of Service Configuration objects. Which to 
choose should be based on the use case documentation you are implementing. The 
right column of the screen displays the parameters that are in a specific service 
configuration. If you 'uncheck' a parameter, the default as seen on this screen (from the 
code) will be utilized. Unchecking is functionally equivalent to 'removing' a field from 
the table after adding it.

— Add New: Implies that you are adding a new Service Configuration to be 
configured. This is almost always what you want.

— Modify: Implies that you are modifying an existing Service Configuration. This is 
used in a 'Use Case Option' and in general not recommended as it's preferred to 
use the 'priority' fields to update the service configuration objects.

For more information, refer to the example on next page.

Create Child: Use Case 
Option

This allows creating a child use case option of this use case template.

PreDefinedRule Parameters

Add This allows adding a parameter to the Use Case Template even if it wasn't added initially 
(unchecked or a code update added a new parameter). 

Remove This allows removing a parameter from the Use Case Template. This means that the value 
specified in the code (as seen on the Add Service Configuration screen) will be utilized.

Display Name This column shows the 'Display Name' of the parameter. This name can be updated by 
either in the Use Case Template to make it clearer for users to understand what this value 
does. The 'true' name of the field can be seen by hovering over the cell.

Value This is the value of the parameter which should be set. If there is also a value set in the 'Pull 
Value From…' column, this value will be used as the default and overridden with the 'Pull 
Value From…' information.

Pull Value From… This allows setting this value dynamically through AVP's, Customer Reference Data or the 
'Policy State'.

Allow Override This value indicates whether this option will show up for configuration in the Service Option 
by default. In general, it is best to only check this box for values you expect to be configured 
in the Service Option. This will make it easier to configure and maintain the service options.
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Use Case Initiators
Use Case Initiators are groups of conditions which indicate if the Service Configuration objects within this use case 
template will be used or not. If no use case initiators are specified, the Service Configuration objects will always be 
added.
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The following parameters can be configured under Use Case Initiators tab.

Table 6 Use Case Initiators Tab

Parameter Description

Service Initiators Service Initiators are a grouping of conditions. If all of a Service Initiators conditions are true then 
the service initiator is true. If any of the service initiators on a Use Case Template are true then 
that Use Case template is active and the Service Configurations are utilized.

 Add/Remove: Adds or removes a service initiator.

 Up/Down: Allows moving the initiators up/down. This affects the order which the conditions 
are initiators are evaluated in. 

Initiator Name This is a logical name for this grouping of conditions.

Conditions These are the conditions associated to the service initiator. Conditions are usually something 
about this messages session, subscriber information, balance information or the message itself. 
The current values of the condition are setup by the code/messaging.

 Add/Remove: Allows adding or removing a condition

 Up/Down: Allows moving a condition up or down. This is usually only needed if you need to 
reference a previous condition in this condition. For example, I could check a 'session exists' 
in the first condition and then use the 'session user name' in the second condition. You can 
only reference previous conditions.

 Input Variables: These are specific to each condition. If the current value of the condition 
matches the input variable, this condition will be true.

— Input Variable: This is the name of the variable.

— Type: This is either 'Literal' matching where we match against a hardcoded 'value' or 
'Output' where the value is pulled from a previous (or current) condition. If output is 
chosen, a popup will appear where the values from the current or previous conditions 
can be selected and the 'value' box will be replaced with the selection.

— Operator: This allows editing how 'true' is determined given the current value of the 
condition and the value specified.   The default and by far most common option is '==' 
equals.

Operator = (Equals): The condition is true if the values are equal. This uses the Java equals() function.

<> (Not Equals): The condition is true if the values are not equal.

isNull: The condition is true if the value is null (empty).

!isNull: The condition is true if the value is not null (empty).

Matches: The condition is true and the value is a regex that successfully matches the current 
value. Java regex is utilized. Example: .* matches anything. 

[0-9]+: Matches 1 or more numbers.

^[0-9]*$: Matches a string which is only numbers or empty.

!matches: The logical opposite of matches (if matches would be true, !matches is false).

In: This is true if the current value is equal to one of the values listed (comma separated).

!In: This is the logical opposite of In (if In would be true; !In is false).

Contains (Only for lists): True if the list contains the value or values.

!Contains (Only for list): The logical opposite of contains.

Value: This is the hard coded value which should be compared against the current value in the 
system.

Remove (link): This allows removing this input variable.
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Documentation
The documentation tab allows writing notes about the implementation which can be referred to later.

Customer Reference Data Tables
This section covers the following topics:

 Overview, page 177

 Example, page 177

 Screens, page 178

Overview
Customer Reference Data tables allow defining custom derived data for your installation and making decision based upon 
that data. 

For example, a customer may not want to directly assign each subscriber a service so they get the appropriate QOS, 
instead, they want to derive the QoS based on data we get from the subscribers session. Customer Reference Data 
tables are the way to do that. Then (as per the previous section) we can wire the derived data directly into the service 
with the “Bind Field…” or “Pull Value From…” options.

Example
The following screens will have a simple example setup. The example is that we want to derive the PCEF Rule Name 
based on the users APN (Access Point Name) and RAT (Radio Access Technology) name. 

The logic we would like to implement is as follows:

The * (asterisk) can be read as a wild card, but the table should match the 'most specific' entry. So, if my APN and RAT 
are Cisco and 3G, match the first row, not the 3rd row (Cisco, *) or the last row (*,*).

Note: These values are for example purposes only. Things like the RAT type value have been simplified to make the 
example easier to understand.

Table 7 Example Table

APN RAT Rule Name Rule Name Depleted

Cisco 3G 10_MB 5_MB

Cisco Wifi 20_MB 5_MB

Cisco * 5_MB 1_MB

CiscoTest 3G 1_MB 5_KB

CiscoTest Wifi 2_MB 50_KB

* * 1_MB 500_KB
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Screens

Search Table Groups
Search table groups allow grouping multiple Customer Reference Data Tables together logically, only executing the 
searching when needed. It also allows ordering the execution of tables so that tables can reference output of one table 
group in another to provide a consistent and expected results. Additionally, Search Table Groups allows multiple different 
tables to populate the same AVPs in different ways.
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The following parameters are configured under Search Table Group:

Customer Reference Data Table
Policy Builder can be thought of as defining the 'schema' for the Customer Reference Data and the Control Center is 
responsible for filling out the 'schema'.

Table 8 Search Table Group Parameters

Parameter Description

Name The name of the Search Table Group.

Evaluation Order The order in which groups get evaluated, starting with 0 and going higher.

Results Columns These are the AVPs that will be added into processing. These need to be mapped to be 
the same as values from underlying tables. This allows populating the same AVPs from 
different tables.

 Name: The name of the AVP. It should start with alphanumeric characters, should be 
lowercase, and should not start with numbers, no special characters are allowed, 
use “_” to separate words. For example, logical_apn = GOOD, logicalAPN = BAD, 
no_spaces

 Display Name: The more human readable name of the AVP.

 Use In Condition: This represents whether this row will be available for conditions in 
Policies or Use Case Templates. There is a performance cost to having these 
checked, so it is recommended to uncheck unless they are required.

Default value is checked (true).

 Default Value: The default value if no results are found from a Customer Reference 
Data Table.

 Add/Remove: Adds or removes a row from the table.

 Up/Down: Allows ordering the list, but has no impact on processing.

Table Search Initiators This section controls whether or not the Search Table Group and all tables below will be 
executed. For more information, refer to Table 6 on page 176.
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Note: It is recommended to create Customer Reference Data Tables under Search Table Groups as this allows order the 
order in which the tables should be searched and providing default values if nothing is found. It is possible to 'reparent' 
a Customer Reference Data Table to another Search Table Group.

The following parameters can be configured under Custom Reference Data Table:

Table 9 Custom Reference Data Table Parameters

Parameter Description

Name This is the name of the table that will be stored in the database. It should start with 
alphanumeric characters, should be lowercase OR uppercase but not MixedCase, and 
should not start with numbers, no special characters are allowed, use “_” to separate 
words. For example, logical_apn = GOOD, logicalAPN = BAD, no_spaces.

Display Name This is the name of the table that will be displayed in Control Center.

Cache Results This indicates whether the tables should be cached in memory. This should be checked for 
production.

Activation Condition This is the Custom Reference Data Trigger which needs to be true before evaluating this 
table. This can be used to have multiple tables create the same data depending on 
conditions or to improve performance if tables don't need to be evaluated based on an 
initial condition(s).

Best Match If checked, this allows '*' to be used in the values of the data and the best matching row is 
returned.

Evaluation Order This indicates the order the tables within the search table group should be evaluated. 
Starting with 0 and increasing.
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Columns Columns correspond to the 'schema' for each column we're creating for this customer 
reference data table.

 Name: The name of the column in the database.

 Display Name: A more readable display name.

 Use In Conditions: This represents whether this row will be available for conditions in 
Policies or Use Case Templates. There is a performance cost to having these checked, 
so it is recommended to uncheck unless they are required. 

Default value is checked (true).

 Type: the type determines what values will be allowed when creating them in control 
center.

— Text: The value is allowed to be any characters. For example, example123!.

— Number: The value is allowed to be any whole number. For example, 1234.

— Decimal: The value is allowed to be any number (including decimals). For example, 
1.234.

— True/False: The value needs to be 'true' or 'false'. For example, true.

— Date: The value is a date without a time component (May 17th, 2020).

— DateTime: The value is a date + time (May 17th, 2020 5:00pm).

 Key: This indicates that this column is all or part of the 'key' for the table that makes 
this row unique. By default, a key is required. Keys also are allowed set the Runtime 
Binding fields to populate this data from the current message/session. Typically, keys 
are bound to data from the current session (APN, RAT Type) and other values are 
derived from them. Keys can also be set to a value derived from another customer 
reference data table.

 Required: This indicates whether this field will be marked required in Control Center. 
A key is always required.

Table 9 Custom Reference Data Table Parameters

Parameter Description
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Custom Reference Data Trigger
A custom reference Data Trigger is group of conditions that can be used to a decide whether to evaluate a table or not. 
This can be used to derive the same data in different ways depending on conditions.

Refer to Use Case Initiators, page 175 as it is identical in function of setting up conditions and only different in what it's 
used for.

Valid Values These are the valid values which will be allowed in Control Center (creates a list box).

 List of Valid Values: A list of name/display name pairs which will be used to create the 
list. Valid values can also contain a 'name' which will be the actual value of the column 
and a display value which allows Control Center to display an easier to use name.

 Valid Values pulled from another Table: This allows initializing the list based on another 
customer reference data table. The 'name' value will be pulled from another table. 
There is no way to customize a 'display' name in this manner.

Validation The validation set here will be checked by Control Center before allowing a row to be 
added.

 Regular Expression: This is the Java regular expression that will be run on the proposed 
new cell value to validate it as described here.

 Regular Expression Description: This is a message to the user indicating what the 
regular expression is trying to check.

Runtime Binding Runtime binding is how key column data gets filled out ('bound') from data in the current 
session. There are multiple ways to bind this data and it is also possible to set an operator 
to define what should match (equals, less than, etc).

 Bind to Subscriber AVP Code: This pulls the value from an AVP on the subscriber. It will 
also pull values from a session AVP or a Policy Derived AVP.

 Bind to Session/Policy State Field: This pulls the value from a Policy State Data 
Retriever which knows how to retrieve a single value for a session

 Bind to a Result Column from another Table: This allows the key to be filled out from a 
columns value from another table. This allows 'normalizing' the table structure and not 
having on giant table with a lot of duplicated values.

 Bind to Diameter Request AVP code: This allows the key be filled out from an AVP on 
the diameter request.

 Matching Operator: This allows the row to be 'matched' in other ways than having the 
value be 'equals'. Default value is equals. 

— eq: Equal

— ne: Not Equal

— gt: Greater than

— gte: Greater than or equal 

— lt: Less than 

— lte: Less than or equal

Table 9 Custom Reference Data Table Parameters

Parameter Description
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First Published: June 26, 2015

Last Updated: August 14, 2015

This chapter covers the following sections:

 Gx Services, page 185

 Sd Services, page 261

Gx Services
This section covers the following topics:

 QoS Profile, page 185

 PCC Rules, page 197

 Table (CRD) Driven Rules, page 202

 Custom Features, page 224

 Emergency Data Services, page 231

 RAN Congestion, page 238

 Usage Monitoring, page 243

 Bandwidth Monitoring, page 250

 Common Parameters Used, page 259

QoS Profile
This section covers the following topics:

 Overview, page 185

 Policy Builder Configuration, page 186

 Parameter Description, page 195

 Default Bearer QoS Algorithm, page 196

 QoS Authorization Algorithm, page 196

Overview
When UE attaches to the network for the first time, it will be assigned default bearer which remains as long as UE is 
attached. Default bearer is best effort service. Each default bearer comes with an IP address. 
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This section provides details of Gx default bearer QoS parameters and also explains how CPS derives QoS in different 
configurations.

Policy Builder Configuration

Case 1- QoS under Gx Profile
1. Login to Policy Builder. 

2. Click Reference Data tab > Diameter Defaults > Gx Profile.
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3. On the right side, click Create Child to open Gx Profile as shown below.

Case 2 - Default Bearer QoS in Service
1. Login to Policy Builder. 

2. Click Services tab> Use Case Templates. Click Summary and select Use Case Template.

3. Click Add to open Select Service Configuration.
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4. Select DefaultBearerQoS under gx and click required service configuration parameters that need to be configured. 
Click OK to add the service in Service Configuration pane.
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5. In Services tab, click Services > Service Options to create a service option and add the configured Use Case 
Template in Step 4. on page 188 to configure Service Option. An example is shown below.
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6. In Services tab, click Services > Services to create a service and add the configured Use Case Template in Step 
4. on page 188 to configure Service. An example is shown below.

Default Bearer QoS Enhancements - Gx
CPS supports the management of Default Bearer QoS attribute values for IP-CAN sessions by applying QoS-Bounding, 
QoS-Mirroring and QoS-Enforced on Default Bearer QoS and these actions for individual QoS attributes can be derived 
based on SPR or Gx session attributes.

 QoS-Bounding is the ability for the PCRF to calculate the minimum QoS between the Requested QoS (from the 
P-GW) and the Authorized QoS (based on internal computation of the Logic in the PCRF) and assign that in the 
response message back to the P-GW. 

 QoS-Mirroring is the ability for the PCRF to mirror the same QoS values back that were being requested by the P-GW 
in the Request Message. 

 QoS-Enforcement is the ability for the PCRF to enforce the Authorized QoS computed based on its internal logic 
back to the P-GW in the request/response message. 

To support QoS Enhancements, you can configure object DefaultBearerQoSAction with action attribute for each possible 
QoS attribute and bind to the QoS action columns of the Default Bearer CRD. Also CPS binds the DefaultBearerQoS 
service configuration object attributes to QoS columns of the Default Bearer CRD. 

CPS when sends or receives a Gx request message then it needs to do a lookup from CRD tables for a match of input 
attributes and perform calculation of DefaultBearer QoS using values from the output attributes and the default 
configured in service. The QoS Actions are also applicable to PreConfigured Rules defined in CPS service configurations 
and are used to calculate the QoS-Information grouped AVPs of such charging rules. 
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CPS after calculation of default bearer QoS applies the QoS actions bounding, mirroring and enforcement to each 
attribute of current calculated QoS. A new class QoSInformationActions is used to override the QoS calculated from the 
QoSInformation and assigning the values as defined by CRD table and corresponding action from 
DefaultBearerQoSAction. 

The DefaultBearerQoS calculations explained above are applied if the service configuration contains the service object 
DefaultBearerQoSAction. 

CPS also supports the Gx TGPP session to store the last received QoS parameters from PCEF/PGW which helps in 
evaluating the QoS during CCR-U or RAR trigger. 

CPS also supports QoS calculations for MPS and it takes precedence over QoS Actions while calculating default bearer 
QoS as shown below:

Note: Special care must be taken by the user while defining CRD table just to avoid unconditional loop in case CRD uses 
cross referencing data from one table to another table.

1. Login to the Policy Builder. 

2. Select the Reference Data tab. 

MIRRORING ACTION

CCR (INPUT) Calculated QoS Value QoS Action CCA (OUTPUT)

MBR MBR MIRROR MBR

GBR GBR MIRROR GBR

QCI QCI MIRROR QCI

ARP ARP MIRROR ARP

ENFORCING ACTION

CCR (INPUT) Calculated QoS Value QoS Action CCA (OUTPUT)

MBR MBR ENFORCE MBR

GBR GBR ENFORCE GBR

QCI QCI ENFORCE QCI

ARP ARP ENFORCE ARP

BOUNDING ACTION

CCR (INPUT) Calculated QoS Value QoS Action CCA (OUTPUT)

MBR MBR BOUND min(MBR, MBR)

GBR GBR BOUND min(GBR, GBR)

QCI QCI BOUND max(QCI, QCI)

ARP-PL ARP-PL BOUND max(PL, PL) and PV, PC based on chosen ARP

ARP-PV ARP-PV BOUND Set based on PL. IF PL comes from CCR set CCR Value, 
or retain Granted QoS Values

ARP-PC ARP-PC BOUND Set based on PL. IF PL comes from CCR set CCR Value, 
or retain Calculated/Granted Values
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3. Click Customer Reference Data Tables and create a CRD table. An example is shown below.

4. Select the Services tab.

5. Click Services tab > Use Case Templates > Summary. 

6. Click Use Case Template and add a Name to the template. 

7. Under Use Case Template, click Add in the Service Configuration pane to open Select Service Configuration 
pop-up window. 

8. Select DefaultBearerQoSActions and click OK to add it in the Service Configurations pane. 

9. Click DefaultBearerQoSActions to open the parameters pane on the right side. An example is shown below.
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Note: By default, Enforce is selected.

Use the following table if you want to bound QoS with CRD table.
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When the above Use Case Template is used in a Service Options then you can bind each DefaultBearerQoSAction 
service object action attribute to the QoS action columns of the CRD. Similar binding of DefaultBearerQoS service 
configuration object attributes to QoS columns of the Default Bearer CRD can be done.

10. Login to the Control Center to define the values for the parameters defined in Customer Reference Data tables. 

11. Select the Configuration tab. 

12. Under Reference Data, click Customer Reference Data Table name to open a dialog-box. Select a row and edit 
the values according to your requirements. An example is shown below.

Parameter Description
Common list of parameters:

Note: For description/usage of other parameters, refer Common Parameters Used, page 259. 

Table 1 QoS Profile - Common Parameters

Parameter Description

Grant Requested QoS It controls whether the requested QoS should be granted or not as the default bearer 
QoS. 

Default value is unchecked.

Gx Client QoS Exclusion List Gx client names that are allowed not to have a default bearer QoS installed.

Grant Requested QoS Over 
Global QoS

If this option is selected then the requested QoS should be granted even if the global 
QoS is provisioned. There are three type of QoS: first taken from service second is from 
default QoS and third one is from requested. If this flag is checked then requested QoS 
will take priority over default QOS.

Default value is unchecked.
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Default Bearer QoS Algorithm

QoS Authorization Algorithm
CPS uses the following rules to calculate granted QoS. For default bearer, configured QoS refers to Default-Bearer-QoS 
and for dedicated bearers configured QoS refers to Max-QoS.

Table 2 Default Bearer QoS Algorithm

Service Configuration Requested QoS Granted QoS

Yes Yes Follow the rules mentioned in QoS Authorization Algorithm, page 196 for 
Granted QoS calculation.

Yes No Granted configured.

No Yes Reference data parameter 
value is “Yes”. 

Grant requested QoS. CPS can throttle 
the user based on the use case. 

Reference data parameter 
value is “No”.

Grant QoS using defaults values. If 
default values are not available, reject the 
request. CPS must define Gx QoS 
defaults like QCI, bit rates.

No No Grant QoS using defaults values. If default values are not available, reject 
the request. CPS must define Gx QoS defaults like QCI, bit rates.

Table 3 QoS Authorization Algorithm

IP-CAN-Type/RAT-Typ
e Evaluation Criteria Granted QoS

IP-CAN:GPRS

RAT Type: Any

Evaluate 
QoS-Upgrade, 
QoS-Negotiation

QoS-Negotiati
on

QoS-Upgra
de

Result

Yes Yes If Requested QoS > configured QoS: 
Grant Configured

If Requested QoS < configured QoS: 
Upgrade to configured

Yes No Requested QoS > configured QoS: 
Grant configured QoS

Requested QoS < configured QoS: 
Grant Requested QoS

No Yes Requested QoS > configured QoS: 
Reject with 
BEARER_NOT_AUTHORIZED

Requested QoS < configured QoS: 
Grant Requested QoS

No No Requested QoS > configured QoS: 
Reject with 
BEARER_NOT_AUTHORIZED

Requested QoS < configured QoS: 
Grant Requested QoS
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PCC Rules
This section covers the following topics:

 Overview, page 197

 Policy Builder Configuration, page 197

Overview
The purpose of the PCC rule is:

 to detect a packet belonging to an SDF to map that packet to proper IP-CAN bearer in downlink and uplink direction

 to identify the service

 to provide appropriate applicable charging

 to provide policy control

There are two different types of PCC rules:

 Dynamic PCC rules: These PCC rules are dynamically provisioned by PCRF to PCEF over Gx interface.

— Pre-configured dynamic rules: These rules can be configured using Policy Builder

— Dynamic generated rules: These rules can be generated by CPS e.g., as result of Rx interaction.

 Pre-defined PCC rules: These PCC rules are pre-configured in the PCEF. The PCRF can advise the PCEF to activate 
a set of PCC rules over Gx interface.

Policy Builder Configuration
1. Login to Policy Builder. 

2. Click Services tab > Use Case Templates. Click Summary and select Use Case Template from the right pane.

3. Click Add to open Select Service Configuration.

IP-CAN-Type 
=3GPP-EPS, RAT-Type 
= 
GERAN/UTRAN/EUTRA
N

Evaluated based 
on IP-CAN-Type

Provision both QoS-Information and Default-EPS-Bearer-QoS.

If Requested QoS > configured QoS: Grant Configured QoS

If Requested QoS < configured QoS: Upgrade to configured QoS

If RAT-Type is 
GERAN

Follow the rules as in IP-CAN-Type GPRS.

IP-CAN-Type=Non-3G
PP-EPS

Evaluate Based 
on IP-CAN-Type

Provision both QoS-Information and Default-EPS-Bearer-QoS.

IP-CAN-Type=DOCSIS 
(1), xDSL (2), WiMAX 
(3), 3GPP2 (4)

Evaluate based on 
IP-CAN-Type

Reject CCR request with 
DIAMETER_ERROR_BEARER_NOT_AUTHORIZED (5143) result code.

Table 3 QoS Authorization Algorithm

IP-CAN-Type/RAT-Typ
e Evaluation Criteria Granted QoS
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4. Select PreConfiguredRule, PreDefinedRule and PreDefinedRuleBase one after another and click required service 
configuration parameters that need to be configured. Click OK to add the service in Service Configuration pane.

Parameter Description
A PCC rules consists of following parameters:

Table 4 PCC Rules Parameters

Parameter Description

Service Identifier The service identifier is used to identify a service or service component 
the SDF relates to.

charging key and charging parameters online or offline charging

Flow status Defines whether the service data flow is enabled or disabled.

Rating Group The charging key for the PCC rule used for rating purposes.

Service Identifier The service identifier is used to identify the service or the service 
component the service data flow relates to.
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Reporting Level The Reporting-Level AVP is of type Enumerated, and it defines on what 
level the PCEF reports the usage for the related PCC rule.There are three 
types of reporting levels:

 SERVICE_IDENTIFIER_LEVEL (0): This value shall be used to indicate 
that the usage shall be reported on service id and rating group 
combination level, and is applicable when the Service-Identifier and 
Rating-Group have been provisioned within the 
Charging-Rule-Definition AVP and Rating-Group AVP have been 
provisioned within the Charging-Rule-Definition AVP. Applicable for 
offline charging.

 RATING_GROUP_LEVEL (1): This value shall be used to indicate that 
the usage shall be reported on rating group level, and is applicable 
when the Rating-Group has been provisioned within the 
Charging-Rule-Definition AVP and Rating-Group AVP have been 
provisioned within the Charging-Rule-Definition AVP. Applicable for 
offline charging.

 SPONSORED_CONNECTIVITY_LEVEL (2): This value shall be used to 
indicate that the usage shall be reported on sponsor identity and 
rating group combination level, and is applicable when the 
Sponsor-IdentityAVP, Application-Service-Provider-Identity AVP and 
Rating-Group AVP have been provisioned within the 
Charging-Rule-Definition AVP. Applicable for offline charging.

Metering Method The Metering-Method AVP (AVP code 1007) is of type Enumerated, and it 
defines what parameters shall be metered for offline charging. The PCEF 
may use the AVP for online charging in case of decentralized unit 
determination and having three values:

 DURATION (0): This value shall be used to indicate that the duration 
of the service data flow shall be metered.

 VOLUME (1): This value shall be used to indicate that volume of the 
service data flow traffic shall be metered.

 DURATION_VOLUME (2): This value shall be used to indicate that the 
duration and the volume of the service data flow traffic shall be 
metered.

Precedence Indicates the precedence of QoS rules or packet filters.

Table 4 PCC Rules Parameters

Parameter Description
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5. In Services tab, click Services > Service Options to create a service option and add the configured Use Case 
Template in Step 4. on page 198 to configure Service Option. An example is shown below.
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Note: To activate a predefined charging rule at PCEF, charging rule name must be used as a reference to the 
predefined charging rule. To activate a group of predefined charging rules within the PCEF (e.g., gold users or 
gaming services) charging rule base name must be used as a reference to the group of predefined charging rules.
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6. In Services tab, click Services > Services to create a service and add the configured Use Case Template in Step 
4. on page 198 to configure Service. An example is shown below.

Table (CRD) Driven Rules
This section covers the following topics:

 Overview, page 202

 Policy Builder Configuration, page 203

 Common Steps, page 210

 Control Center Configuration, page 214

 CRD Supported Features, page 215

Overview
ASR5K supports handling of Service Group QoS and defines new Gx AVPs which are exchanged between PCEF and 
PCRF. Additionally, CPS (PCRF) already supports various use cases related to PCC Rules provisioning and usage 
monitoring control as defined in 3gpp specification 29.212. Also the new AVPs related to CISCO Service Group QoS are 
already supported in CPS.

This feature uses capabilities of Customer Reference Data tables and Search Table Group functionality of CPS.
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CPS supports defining a Customer Reference Data table where in all sub-elements of Cisco QoS Group rules are 
possible to be configured with different values for each element. Also it is possible to group these rules under a logical 
group. The application at run time supports queries based on this configured logical group, and Search Table group, and 
is able to retrieve all applicable CISCO Service QoS Group rules and its sub-elements.

This feature can be configured by using two service options namely, TableDrivenCiscoQosGroupRule (For Cisco QoS 
Group rules) and TableDrivenChargingRule (For standard PCC rules). Description of their common parameters is listed in 
a table below.

Policy Builder Configuration

Table Driven Cisco QoS Group Rule
1. Login to the Policy Builder. 

2. Select Services tab > Use Case Templates > Summary. Click Use Case Template link from the right side under 
Actions.

3. Create a Use Case Template for TableDrivenCiscoQosGroupRule.

4. Select Services > Summary. Click Service Option link from the right side under Actions to create a service option 
using Use Case Template created above.

Table 5 Common Parameters between TableDrivenCiscoQosGroupRule and TableDrivenChargingRule

Parameter Description

Search Group Search Group is a constant value which CPS uses to search within the Search Table Group 
indicated by “Search Table” element.

Search Column Search Column must be bound to the Key column of the STG (which must be given a data 
type of Text).

Rule Name Source Rule Name Source must be a key column as well. This filed must be bound to the rule name 
column within the STG which should be Text.

Flow Status Source Flow Status Source must be bound to the Flow status column within the STG which should 
be Text.

Monitoring key Source Monitoring key Source must be bound to the Monitoring Key column within the STG which 
should be Text.

Encoding format Source Encoding format Source must be bound to the Encoding format column within the STG 
which should be either Boolean or Text. If this is defined as Text Data Type then Valid 
Values must be provided as (True/False).

Redirect Enabled 
Source

Redirect Enabled Source must be bound to the Redirect Enabled column within the STG 
which should be either Boolean or Text. If this is defined as Text Data Type then Valid 
Values must be provided as (True/False).

Redirect Address Type 
Source

Redirect Address Type Source must be bound to the Redirect Address Type column within 
the STG which should be Text.

Redirect Address 
Source

Redirect Address Source must be bound to the Redirect Address column within the STG 
which should be Text.

Use Override Server 
Address

Use Override Server Address must be bound to the Use Override Server Address column 
within the STG which should be either Boolean or Text. If this is defined as Text Data Type 
then Valid Values must be provided as (True/False). If this flag is true then it will take the 
address from the service option and if it is false then it would not override the redirect 
server address.
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A sample configuration is shown below:
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Note: For description/usage of different parameters, refer to Table 5 on page 203.

5. To bind the Value, select the name from the Display Name column and in Value column click .... to open Please 
select a 'CustomerReferenceDataTable' object.
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6. Select the required object to bind and click OK. A sample selection is shown below:

Refer to Common Steps, page 210 to continue with the configuration.

Table Driven Charging Rule
1. Login to the Policy Builder. 

2. Select Services tab > Use Case Templates > Summary. Click Use Case Template link from the right side under 
Actions. 

3. Create a Use Case Template for TableDrivenChargingRule.

4. Select Services > Summary. Click Service Option link from the right side under Actions to create a service option 
using Use Case Template created above.
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A sample configuration is shown below:
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Note: For description/usage of common parameters, refer to Table 5 on page 203. Other then the parameters defined 
in Table 5 on page 203, following parameters can be configured.

Table 6 TableDrivenChargingRule Parameters

Parameter Description

Online Source Online Source must be bound to the rule name column within the STG which should 
be Number. The possible values are mentioned in 3GPP specification 29.212.

Offline Source Offline Source must be bound to the rule name column within the STG which should 
be Number. The possible values are mentioned in 3GPP specification 29.212.

Rating Group Source Rating Group Source must be bound to the rule name column within the STG which 
should be Number. The possible values are mentioned in 3GPP specification 
29.212.
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5. To bind the Value, select the name from the Display Name column and in Value column click ... to open Please 
select a 'CustomerReferenceDataTable' object.

6. Select the required object to bind and click OK.

Service Id Source Service Id Source must be bound to the rule name column within the STG which 
should be Number. The possible values are mentioned in 3GPP specification 
29.212.

Reporting Level Source Reporting Level Source must be bound to the rule name column within the STG 
which should be Number. The possible values are mentioned in 3GPP specification 
29.212.

Precedence Source Precedence Source must be bound to the rule name column within the STG which 
should be Number. The possible values are mentioned in 3GPP specification 
29.212.

Metering Method Source Metering Method Source must be bound to the rule name column within the STG 
which should be Number. The possible values are mentioned in 3GPP specification 
29.212.

Flow-Information Source Flow-Information Source must be bound to the rule name column within the STG 
which should be Text.

Use Override Server Address Use Override Server Address must be bound to the rule name column within the 
STG which should be either Boolean or Text. If this is defined as Text Data Type then 
Valid Values must be provided as (True/False).

Table 6 TableDrivenChargingRule Parameters

Parameter Description
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A sample selection is shown below.

Refer to Common Steps, page 210 to continue with the configuration.

Common Steps
1. Since this approach leverages Customer Reference and Search Table Group capabilities of CPS, we need to 

configure a Search Table Group to be able to use the above Service Configuration to configure a 
Search-Group-Table with the output column specified. 
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A sample configuration is shown below.
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— The “Rule_Group” in the above STG is the key column indicating that searches need to be based on it.
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— The “Search Group” and “Search Column” are expected to be configured or bound to the “Rule_Group” column 
of the STG.

2. It is possible to retrieve the redirect Address related elements of CISCO Service Group QoS from another table.
213



Gx/Sd Services

 

Gx Services
A sample configuration is shown below.

Note: In other cases if Redirect URL STG is not required, and if redirect URL is being derived from other components of 
CPS, the use of override address is essential. The override server address can be derived from retrievers when the 
redirect address is not populated from CRD.

Control Center Configuration
1. Login to the Control Center.

2. Select Configuration tab > Configuration > Reference Data.

3. Select the STG created in Policy Builder and add data by creating new rows.
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A sample configuration is shown below.

CRD Supported Features

Table Driven Rule Name Support
This feature allows CPS to do UNION of two set of rule lists, which means we will get all those rules which are common 
to both the rule lists obtained from two different STGs. 

1. Create a new STG/CRD called 'gw-version-mapping-table'.

— Based on the incoming Gx origin Host and Gx Origin Realm, determine the GW Version.

— Make this table as 'Best Match': Enable the check box for best match utility. 

Origin Host (Input) Original Realm (Input) GW Version (Output)

gx_origin_host gx_origin_realm gw_version

Bind to 'Gx Request Origin-Host' Bind to 'Gx Request Origin-Realm' NA
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2. Create another STG/CRD called 'gw-rule-mapping-table'.

— Link the input column 'gw_version' in this table to the output from the earlier table.

— Both columns are input columns in this case.

Note: For same GW version, we can define multiple rules, so we need to have each rule name as an input column.

GW Version (Input) Rule Name (Input)

Gw_version Rule_name

Bind to result column from  'gw_version_mapping-table' NA
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3. In the existing 'QoS-Group-Rules' template (where we already have the Table Driven objects) add the new object 
'TableDrivenRuleNameSupport'. 

4. In the same Service Configuration Object 'QoS-Group-Rules', then click add. The new service configuration object 
(added in the template) will be available here. 

Note: Update the following fields in the new service configuration object: 

— Logical-Grouping: Update as grp-gw-support.

— Search Table: Click on the icon in the Value section and select gw-rule-mapping-table from the drop-down 
list.

— Search Group: Click on the icon in the Pull Value from section and select the Group level output gw_version 
from gw-version-mapping-table. 

— Search Column: Click on the icon the Value section and select gw_version input column from 
gw-rule-mapping-table. 

— Rule Name Source: Click on the icon the Value section and select rule_name input column from the same 
gw-rule-mapping-table as above.

With this configuration, CPS would do a UNION operation with the QoS groups obtained from the new 
'TableDrivenRuleNames' Object (based on the GW version) and the ones retrieved from 
'TableDrivenCiscoQoSGroupRules' (based on Rule-Mapping table & Rule-Group-Mapping table).
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Mapping for Search Table of TableDrivenRuleNameSupport:

Mapping for Search Group of TableDrivenRuleNameSupport:
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Mapping for Search Column of TableDrivenRuleNameSupport:
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Best Match Table Logic
CPS supports each table lookup in CRD which needs to be an exact match, along with Best Match table. This approach 
is fast, efficient, and very easy to troubleshoot, but does not scale when there are dozens, scores, or hundreds of 
combinations of values, in which case you need to support wild cards, or “best match”- type comparisons.

CPS first searches for exact match from CRD and then attempts for Best Match, which will provide the output as per 
configuration.

 STG Table as Input for Best Match:

Note: Best Match option under CRD table must be checked.
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 Output Table of CC which can take wild card entry like * while adding or editing.

Custom Features
This section covers the following topics:

 Service Group QoS, page 224

 Content Filtering, page 227

Service Group QoS

Overview
The goal of Service Group QoS is to provide support within PCRF in ASR5K to define and enforce Fair-Usage-Policy 
(FUP) per subscriber. CPS provides support for CISCO Service Group QoS in ASR5K based deployment of PCEF. Service 
Group QoS is sent over the Gx interface when CPS (PCRF) tries to install or remove rules for a subscription based on 
various triggers. These attributes are CISCO deployment specific and are enabled only for the “Gx clients” which support 
Service Group QoS Rules.

Policy Builder Configuration
1. Login to Policy Builder. 

2. Select Services tab > Use Case Templates > Summary. Click Use Case Template link from the right side under 
Actions.

3. Click Add to open Select Service Configuration.
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4. Select CiscoQoSGroupRule and click required service configuration parameters that need to be configured. Click 
OK to add the service in Service Configuration pane.

User can configure various QoS Group Rule parameters depending on the network requirements. For 
configuration/usage of different parameters, refer to Common Parameters Used, page 265.
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5. In Services tab, click Services > Service Options to create a service option and add the configured Use Case 
Template in Step 4. on page 225 to configure Service Option. A sample configuration is shown below.
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6. In Services tab, click Services > Services to create a service and add the configured Use Case Template in Step 
4. on page 225 to configure Service. A sample configuration is shown below.

Content Filtering

Overview
The goal of Content Filtering is to provide support for content filtering within the network by use of Policy ID's. Policy 
identifiers (Policy IDs) are rules that are configured on the ASR 5000 platform and invoked by the CPS. Policy IDs are 
used to implement the required Content Filtering policies defined for the subscriber. The Policy IDs are selected at the 
ASR 5000 by provisioning their values through the Gx interface by the PCRF.

When a user initiates a session, the ASR5K communicates with the CPS to initialize the defined policies. CPS provides 
the Policy ID to the ASR5K to provide the necessary Content Filtering services for the user.

The main aim of this feature is for CPS to provide Policy ID's configured in the subscriber's service to the PCEF (ASR5K).

Policy Builder Configuration
There are three sequential procedures to configure the Policy IDs using the CPS. 

1. Login to Policy Builder. 

2. Select Services tab > Use Case Templates > Summary. Click Use Case Template link from the right side under 
Actions. 
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3. Provide a name for the template in the Name field.
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4. To define the basic template, under Service Configurations, click Add. Select the required configurations from the 
pop-up window and click OK.

Note: Cisco Content Filtering Policy option must be selected along with other configurations to provide Content 
Filtering services. 

Note: The check boxes in the Allow Override column are checked by default. This allows the subscriber to change 
the values in the Service Option. Otherwise, the value remains constant.

5. Click the Save icon. 

6. In the left column, select Services. 

7. Locate the template that was defined in the above procedure and click Service Option in the summary window. The 
configurations that had been selected in the above procedure appears in the window.

8. Click OK. Define the required parameters. 

9. Select the configuration to define the parameters from the list of Service Configurations. 

10. In the Parameters columns, set the required values. 
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11. Click CiscoContentFilteringPolicy option and set the Policy ID value in the parameters field.

Note: Value for Policy ID should not be set to zero (0). Policy IDs can be dynamically assigned to the subscriber by 
referring to the Customer Reference Data Tables.

12. Click Pull value from... option in the parameters column to assign Policy IDs dynamically from a pre-defined 
Customer Reference Data Table.
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Emergency Data Services
This section covers the following topics:

 Overview, page 231

 Configure Diameter Gx Client for Emergency APNs, page 231

 Configure Service for Emergency Sessions, page 233

 Configure Prioritizing Emergency Sessions using APNs, page 235

Overview
CPS supports Emergency Data Services as per the procedures defined in 3GPP TS 29.212. The operator has to configure 
a list of Emergency Access Point Names (APNs) that are valid for the operator. These APNs are then used by CPS to 
identify a session as an Emergency session. CPS also supports installation of QoS and Rules for emergency sessions. 

Configure Diameter Gx Client for Emergency APNs
The emergency APNs have to be configured in the Diameter Gx Client configuration. So, first you need to configure a 
Diameter Gx Client. For more details on how to configure the Diameter Gx Client, refer Diameter Clients, page 74. 

1. Login into Policy Builder.

2. Select Reference Data tab.

3. From the left pane, select Diameter Clients.

4. Expand the Gx Clients by clicking on the arrow right next to “Gx Clients”. If you do not see this arrow, this means 
you have not created the Gx Client. Refer Diameter Clients, page 74 to create a Gx Client.
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5. Select the Gx Client name created by you. Gx Client attributes as shown below will come up in the right pane.
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6. Click Add to configure the emergency APNs. A new window as shown below will pop up.

7. Type the name of the emergency APN that you want to add in the Value to Add (String) text box and click Add. 

8. Click OK. In the example shown above, four APN entries are already added.To remove an APN from this list, select 
the APN to be removed and click Remove.

Note: CPS supports wildcarding for the Emergency APN names. As shown in the example above, we have used '*' 
for wildcarding. CPS uses standard Java pattern characters for APN names. For more information, refer to 
http://www.vogella.com/tutorials/JavaRegularExpressions/article.html#regex.

Configure Service for Emergency Sessions
For emergency APNs, the IMSI may not be present. Hence, CPS allows emergency sessions without subscriber 
authentication. 

1. Login into Policy Builder.

2. Select Services tab.

3. From the left pane, select Domains.

4. Select the Domain name that you want to use for emergency subscribers. Domain attributes will open up in the right 
pane. If you want to create a new Domain, then refer Domains, page 143.
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5. Select Advanced Rules tab.
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6. Click select near Anonymous Subscriber Service. A new window as shown below will pop up. Select the Service 
that you want to assign for emergency sessions and click OK.

Configure Prioritizing Emergency Sessions using APNs
Emergency calls are fast-tracked through the CPS platform by by-passing authorization logic. As a user, the CPS 
platform enables to prioritize these emergency calls by APN. CPS uses “Emergency Message Priority”, for this 
prioritization. These attributes are part of “Inbound Message Overload Handling” feature under “Diameter Configuration”. 
For more details, refer Inbound Message Overload Handling, page 59.

1. Login into Policy Builder.

2. Select Reference Data tab.

3. From the left pane, select Systems and expand your system name or cluster name.

4. Select and expand the Plugin Configurations.

5. Select Diameter Configuration. Diameter configuration screen will appear in the right pane.
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6. Check Inbound Message Overload Handling check box. A new pane as shown below opens up.

7. Click Add under Message Handling Rules table. A new row is added in the table as shown below.
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8. Click ... in the Diameter Client column. A new window opens as shown below.

9. Select the Gx Client in which we added the emergency APNs in Configure Diameter Gx Client for Emergency APNs, 
page 231 and click OK.

10. Configure the other parameters of the table. A sample configuration is shown below.
237



Gx/Sd Services

 

Gx Services
Note: For the detailed explanation of all the parameters of the Inbound Message Overload Handling feature, refer 
Inbound Message Overload Handling, page 59. The parameters relevant to the prioritization of emergency sessions 
are explained below.

Note: Higher the value of the priority, the higher is the priority. User must take care that the Emergency Message 
Priority field value is higher than the priority column values present in the Message Handling Rules, so that the 
Emergency Messages are processed first than the usual messages.If we take the example values configured above, 
then this is how the priority is assigned to the incoming messages.

Note: By default, the emergency message priority is higher than the default priority. This means, if you do not 
configure the Inbound Message Overload Handling, then default priority = 0 and emergency message priority = 1.

RAN Congestion
This section covers the following topics:

 Overview, page 238

 Policy Builder Configuration, page 239

 Control Center Configuration, page 242

 Parameter Description, page 243

Overview
Currently, when RAN congestion is configured, at the hour boundary there is a check for congestion level change. If the 
congestion level has changed then RAR is sent in which new rules corresponding to changed congestion level are 
applied.

Table 7 Prioritization of Emergency Session - Parameters

Parameter Description

Default Priority Default priority to be assigned to an incoming message, if no specific one is defined 
in the Message Handling Rules table. 

Default value is 0.

Emergency Message Priority Default priority assigned to incoming messages related to an emergency session. 

Default value is 0.

Message Handling Rules Defines specific inbound message overload handling rules based on different 
criteria. Message Handling Rules are generic. This means for all CCR-I messages, if 
you want to process with priority, user needs to set the configuration in Message 
Handling Rules.

Incoming Message Priority Description

Any message for any emergency 
session/APN

5 The default emergency message priority is assigned as this is 
emergency APN.

A Gx CCR-I message for the 
non-emergency APN

3 The protocol, command code, and request type match the 
message handling rules.

A Gx CCR-U message for the 
non-emergency APN

0 Request type does not match with the value in the “Message 
Handling Rules”. So, the default priority is assigned.
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The next evaluation time for session is set to the time when the congestion level changes next. At that hour boundary 
again the session is evaluated, and new rules applicable to changed level are applied. Since all the sessions are getting 
re-evaluated at applicable hour boundaries where the congestion level changes, there is a possibility of huge amount of 
RAR's being generated by CPS. CPS can generate this load of RAR's without any issues as it is distributed amongst the 
CPS VMs but there might be limitation on other network element to handle the RAR surge.

To prevent RAR burst at the hour boundary, we can evaluate configured services for next hour based on the appropriate 
congestion levels for next hour and pre-install the rules specifying Activation/Deactivation times.

Policy Builder Configuration
1. Login to Policy Builder. 

2. Click Services tab > Use Case Templates. Click Summary and select Use Case Template link from the right side.

3. Click Add to open Select Service Configuration.

4. Select PreDefinedRuleBase and click required service configuration parameters that need to be configured. Click 
OK to add the service in Service Configuration pane.

Configuration for Current Hour
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Configuration for Next Hour

 In order to achieve the RAN congestion use case to install rules based on congestion levels, we need to configure 
use case initiators to modify the rules based on congestion level.

— Use case initiator - on condition that congestionLevel = 1, changes rulename to internetlvl1

— Use case initiator - on condition that congestionLevel = 2, changes rulename to internetlvl2

— Use case initiator - on condition that congestionLevel = 3, changes rulename to internetlvl3

 Assume congestionLevel is 1 for current hour and 2 for next hour. When services are evaluated for current time, this 
evaluates only to internetlvl1. In order to also evaluate services for the look ahead hour, we need to add 
corresponding modified rules for each with use case initiators as follows:

— Use case initiator - on condition that congestionNextHourLevel = 1, changes rulename to internetlvl1

— Use case initiator - on condition that congestionNextHourLevel = 2, changes rulename to internetlvl2

— Use case initiator - on condition that congestionNextHourLevel = 3, changes rulename to internetlvl3
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Example of configuration for one of the use case modifiers is shown below:
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Custom Reference Data Table Configuration
 We have to create one CRD table in which SAC and 0-23 Hrs need to define as shown in table below. SAC will be 

cell id of the network and need to bind with Gx session. Output of this table is shown below in Control Center 
Configuration, page 242.

 We have to create one more CRD for rule selection based on APN,RAT Type and Incoming rule name for each 
congestion level _and output of this table will be OutputRuleName as shown in below sample.

Control Center Configuration
1. Login to the Control Center.
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2. Select Configuration tab > Configuration > Reference Data.

3. Select the STG created in Policy Builder and add data by creating new rows. A sample configuration is shown below.

Note: 

 0-3 are congestion levels

 Currently, we supports only current and next level congestion.

Parameter Description
The following table provides information related to RAN Congestion parameters:

Note: By default, CPS sets the next evaluation time as per the next change in congestion level. To configure CPS to do 
a forward lookup for multiple changes in congestion level, add the following parameter to qns.conf:

-DcongDataLookAhead=true

Usage Monitoring
This section covers the following topics:

 Overview, page 244

Table 8 RAN Congestion Parameters

Parameter Description

Rule Name Any name which you want to give for rule name.

Scheduled Hour: drop-down list with three values. Default: It turns OFF Hour Boundary RAR enhancement 
feature for look ahead rules installation at hour boundary 
and causes rules to behave in normal fashion of getting 
installed at hour boundary as applicable

CurrentHour: For the current hour rule activation time will 
be current time, deactivation time will be next hour.

NextHour: For the next hour rule activation time will be 
next hour, deactivation time will be next-next hour.
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 Policy Builder Configuration, page 244

 Scheduled Usage Monitoring, page 246

 Parameter Description, page 249

Overview
CPS supports Usage-Monitoring over Diameter Gx interface with different Balance Code, Dosage and monitoring level. 
Usage monitoring key Identifies the usage monitoring control instance and is subscribed using Event-Trigger AVP = 
USAGE_REPORT.

Policy Builder Configuration
1. Login to Policy Builder. 

2. Click Services tab > Use Case Templates. Click Summary and select Use Case Template link from the right side.

3. Click Add to open Select Service Configuration.

4. Select UsageMonitoringKey under gx and click OK to add the service in Service Configuration pane.
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5. In Services tab, click Services > Service Options to create a service option and add the configured Use Case 
Template in Step 4. on page 244 to configure Service Option. A sample configuration is shown below.

6. In Services tab, click Services > Services to create a service and add the configured Use Case Template in Step 
4. on page 244 to configure Service. A sample configuration is shown below.
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Scheduled Usage Monitoring
To support scheduling, CPS uses Monitoring-Time AVP in Monitoring information. To use Monitoring-Time AVP CPS 
supports Usage Monitoring Congestion Handling (UMCH) feature on Gx. If the PCEF does not support UMCH feature, 
CPS uses the RAR message to request account balance usage details of the previous or older schedule. CPS will charge 
the account balance usage against the old schedule and further grants a new dosage value as per the new schedule. 
CPS uses the next evaluation time set on the diameter session to trigger the RAR message for requesting the 
usage-report on schedule's time boundary. 

The current Usage-Monitoring information in the Gx session is added with monitoring schedules to grant and track the 
usage for the PCEF, based on current and adjacent schedules. It also provides support to bind different balance code to 
each schedule. CPS grants, reserves and charges the respective balance as per the usage monitoring schedule defined. 
CPS defines dosage on each schedule and accordingly grants single units to PCEF in Granted-Service-Units AVP. It also 
defines charging rate on each schedule. The default charging rate is 1. 

This feature provides support to configure multiple schedules in monitoring-key service configuration.

Configure a Scheduled Usage Monitoring
Scheduled Usage Monitoring is configured in the Service Options section of the Services tab. The Service Configuration 
UsageMonitoringKey allows scheduled monitoring in the Monitoring Schedule (List) parameter. 

Before configuring a scheduled monitoring, the following configuration must be completed in the Policy Builder: 

 Configure the Account Balance Templates, page 304 in the Reference Data tab.

 Configure a Use Case Template, page 163 in the Services tab. 

Configuration restrictions while defining Monitoring schedule in Policy Builder:

 The time value should be entered in hh:mm format.

 Monitoring schedule should be complete for 24 hours.

 First monitoring schedule should start at mid-night with start-time value as 00:00 and last schedule should end on 
next mid-night with end-time value as 23:59.

 Time entry with 23:59 will be rounded-up to complete the 24 hour schedule.

To configure a scheduled monitoring, perform the following steps:

1. Select Services tab. 

2. Click Services > Service Options and select the corresponding Service option whose name matches the Use Case 
Template.

3. Provide a name for the service in the Name field. 

4. In the Service Configuration section, click Add. A pop-up window is displayed. Select UsageMonitoringKey and 
click OK. 
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5. In the Service configuration parameters, select Monitoring Schedule and click Add Child to add a 
UsageMonitoringSchedule.
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6. Select the UsageMonitoringSchedule to provide the values as shown in the sample below.

a. Enter the Start Time in 24 hrs format (00:00 to 23:59).

b. Enter the End Time in 24 hrs format (00:00 to 23:59).
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c. Provide a value for the Balance Code as shown in the sample below. Click the icon circled in red, a window 
appears. Select the required Balance Code and click OK.

d. Enter the Dosage value. 

e. Enter the Rate value

To add multiple UsageMonitoringSchedule, click Add Child and add the parameters according to your 
requirements.

Parameter Description
The following parameters can be configured for Usage Monitoring Schedule:

Table 9 Usage Monitoring Schedule Parameters

Parameter Description

Encoding Format Having two values true and false

A default value is false. If monitoring key is numeric it should be true otherwise false.

Dosage Units provided by CPS at a time for subscriber session.

Monitoring Level Monitoring level having three values:

 SESSION_LEVEL (0)

 PCC_RULE_LEVEL (1)

 ADC_RULE_LEVEL (2)
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Bandwidth Monitoring
This section covers the following topics:

 Overview, page 250

 Policy Builder Configuration, page 250

 Parameter Description, page 259

Overview
The purpose of this feature is to track bandwidth and apply policies based on that. Normal usage monitoring is used to 
track usage but not bandwidth.This feature is based on usage monitoring key being installed in order to have the usage 
reported by the PCEF. Using this feature, the service provider can install a monitoring key and the different thresholds 
that are used to flag the subscriber. This feature works in parallel with the usage monitoring feature but the usage 
monitoring feature has a higher priority since that one is about charging traffic. In this context 'higher priority' means that 
usage monitoring feature installs any usage monitoring keys it needs to do its job.

Bandwidth monitoring installs any additional monitoring keys it needs while reusing any monitoring keys that were already 
installed. In order to reuse a monitoring key the same monitoring key name should be used in both BandwidthMonitor 
and UsageMonitoringKey objects. ReportingTimeout value is in minutes and is used to set the Revalidation-Time AVP so 
that the subscriber has a chance to get unthrottled before the allocated dosage is used. The BandwidthThreshold Lower 
Value is in kbps and when the computed bandwidth used is over that value, the corresponding Label is set to the 
subscriber for the particular application identified by Name attribute.

Policy Builder Configuration
1. Log in to Policy Builder.

2. Click Services tab > Use Case Templates. 

Enabled Having two values true and false:

 True: Monitoring information will flow to PCEF.

 False: Monitoring information will not flow to PCEF.

Balance Code The balance code indicates which balance the quota will be provided from. User can 
subscribe to multiple balances, but the monitoring key is associated with one balance.

Validity Period Minutes Time for which the balance code representing the quota is valid and default value is 60 
minutes. This parameter is deprecated.

Dosage Override Default dosage override based on remaining balance on the selected account.

Table 9 Usage Monitoring Schedule Parameters

Parameter Description
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3. If you want to create a new use case template, click Use Case Template in the main window under Create Child to 
open the default use case template.

4. Enter the name for the template. For our example name it as Bandwidth Monitoring. 

5. Click Add under Service Configurations tab to open Select Service Configuration window.
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6. Select the necessary service configuration objects and click OK to add the objects in Service Configurations pane.

Note: The Bandwidth Monitoring service option includes the BaseUsageMonitoringKey that enables Gx usage 
monitoring for this subscriber.

7. Click Services > Service Options > name of the Use Case Template provided in Step 4. on page 251. 

8. Click Service Options in the main window under Create Child to open Select Service Configuration window which 
consists of already defined Service Configurations and click OK.

9. Select BandwidthMonitor from the Service Configurations pane. 

a. We can monitor the Bandwidth usage on a per session rule base or per PCC rule base. For example, let us name 
this bandwidth monitor per session base as SESSION. 

b. Under Monitoring Key, enter the values for Monitoring Key, Dosage, and Monitoring Level. For session level, the 
Monitoring Level should be 0. 
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c. Also enable the BaseUsageMonotoringKey.
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d. Under Bandwidth Threshold, define three levels for bandwidth - Low, Medium and High.

10. Click Services > Use Case Templates > name of the Use Case Template provided in Step 4. on page 251.

11. Click Use Case Option in the main window under Create Child to open Use Case Option pane and name it as Low 
Bandwidth Usage. 
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12. Click Add to open Select Service Configuration window and select DefaultBearerQoS and click OK to add the 
service.

13. Rename the configured service as LowDefaultBearerQoS. 

14. Click Use Case Initiators tab. Click plus sign (+) to add a service initiator. Rename the initiator as Low. 
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15. Under Conditions, click Add to open Select the Condition Phrase which you would like to use. window and select 
the required condition and click OK.

The added condition is displayed in Conditions pane.

16. Click Add All under Available Input Variables. 

a. In the Value column under name (String), enter the name for the bandwidth monitor as mentioned in Step a. on 
page 252. The name should match what you have entered in Step a. on page 252. 

b. In the Value column under label (String), enter the Bandwidth threshold value defined in Step d. on page 254.

17. Create another initiator and add the condition A bandwidth monitor status does not exist to it. Add the name 
(String) to the condition. 

18. Repeat the steps from Step 11. on page 254 to Step 16. on page 256 for Medium and High bandwidth usage.
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19. Click Services > Service Options > name of the Use Case Template provided in Step 4. on page 251. Add all the 
service configurations as shown below.

20. Define the different parameters for low, medium and high bandwidth usage monitoring in Service Configurations 
pane according to the customer requirements. A sample configuration for Low Bandwidth Usage Monitoring is 
shown below.

21. Click Services > Services and click Service under Create Child to open Service window. 
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22. Enter the name in Code and Name text fields.

23. Click Add to open Select Service Configuration window. Select the service which you have configured in Step 4. 
on page 251 and click OK.

24. Select Use V9 Event Trigger Mapping and Rel8 Usage Monitoring Supported under Diameter Configuration, 
page 55.

— If Use V9 Event Trigger Mapping check box is not selected, the event trigger mapping ID (33) from 3GPP TS 
29.212 V11.10.0 (2013-09) is used. 

— If Use V9 Event Trigger Mapping check box is selected, the event trigger mapping ID (26) from 3GPP TS 29.212 
V9.5.0 (2013-09) is used.
258



  
Gx/Sd Services

Gx Services
Parameter Description
The following parameters can be configured in Bandwidth Monitoring:

Common Parameters Used
The following is the list of common parameters that can be configured under all the sections mentioned above in this 
chapter.

Table 10 Bandwidth Monitoring Parameters

Parameter Description

Name Any name you can give.

Reporting Timeout It is revalidation timer for defined dosage.

Lower Value It is minimum bandwidth value you can give for that particular Lable.This value is not 
standard and defined as per requirement and should be integer. 

Label It is the name of label which can depends upon users requirement.

Table 11 Common Parameters

Parameter Description

Qci The QoS class identifier identifies a set of IP-CAN specific QoS parameters that 
define QoS, excluding the applicable bitrates and ARP. It is applicable both for 
uplink and downlink direction. The QCI values 0, 10 – 255 are divided for usage 
as follows:

 0: Reserved

 10-127: Reserved

 128-254: Operator specific

 255: Reserved

Max Req Bandwidth UL It defines the maximum bit rate allowed for the uplink direction.

Max Req Bandwidth DL It defines the maximum bit rate allowed for the downlink direction.

Guaranteed Bit Rate UL It defines the guaranteed bit rate allowed for the uplink direction.

Guaranteed Bit Rate DL It defines the guaranteed bit rate allowed for the downlink direction.

Apn Agg Max Bit Rate UL It defines the total bandwidth usage for the uplink direction of non-GBR QCIs at 
the APN.

Apn Agg Max Bit Rate DL It defines the total bandwidth usage for the downlink direction of non-GBR QCIs 
at the APN.
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Priority Level Values: 1 to 8 - 
assigned for services that are 
authorized to receive prioritized 
treatment within an operator 
domain. Values: 9 to 15 - Can be 
assigned to resources that are 
authorized by the home network 
and thus applicable when a UE is 
roaming.

The priority level is used to decide whether a bearer establishment or 
modification request can be accepted or needs to be rejected in case of 
resource limitations (typically used for admission control of GBR traffic). The AVP 
can also be used to decide which existing bearers to pre-empt during resource 
limitations. The priority level defines the relative importance of a resource 
request. 

Values 1 to 15 are defined, with value 1 as the highest level of priority.

 Values: 1 to 8 - assigned for services that are authorized to receive 
prioritized treatment within an operator domain.

 Values: 9 to 15 - Can be assigned to resources that are authorized by the 
home network and thus applicable when a UE is roaming.

Preemption Capability If it is provided within the QoS-Information AVP, the AVP defines whether a 
service data flow can get resources that were already assigned to another 
service data flow with a lower priority level. If it is provided within the 
Default-EPS-Bearer-QoS AVP, the AVP defines whether the default bearer can 
get resources that were already assigned to another bearer with a lower priority 
level.

 0: This value indicates that the service data flow or bearer is allowed to get 
resources that were already assigned to another service data flow or bearer 
with a lower priority level.

 1: This value indicates that the service data flow or bearer is not allowed to 
get resources that were already assigned to another service data flow or 
bearer with a lower priority level. This is the default value applicable if this 
AVP is not supplied.

Preemption Vulnerability If it is provided within the QoS-Information AVP, the AVP defines whether a 
service data flow can lose the resources assigned to it in order to admit a service 
data flow with higher priority level. If it is provided within the 
Default-EPS-Bearer-QoS AVP, the AVP defines whether the default bearer can 
lose the resources assigned to it in order to admit a pre-emption capable bearer 
with a higher priority level.

 0: This value indicates that the resources assigned to the service data flow 
or bearer can be pre-empted and allocated to a service data flow or bearer 
with a higher priority level. This is the default value applicable if this AVP is 
not supplied.

 1: This value indicates that the resources assigned to the service data flow 
or bearer shall not be pre-empted and allocated to a service data flow or 
bearer with a higher priority level.

Monitoring Key Identifies a usage monitoring control instance. Any value can be given. 

Priority It is priority of the service option within the service.

Diameter Client The client configuration is used to apply different policies based on PCEF type. 
This is optional parameter.

Rule Group Rule Group is to classify rules at PCRF to change set of predefined rules based 
on policy. This is an optional parameter.

Enable Resource Allocation 
Notification

This is having two values Enabled and Disabled. Default value is disabled.

Table 11 Common Parameters

Parameter Description
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Sd Services
This section covers the following topics:

 Overview, page 261

 Policy Builder Configuration, page 262

Overview
The Sd reference point is located between the Policy and Charging Rules Function (PCRF) and the Traffic Detection 
Function (TDF). The Diameter session on Sd is established either at the request of the PCRF in case of solicited 
application reporting by initiating a (TSR - TDF Session Request) or at the request of the TDF by initiating an (CCR-I) in 
case of unsolicited application reporting. Session modifications may be initiated by either TDF or PCRF.

Solicited Application
For the solicited application reporting, the Sd reference point is used for: 

 Establishment and termination of TDF session between PCRF and TDF. 

 Provisioning of Application Detection and Control rules from the PCRF for the purpose of traffic detection and 
enforcement at the TDF. 

 Usage monitoring control of TDF session and of detected applications. 

 Reporting of the start and the stop of a detected application’s traffic and transfer of service data flow descriptions 
for detected applications, if deducible, from the TDF to the PCRF.

Unsolicited Application
For the unsolicited application reporting, the Sd reference point is used for: 

 Establishment and termination of TDF session between PCRF and TDF.

 Reporting of the start and the stop of a detected application’s traffic. 

 Transfer of service data flow descriptions for detected applications, if deducible, and transfer of Application instance 
identifier, if service data flow descriptions are deducible, from the TDF to the PCRF.

As part of the IP-CAN Session Establishment or Modification procedure, in case of solicited application reporting with a 
TDF, the PCRF initiates a TDF Session Establishment with the selected TDF. The TDF is selected based on data received 
from the PCEF or a local configuration at the PCRF and or SPR data for the subscriber.

Dual Stack Session This is having two values Enabled and Disabled. Default value is disabled.

Framed I P Type It is having four options. Default option is ANY_ONE.

 ANY_ONE

 BOTH 

 IPv4_ADDRESS

 IPv6_ADDRESS

ToD Schedule Identifies the schedule for rule activation and deactivation.

Table 11 Common Parameters

Parameter Description
261



Gx/Sd Services

 

Sd Services
TDF Session Termination happens in any of the following cases:

 the corresponding IP-CAN session is terminated;

 at any point of time when the PCRF decides that the session with TDF is to be terminated (e.g. subscriber profile 
changes).

Policy Builder Configuration
1. Login to Policy Builder GUI. 

2. Click Services tab > Use Case Templates. Click Summary and select Use Case Template. 

3. Click Add to open Select Service Configuration.

4. Select ADC-Predefined-Rule and click required service configuration parameters that need to be configured. Click 
OK to add the service in Service Configuration pane.

ADC Pre-Defined Rule

5. In Services tab, click Services > Service Options to create a service option and add the configured Use Case 
Template in Step 4. on page 262 to configure Service Option.
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6. In Services tab, click Services > Services to create a service and add the configured Use Case Template in Step 
4. on page 262 to configure Service.

ADC Pre-Configured Rule
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ADC Pre-Defined Rule Base
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Event-Trigger for Sd

Common Parameters Used
The following is the list of common parameters configured for Sd Services:

Table 12 Common Parameters

Parameter Description

Qci The QoS class identifier identifies a set of IP-CAN specific QoS parameters that 
define QoS, excluding the applicable bitrates and ARP. It is applicable both for uplink 
and downlink direction. The QCI values 0, 10 – 255 are divided for usage as follows:

 0: Reserved

 10-127: Reserved

 128-254: Operator specific

 255: Reserved

Max Req Bandwidth UL It defines the maximum bit rate allowed for the uplink direction.

Max Req Bandwidth DL It defines the maximum bit rate allowed for the downlink direction.
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Guaranteed Bit Rate UL It defines the guaranteed bit rate allowed for the uplink direction.

Guaranteed Bit Rate DL It defines the guaranteed bit rate allowed for the downlink direction.

Apn Agg Max Bit Rate UL It defines the total bandwidth usage for the uplink direction of non-GBR QCIs at the 
APN.

Apn Agg Max Bit Rate DL It defines the total bandwidth usage for the downlink direction of non-GBR QCIs at 
the APN.

Priority Level Values: 1 to 8 - 
assigned for services that are 
authorized to receive 
prioritized treatment within an 
operator domain. Values: 9 to 
15 - Can be assigned to 
resources that are authorized 
by the home network and 
thus applicable when a UE is 
roaming.

The priority level is used to decide whether a bearer establishment or modification 
request can be accepted or needs to be rejected in case of resource limitations 
(typically used for admission control of GBR traffic). The AVP can also be used to 
decide which existing bearers to pre-empt during resource limitations. The priority 
level defines the relative importance of a resource request. 

Values 1 to 15 are defined, with value 1 as the highest level of priority.

 Values: 1 to 8 - assigned for services that are authorized to receive prioritized 
treatment within an operator domain.

 Values: 9 to 15 - Can be assigned to resources that are authorized by the home 
network and thus applicable when a UE is roaming.

Preemption Capability If it is provided within the QoS-Information AVP, the AVP defines whether a service 
data flow can get resources that were already assigned to another service data flow 
with a lower priority level. If it is provided within the Default-EPS-Bearer-QoS AVP, 
the AVP defines whether the default bearer can get resources that were already 
assigned to another bearer with a lower priority level.

 0: This value indicates that the service data flow or bearer is allowed to get 
resources that were already assigned to another service data flow or bearer with 
a lower priority level.

 1: This value indicates that the service data flow or bearer is not allowed to get 
resources that were already assigned to another service data flow or bearer with 
a lower priority level. This is the default value applicable if this AVP is not 
supplied.

Preemption Vulnerability If it is provided within the QoS-Information AVP, the AVP defines whether a service 
data flow can lose the resources assigned to it in order to admit a service data flow 
with higher priority level. If it is provided within the Default-EPS-Bearer-QoS AVP, the 
AVP defines whether the default bearer can lose the resources assigned to it in order 
to admit a pre-emption capable bearer with a higher priority level.

 0: This value indicates that the resources assigned to the service data flow or 
bearer can be pre-empted and allocated to a service data flow or bearer with a 
higher priority level. This is the default value applicable if this AVP is not supplied.

 1: This value indicates that the resources assigned to the service data flow or 
bearer shall not be pre-empted and allocated to a service data flow or bearer 
with a higher priority level.

Monitoring Key Identifies a usage monitoring control instance. Any value can be given. 

Priority It is priority of the service option within the service.

Diameter Client The client configuration is used to apply different policies based on PCEF type. This 
is optional parameter.

Rule Group Rule Group is to classify rules at PCRF to change set of predefined rules based on 
policy. This is an optional parameter.

Table 12 Common Parameters

Parameter Description
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Flow Status Defines whether the service data flow is enabled or disabled.

Redirect Address Type Defines the address type of the address given in the Redirect-Server-Address AVP.

Redirect Support This value indicates that redirection is enabled for a detected application's traffic.

Redirect Server Address This value indicates the target for redirected application traffic.

Event-Trigger This is not to re-request rules. Primarily to notify start/stop of applications or report 
usage.

Table 13 Sd Parameters

Parameter Description

Tdf Application Identifier This references the application detection filter (e.g. its value may represent an 
application such as a list of URLs, etc.), which the PCC rule for application detection 
and control in the PCEF applies.

Mute Notification An indication whether application start/stop notification is to be muted for ADC Rule 
by the TDF.

Table 12 Common Parameters

Parameter Description
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This chapter covers the following sections:

 Overview, page 269

 VoLTE, page 269

 Dynamic Rule Naming (Multiple Dedicated Bearer QoS), page 277

 QoS Selection, page 278

 Dynamic QoS, page 279

 SRVCC, page 293

 NPLI (Access Network), page 293

 Dynamic PCC (MOG), page 294

 VoLTE Emergency Calls, page 295

 Sponsored Data, page 295

 Multi-Media Priority Services, page 297

Overview
Cisco Policy Suite (CPS) for Mobile is a carrier-grade policy, charging, and subscriber data management solution. It helps 
service providers rapidly create and bring services to market, deliver a positive user experience, and optimize network 
resources. It also generates monetization opportunities across 3G, 4G, and LTE access networks as well as IP Multimedia 
Subsystem (IMS) service architectures.

CPS supports various carrier-based multi-media services by acting as a gateway between the IMS core and Packet core 
network. CPS PCRF supports 3GPP standard Rx interface and comply with related specifications (29.214, 29.213 and 
29.212). With these capabilities CPS supports VoLTE, VOLTE emergency calls, Dynamic PCC, MPS, Sponsored Data, 
QoS enhancements, SRVCC, Access network information reporting and many more such functionalities.

This chapter covers information on various services and policies related to Rx interface mentioned above. It gives 
functional information, configuration details and troubleshooting steps for setting up Rx related services and features in 
CPS.

VoLTE
This section explains CPS policy management configuration for Voice over LTE (VoLTE). VoLTE requires a policy 
management solution to:
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 Establish and release the bearer for voice traffic on behalf of the IP multimedia system (IMS) domain

 Forward the bearer allocation status and subscriber location from the packet core to the IMS domain

 Forward charging information from the IMS domain to the evolved packet core.

 Handle supplementary services, such as call forwarding and call holding, that are delivered in the IMS domain.

A normal VoLTE call will include -

1. Creating a Gx session with default bearer activation (e.g. QCI=5 for SIP signaling).

2. UE IMS (SIP) registration.

3. P-CSCF (AF) initiates dedicated bearer requests to CPS (AAR with Media-Component-Description, Specific-Action, 
etc).

4. Creating a Rx session and session binding at CPS (bind to Gx session).

5. PCRF authorizes QoS and dedicated bearer activation (e.g. QCI=1 for VoLTE voice bearer, MBR, GBR, etc).

6. QoS information is derived based on algorithm defined in section 6.3 of 3GPP 29.213 specifications.

7. QoS information is updated based on QoS policies or services configured in CPS (e.g. Dynamic QoS).

8. PCEF reports bearer creation status and same is indicated to P-CSCF by CPS.
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The following diagram shows the above steps with an example for dedicated bearer establishment in VoLTE call flow:

Policy Builder Configuration

Diameter Stack for Rx
To enable VoLTE services in CPS following diameter configuration is required in Policy Builder:
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 Local endpoints to bind and bring up the diameter server for Rx interface.

 Entry in the 'Inbound Peers' for realms and peers that will interact with CPS over Rx interface.

(Refer to Diameter Configuration, page 55 for information on configuring the diameter stack for Rx interface.)

Service configuration for VoLTE

Domain Configuration
A dedicated “IMS” APN may be used for VoLTE traffic. Typically, established during initial attach as default APN. In CPS, 
operator may define a separate domain to authorize VoLTE calls based on the APN (Called-Station-Id) received in the 
CCR-I message.

(Refer to Basic Systems Configuration, page 9 for information on configuring a domain.)

The following example shows a sample domain configuration:

1. Open the Policy builder GUI. 

2. Go to Services tab.

3. Under Domains, click Summary and then create a child domain.

4. Configure the domain by setting the required configuration for Authorization, Location and default service details 
as shown in example below:

In this example the domain is configured for messages received with “IMS” APN (Called-Station-Id), it authorizes all 
user and attached a default service (with name “IMS”) to the subscriber. Also select Allow all Users for 
Authorization:
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Use this domain for calls received for “IMS” APN (APN is derived from 'Called-Station-Id' AVP received in CCR-I 
message and mapped to a LOGICAL_APN AVP):

Defining a default service:

(Refer to Basic Systems Configuration, page 9 for more information on Domain configuration).

Service Configuration
While defining the service for VoLTE call following service options may be used:
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RxQoSInformation Service Configuration
This service configuration provides an option to define QoS values at service level to be used for dedicated bearer. It 
provides values to be used during the derivation of the Maximum Authorized Data Rates, Authorized Guaranteed Data 
Rates, and Maximum Authorized QoS Class Id in the PCRF whenever the “operator special policy exists” phrase is used 
in the algorithm (3GPP 29.213) description.

The service configuration provides only the QoS AVP output values. It does not have any key parameters. So the QoS 
values will be applied based upon the service (code) enabled for the subscriber. 

For more information on above mentioned parameters, refer to Diameter Configuration, page 55.

RxAppQosInformation Service Configuration
This service configuration provides an option to define authorized QoS values at service level for a combination of 
'Application-id' and 'Media-Type' value. It provides values to be used during the derivation of the Maximum Authorized 
Data Rates, Authorized Guaranteed Data Rates, and Maximum Authorized QoS Class Id in the PCRF whenever the 
“operator special policy exists” phrase is used in the algorithm (3GPP 29.213) description.

The service configuration uses the Af-Application-Id and Media-Type as keys (inputs) for selecting the QoS information 
AVP values. So the QoS values are selected based upon the Af-Application-Id, Media-Type (received in the AAR 
message) and the service (code) enabled for the subscriber.

Table 1 RxQosInformation Service Configuration Parameters

Parameter Description

Qci QoS-Class-Identifier AVP value

Max Requested Bandwidth U L Max-Requested-Bandwidth-UL AVP value

Max Requested Bandwidth D L Max-Requested-Bandwidth-DL AVP value

Guaranteed Bitrate UL Guaranteed-Bitrate-UL AVP value

Guaranteed Bitrate DL Guaranteed-Bitrate-DL AVP value

ARP (Allocation Retention Priority)

Priority-Level Priority-Level AVP value

Preemption-Capability Pre-emption-Capability AVP value

Preemption-Vulnerability Pre-emption-Vulnerability AVP value

Table 2 RxAppQosInformation Service Configuration Parameters

Parameter Description

Af Application Id (Input) Specify the AF-Application-Id for which the QoS values should be applied.

Media Type (Input) Specify the Media-Type for which the QoS values should be applied. (Integer 
value as per 3GPP specifications).

Qci QoS-Class-Identifier AVP value

Max Requested Bandwidth U L Max-Requested-Bandwidth-UL AVP value

Max Requested Bandwidth D L Max-Requested-Bandwidth-DL AVP value

Guaranteed Bitrate UL Guaranteed-Bitrate-UL AVP value

Guaranteed Bitrate DL Guaranteed-Bitrate-DL AVP value

ARP (Allocation Retention Priority)

Priority-Level Priority-Level AVP value

Preemption-Capability Pre-emption-Capability AVP value

Preemption-Vulnerability Pre-emption-Vulnerability AVP value
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For more information on above mentioned parameters, refer to Diameter Configuration, page 55.

Note: When both “RxQosInformation” and “RxAppQosInformation” service configuration are configured then CPS will 
derive QoS values based on “RxAppQosInformation” and if not found then it will use “RxQosInformation” values.

RxGaranteedBitRateOverride Service Configuration
This service configuration provides a configuration option for copying the Max Requested Bit-rate values into Guaranteed 
Bit-rate. This configuration is applicable when CPS is not able to derive Guaranteed Bitrate values based on the QoS 
derivation algorithm defined in 3GPP 29.213 specification. So if GBR is not derived and this service option is configured 
then CPS will copy the values derived for Max Requested Bitrates into Guranteed Bitrates (applicable for both UL and DL).

Note: In a VoLTE specific service operator can defines basic Gx specific services configurations like DefaultBearerQos, 
Event-Trigger, etc. For more information on these services configuration, refer to Gx Services, page 185.

The following are the steps to configure the Service options details (RxAppQosInformation, RxAppQosInformation) for 
setting up a sample VoLTE specific service:

1. Open the Policy builder GUI.

2. Go to Services tab.

3. Under Use Case Templates, click Summary and then create a child Use Case Template.

4. Add a Name to the template, e.g. “Rx_VoLTE”.

5. Click the Add button in the Service Configuration pane and add “RxQosInfomration” service configurations listed 
under 'rx' section. 

Similarly, operator can optionally add other service configurations like RxAppQosInformation, 
RxGuaranteedBitrateOverride, listed under 'rx' section as well as DefaultBearerQos, Event-Trigger, etc. listed under 
'gx' section.

6. Go to Services Options, the newly created template (Step 5. on page 275) would be available here.

7. Create a child Service Option e.g. “volte”.

8. Click OK. The newly created service options should have the Service Configuration objects which were added 
previously at the template level.

Table 3 RxGaranteedBitRateOverride Service Configuration Parameters

Parameter Description

Set Guaranteed Bitrates from Max 
requested Bitrates

Flag that indicates whether to copy the MBR values into GBR values when GBR 
is not derived. 

Default value is checked (true).
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9. Select the “RxQosInfomration” service configuration and configure it as per the example shown below.

10. Select the “RxAppQosInfomration” service configuration and configure it as per the example shown below:
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11. Select the “RxGuaranteedBitrateOverride” service configuration and configure it as per the example shown below:

12. Click on Services and create a child service, e.g. “volte_service”.

13. Update the Code and Name as “volte_service”.

14. Click Add and select the Service Option “volte” created earlier.

Dynamic Rule Naming (Multiple Dedicated Bearer QoS)
CPS supports multiple dedicated QoS Bearers (video and audio) within a subscriber's IP-CAN session, includes splitting 
up Gx based RAR messages to provides quality video calls.

When a AAR message is received through the Rx interface with Media-Component-Description, a Gx RAR request is 
sent with the new dynamic PCC rules for initiating new dedicated bearers. Since CPS generates these rules dynamically 
it automatically generates the rule-name using the following syntax:

_<Rx-Linked-Session-Number>_<Media-Component-Number>_<Media-Sub-Component:Flow-Number>_<Rule-Name>_<Med
ia-Type>

The items in this name are:

 Rx-Linked-Session-Number: An internal number that identifies an Rx-session bound to a Gx-session.

 Media-Component-Number: Corresponding AVP value as received in Media-Component-Description Grouped AVP 
for an AAR message. 

 Media-Sub-Component:Flow-Number: Corresponding AVP value as received in 
Media-Component-Description->Media-Sub-Component Grouped AVP for an AAR message.

 Rule-Name: A partial name configured in Policy Builder (as derived using AF-Application-Identifier and Media-Type 
values from 'Custom dynamic rule name' table in Gx Client. Default value “AF”).

e.g. “_1_1_1_SIP_AUDIO”, “_2_3_1_SIP_VIDEO”, etc.
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(Refer to Gx Clients, page 78 for more information on configuring the table in Gx client).

QoS Selection
QoS on dynamic rule (dedicated bearer) created for rx session is derived based upon the algorithm mentioned in section 
6.3 of 3GPP 29.213 specification. This algorithm specifies how QoS Class (QCI), Maximum Authorized Data Rates (MBR), 
Authorized Guaranteed Data Rates (GBR) and Allocation Retention Policy (ARP) are derived based on the media details 
(Media-Component-Description) send by the AF (IMS).

Table 4 QoS Selection Parameters

Phrase mentioned in Algorithm Policy Builder section to refer

“as defined by operator specific algorithm” “RxQosInformation” and “RxAppQosInformation” service 
configuration.

“AF-Application-Identifier AVP demands application 
specific data rate”

“Application Qos Policy” defined in Rx Profile

“Codec-Data AVP provides Codec information for a 
codec that is  supported by a specific algorithm”

“Codec Qos Policy” defined in Rx Profile
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(Refer to Rx Profile, page 103 for more information on configuration of Rx Profile).

Dynamic QoS
This section covers the following topics:

 Programmatic CRD (QoS Action), page 279

 Logical Operator Support in Programmatic CRD tables for RxSTGConfiguration, page 285

 Support of Charging Parameters for Dynamic Rules using CRD Tables, page 288

 Charging Parameters for Sponsored Data, page 293

Programmatic CRD (QoS Action)
CPS supports the management of Dedicated Bearer QoS attribute values for Rx IMS application sessions by applying 
actions QoS-Bounding, QoS-Mirroring and QoS-Enforced on Dedicated Bearer QoS calculated as per specification 
29.213. 

After applying the a combination of bound, mirror and enforce on the QoS parameters for each flow of Dynamic PCC rule 
these dedicated bearer are sent in RAR message over Gx interface to PCEF/PGW. CPS supports the derivation of 
Dedicated Bearer QoS for Rx IMS application sessions by iterating over the parameters of 
Media-Component-Description and Media-Sub-Component AVPs found in AAR message after QoS is dynamically 
calculated as per 29.213. 

CPS will set the QoS attributes values on the dedicated bearer based on the following QoS actions:
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 Enforce: This action for any QoS attribute will enforce the values from customer reference data (CRD) table.

 Mirror: This action will copy the QoS attributes values requested by the AF (received in the AAR message).

 Bound: This action will calculate the minimum value between the QoS defined in CRD table and AF requested values 
or values calculated as per QoS derivation algorithm (29.213).

The following table explains how CPS will derive dedicated bearer QoS-Information attributes based on:

 The value received in AAR message (AF requested QoS)

 Value derived from QoS derivation algorithm defined in 29.213

 QoS-Action (Mirror, Enforce, Bound) and their respective values configured in CRD table 

The pattern of the attributes in output column indicates from which input column the value is derived.

Qos-Action Mirror:

Qos-Action Enforce:

Qos-Action Bound:

 As per Bound definition we still select min value, but min value for QCI translates to max QCI value. 

Table 5 Qos-Action Mirror

Input Output

AAR QoS Derivation Algorithm CRD Value

MBR MBR MBR MBR

GBR GBR GBR

QCI QCI QCI

ARP ARP ARP

Table 6 Qos-Action Enforce

Input Output

AAR QoS Derivation Algorithm CRD Value

MBR MBR MBR MBR

GBR GBR GBR

QCI QCI QCI

ARP ARP ARP

Table 7 Qos-Action Bound

Input Output

AAR QoS Derivation Algorithm CRD Value

MBR MBR MBR min(MBR, MBR)

GBR GBR min(GBR, GBR)

QCI QCI min (QCI, QCI)

ARP ARP min(PL, PL) and PV, PC based on chosen ARP
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In order to apply the various QoS actions Enforce, Mirror and Bounding CPS needs to provide a new Rx service 
configuration object which can be applied to subscriber. CPS also supports customer reference data (CRD) tables where 
for a combination of subscriber and session attributes can be used as an input to derive the output values. These lookup 
can be performed by using the Input attributes and values as a key and derive a result set of Output attribute and value 
which can be used to calculate various applicable QoS parameters.

Note: The Rx service configuration object introduced is only used for Rx input attributes and other attributes can be 
directly bound in CRD table definition. So any Gx or SPR attributes (inputs) can be directly bound in CRD table definition. 

Policy Builder Configuration
Policy builder configuration for this feature requires configuring a CRD table in reference data section and 
'RxSTGConfiguration' service configuration object in use case template.

RxSTGConfiguration Service Configuration

Note: The values of “AVP name” must be exact same as per specifications (e.g. Media-Component-Number, 
Flow-Number, etc.) while defining input columns to RxSTGConfiguration.

Output columns can be defined for one or more of the QoS attributes. When a QoS attribute is added to output, it requires 
defining two column entries, one for QoS action and one for QoS value. The QoS value AVP name needs to be defined 
as per standard (3gpp TS 29.214) QoS attribute AVP name. whereas, QoS action AVP name needs to be as mentioned 
below (for the corresponding QoS attribute): 

 Qci 

 Max Req Bandwidth U L 

 Max Req Bandwidth D L 

 Guaranteed Bit Rate U L 

 Guaranteed Bit Rate D L 

Table 8 RxSTGConfiguration service configuration Parameters

Parameter Description

Stg Name Reference to the Search table group containing the CRD tables that defines the QoS 
Action for Rx specific dynamic rules (dedicated bearer).

List of Input Columns (List of 
ColumnAndAvpPair)

Define the mapping between the 'AVP Names' and the key 'Columns' defined in the 
selected STG. These AVPs will be the inputs while evaluating the CRD table in STG. 

Avp Name Name of the diameter AVP (received in Media Component Description AVP of the 
AAR message) which is to be used as input for CRD table evaluation. (e.g. 
“Flow-Number”, “Media-Component-Number”, etc).

Column Reference to the key column defined in the STG selected.

List of Output Columns (List of 
ColumnAndAvpPair)

Define the mapping between the AVP Names and the output columns defined in the 
STG selected. These mapping indicate how the output column's values are mapped 
to AVPs after the CRD is evaluated.

Avp Name Name of the diameter AVP (attribute from Qos-Information) to which the value of the 
output column should be mapped to while setting the Qos-Information for the 
dedicated bearer on Gx. (e.g. “Qos-Class-Identifier”)

Similarly for Qos-Actions on the attribute the AVP Name specifies the qos-action for 
a specific Qos-Information attribute (e.g. “Qci”). Refer the note below.

Column Reference to the output column defined in the STG selected.
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 Priority Level 

 Preemption Capability 

 Preemption Vulnerability

Similarly, when mapping the output columns for CRD values of Qos-Information attribute use the exact QoS attribute 
name (e.g. “Qos-Class-Identifier”, “Max-Requested-Bandwidth-UL”, etc.)

The following are the steps to configure the CRD table for defining the Qos-Action details and Service options details 
(RxSTGConfiguration) for setting up the service:

1. Open the Policy builder GUI.

2. Select the Reference Data tab. 

3. Click Customer Reference Data Tables and create a CRD table under Search Table Group as shown in example 
below. For more information on how to configure Search Table Groups, refer to Services, page 161.

Example

Below example shows three key columns for the CRD table. 'Media-Component-Number' and 'Flow-Number' 
columns will be mapped to the respective AVPs by setting the respective AVP Names in service-option configuration 
(Step 9. on page 283). Whereas the additional 'RAT-Type' key column is bound to the Gx session attribute.
282



  
Rx Services

Dynamic QoS
4. Go to Services tab.

5. Under Use Case Templates, click Summary and then create a child Use Case Template.

6. Add a Name to the template, e.g. Rx_CRD_QoS.

7. Click the Add in the Service Configuration pane and add RxSTGConfiguration service configurations listed under 
'rx' section. 

8. Go to Services Options, the newly created template (Step 6. on page 283) would be available here.

9. Create a child Service Option e.g. qos_enhancement.

10. Click OK.The newly created service options should have the Service Configuration objects which were added 
previously at the template level.

11. Select the RxSTGConfiguration service configuration and configure it as per the example shown below:

Refer to the example configuration below that shows 'Media-Component-Number' and 'Flow-Number' Columns in CRD 
are bound to respective AVP names (received in 'Media-Component-Description' AVP received in AAR message). For 
output column pairs the sample configuration shows 'Qci' and 'Max Req Bandwidth U L' being mapped to the respective 
columns in CRD for QoS actions and 'Qos-Class-Identifier' and 'Max-Requested-Bandwidth-UL' columns are mapped 
to the respective AVPs for CRD values. 
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Note: To add multiple input columns select 'List of Input Column AVP Pairs (List)' row and click 'Add Child' button to 
create a new ColumnAndAvpPair row for adding an input column details. Follow same steps to add output columns in 
'List of Output Column Avp Pairs'.

12. Click on Services and create a child service, e.g. rx_qos_action.

13. Update the Code and Name as rx_qos_action.

14. Click Add and select the Service Option 'qos_enhancement' created earlier (Step 9. on page 283).

Control Center Configuration

Setting up the CRD table in the STG
1. Login to the Control Center to define the values for the parameters defined in Customer Reference Data tables. 

2. Select the Configuration tab. 
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3. Under Reference Data, click Customer Reference Data Table name to open a dialog-box. Select a row and edit the 
values according to your requirements. An example is shown below:

Note: Since Qos Action columns have fixed values (“Mirror”, “Bound”, “Enforce”) user can define these values in 'Valid 
Values' section while defining the column for CRD table.

Logical Operator Support in Programmatic CRD tables for 
RxSTGConfiguration

CPS users can now configure the CRD table to check if the requested value is present within the range of values present 
in the CRD tables and fetch the matching records. CRD tables now support Maximum and Minimum columns for each 
AVP. 

For example, operator now can configure the CRD table for QoS derivation based on the range of the 
“Max-Requested-Bandwidth-UL” AVP value (received in AAR message). For this operator, create two columns (e.g. 
MBR_UL_Max and MBR_UL_Min) and bind them to the same attribute/AVP. CPS then uses the min and max to check the 
range.

Note: This functionality is currently available for RxSTGConfiguration only.

Policy Builder Configuration
Policy Builder configuration for defining ranged columns in RxSTGConfiguration:

1. Refer to the steps mentioned in Programmatic CRD (QoS Action), page 279 for creating the CRD table and 
configuring the RxSTGConfiguration. 

2. For the input attribute whose range is to be checked create two columns for Maximum and Minimum value. 

This example creates a CRD table that supports deriving Qci value based on the range of 
“Max-Requested-Bandwidth-UL” value received in AAR message. 
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MBR_UL_MAX Column (represents maximum value of MBR_UL in CRD table).

MBR_UL_MIN (represents minimum value of MBR_UL in CRD table).

Make sure that Matching Operator is selected properly i.e for Maximum value column need to select 'gt' or 'gte' and for 
Minimum value column select 'lt' or 'lte' and QCI column is a result column need to specify that at result column section 
of STG table.
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3. In RxSTGconfiguration, map the corresponding input columns defined above with the same AVP name 
(Max-Requested-Bandwidth-UL) as shown below:

4. Set Control Center table values as follows:

So with the above configuration, If CPS receives an Rx-AAR message with “Max-Requested-Bandwidth-UL” AVP having 
value as “4000” then the dynamic rule generated will have Qci value as '6' based on following evaluation:

 2000 (MBR Min CRD value) < 4000 (Requested value) 

 8000 (MBR Max CRD value) > 4000 (Requested value)

Fetch the record and give the Result Column value (QCI as 6).
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5. Use the same AVP name in the List of Input AVP columns in the service configuration. For example:

Support of Charging Parameters for Dynamic Rules using CRD Tables
CPS supports configurations for setting up the charging parameters on the dedicated bearer created for IMS application 
sessions (Rx sessions). The charging parameters (like Rating-Group, Service-Identifier, Metering-Method, etc.) can be 
derived based on certain parameters in the Media-Component-Description AVP received in AAR message (e.g. 
AF-Application-Identifier, Flow-Status, etc) or any session or SPR attributes. CPS supports configuration of static tables 
as well as CRD tables to define the criteria for selecting the desired charging parameters on the dynamic PCC rule 
(dedicated bearer).

CPS will first evaluate the CRD table defined in 'RxChargingParameterSTGConfig' service configuration and if no 
parameters are derived then CPS will look into the static table defined in 'Dynamic Rule charging parameters' section 
under Rx-Profile. (Refer to Diameter Configuration, page 55 for more information).

CPS also supports a separate configuration for deriving the charging parameters when dedicated bearer is created for 
sponsored data. CPS will first evaluate the CRD table defined in 'RxSponsoredDataChargingParam' service configuration 
and if no parameters are derived then CPS will look into the static table defined in 'Sponsored Data Charging Parameter' 
section under Rx-Profile.

Policy Builder Configuration:
Use 'RxChargingParameterSTGConfig' service configuration for setting the charging parameters for dedicated bearers 
created for IMS session (non-sponsored data case)
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RxChargingParameterSTGConfig service configuration:

Note: The values of “AVP name” must be same as per specifications (e.g. Media-Component-Number, Flow-Number, 
etc.) while defining input columns to RxChargingParameterSTGConfig.

Whereas, for output column AVP Pairs in RxChargingParameterSTGConfig while defining the charging parameter 
attribute use the exact AVP name for charging parameters in Charging-Rule-Definition as per specification. (e.g. 
Rating-Group, Service-Identifier, etc.)

The following are the steps to configure the STG for defining the charging parameters details and Service options details 
(RxChargingParameterSTGConfig) for setting up the service:

1. Open the Policy builder GUI.

2. Select the Reference Data tab. 

3. Click Customer Reference Data Tables and create a CRD table under Search Table Group as shown in example 
below. For more information on how to configure Search Table Groups, refer to Services, page 161.

Example

Table 9 RxChargingParameterSTGConfig Service Parameters

Parameter Description

ChargingParameterStg Name Reference to the Search table group containing the CRD tables that defines the 
Qos Action.

List of Input Columns (List of 
ColumnAndAvpPair)

Define the mapping between the 'AVP Names' and the key 'Columns' defined in 
the selected STG. These AVPs will be the inputs while evaluating the CRD table in 
STG. 

Avp Name Name of the diameter AVP (received in Media Component Description AVP of the 
AAR message) which is to be used as input for CRD table evaluation. (e.g. 
Flow-Number).

Column Reference to the key column defined in the STG selected.

List of Output Columns (List of 
ColumnAndAvpPair)

Define the mapping between the AVP Names and the output columns defined in 
the STG selected. These mapping indicate how the output column's values are 
mapped to AVPs after the CRD is evaluated.

Avp Name Name of the diameter AVP (available under Charging-Rule-Definition) to which 
the value of the output column should be mapped to while setting the charging 
parameters on the dynamic rule (for the dedicated bearer) on Gx. (e.g. 
Rating-Group, Service-Identifier, etc.)

Column Reference to the output column defined in the STG selected.
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Below example shows three key columns for the CRD. 'Media-Type' and 'Flow-Status' column will be mapped to 
the respective AVPs from AAR message (by setting the corresponding AVP Names in service-option configuration 
in Step 9. on page 291). And an additional 'RAT_Type' key column is used which is bound to the Gx session attribute.

4. Go to Services tab.
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5. Under Use Case Templates, click Summary and then create a child Use Case Template.

6. Add a Name to the template, e.g. Rx_Doc.

7. Click Add in the Service Configuration pane and add RxChargingParameterSTGConfig service configurations listed 
under 'rx' section. 

8. Go to Services Options, the newly created template (Step 6. on page 291) would be available here.

9. Create a child Service Option e.g. “rx_charging”.

10. Click OK. The newly created service options should have the Service Configuration objects which were added 
previously at the template level. 

11. Select the RxChargingParameterSTGConfig service configuration and configure it as per the example shown 
below:

The sample configuration below that shows 'Media-Type' and 'Flow-Status' Columns in CRD are bind to respective 
AVP names (received in Media-Component-Description AVP received in AAR message). For output column pairs the 
sample configuration shows 'Rating-Group', 'Service-Identifier', 'Reporting-Level', etc. columns are mapped to the 
respective AVPs 

Note: To add multiple input columns select 'List of Input Column AVP Pairs (List)' row and click 'Add Child' button to 
create a new ColumnAndAvpPair row for adding an input column details. Follow same steps to add output columns 
in 'List of Output Column Avp Pairs'.
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12. Click on Services and create a child service, e.g. <>

13. Update the Code and Name as <>

14. Click Add and select the Service Option <> created earlier.

Control Center Configuration 

Setting up the CRD Table in the STG
1. Login to the Control Center to define the values for the parameters defined in Customer Reference Data tables. 

2. Select the Configuration tab. 

3. Under Reference Data, click Customer Reference Data Table name to open a dialog-box. Select a row and edit 
the values according to your requirements. An example is shown below:
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Note: In the above example few columns will have fixed values (eg. value for Flow-Status column will be 
“ENABLED-UPLINK (0)”, “ENABLED-DOWNLINK (1)”, “ENABLED (2)”, etc.) So, user can define these values in 'Valid 
Values' section while defining the column for CRD table.

Charging Parameters for Sponsored Data
As explained in the previous section CPS supports defining CRD tables to set the charging parameters on dynamic rules 
(dedicated bearer) created for IMS session. User can define various inputs to the CRD table to define different evaluation 
criteria.

In case the dedicated bearer is created for a sponsored data access CPS supports a different service configuration and 
CRD tables to define the evaluation criteria for selecting charging parameters on dynamic rules. 
RxSponsoredDataChargingParam is the service configuration defined in CPS to configure the CRD details for setting 
charging parameters on dedicated bearer created for sponsored data. This service configuration supports defining 
'Sponsor-Identity' (provided in 'Sponsored-Connectivity-Data') as one of the input column in the CRD table created for 
charging parameters of sponsored-data.

CPS will first evaluate the CRD table defined in 'RxSponsoredDataChargingParam service configuration and if no 
parameters are derived then CPS will look into the static table defined in 'Sponsored Data charging parameters' section 
under Rx-Profile. (Refer to Diameter Configuration, page 55 for more information).

Policy Builder Configuration
Refer to the policy-builder configuration in above section (Logical Operator Support in Programmatic CRD tables for 
RxSTGConfiguration, page 285). Create an extra key column for 'Sponsor-Identity' in the CRD table. Correspondingly, in 
the service configuration add an extra input AVP mapping for 'Sponsor-Identity' AVP and its CRD column.

SRVCC
Single Radio Voice Call Continuity (SRVCC) solution seamlessly maintains voice calls as mobile users move from LTE to 
non-LTE coverage areas. This solution transfers VoLTE calls in progress from LTE to legacy voice networks. Without 
SRVCC, a VoLTE call on a device moving out of LTE coverage will be dropped. 

To support SRVCC solution, CPS support notifying the AF (IMS System) when dynamic rules (created for Rx) on Gx fails 
because of handover from packet switched (PS) to Circuit Switched (CS).

NPLI (Access Network)
Cisco Policy Suite (CPS) provides Access Network Information (Network Provided Location Information) (for example, 
User Location, User Timezone information and so on) Reporting over Gx and Rx Interfaces.

In this feature, CPS supports ACCESS_NETWORK_INFO_REPORT Event-Trigger and specific-action on Gx and Rx 
interface respectively to provide the necessary Access Network Information. 

When AF requests the PCRF for access network information, the PCRF (CPS) subscribes the requested Access Network 
Information from the PCEF within the Required-Access-Info AVP, which is included in the Charging-Rule-Definition AVP. 
When the Access Network Information is available, the PCEF provides the required Access Network Information to the 
PCRF within the 3GPP-User-Location-Info AVP or 3GPP-MS-TimeZone AVP or both, as requested by the PCRF. 

If CPS receives STR with 'Required-Access-Info' AVP then the same will be send in 'Charging-Rule-Remove'. Only in 
this case STA message will be held till CPS receives CCR-U with access-network-info AVPs (location/timezone).

Note: PCEF, PCRF and the AF should be compliant with the NetLOC supported feature. 
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CPS will report NetLoc-Access-Support (0) AVP in AAA and STA message when it gets Required-Access-Info AVP but 
PCEF does not support NetLoc feature. CPS will report 
INDICATION_OF_ACCESS_NETWORK_INFO_REPORTING_FAILURE SpecificAction in RAR message when gateway 
reports NetLoc-Access-Support (0) in CCR-U.

The PCEF provides the following information during an ACCESS_NETWORK_INFO_REPORT event trigger within the 
Event-Trigger AVP: 

 3GPP-User-Location-Info AVP (If available), 

 User-Location-Info-Time AVP (If available), 

 3GPP-SGSN-MCC-MNC AVP (If the location information is not available) or 3GPP-MS-TimeZone AVP or both.

Note: As the Gx Event-Trigger use in this feature is specific to 3GPP R11 specification. Make sure the CPS is not 
configured to use V9 Event-Triggers.

Refer to Diameter Configuration, page 55 for more information on configuring the above show parameters.

Dynamic PCC (MOG)
Dynamic PCC allows a user (subscriber) that is currently under rate limits to dynamic modify their default bearer 
characteristic to support higher bit rates in run time. This is an opt-in service and allows the user to request and update 
(boost/throttle) in QoS on demand.

To support this functionality CPS can boost/throttle the QoS values on Default Bearer based on a trigger from the AF/CSB 
(Cisco Service Bus) on the Rx prime interface. CSB shall initiate an Rx session with CPS as an AF and establish an Rx 
session by sending an AAR.

CPS shall parse the AAR to look for a custom AVP which is “Dynamic-PCC-request-QoS” that has the QoS values and 
additionally Priority and Intent values as well. 

It is possible that there are multiple Rx (IMS) Sessions for a single Gx session and each Rx session may influence the 
QoS values by sending the above mentioned custom AVP. CPS shall take into consideration the 'Priority', 'Intent', 'CSB/AF 
requested QoS' and 'calculated QoS' for deriving the values for modified default bearer QoS.
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Policy Builder Configuration
No Service configuration is required for this feature. 

But, when there are multiple Rx sessions with dynamic PCC requests having same priority then CPS by default will select 
the QoS values from the BOOST request. CPS provides a configuration flag in 'Gx Client' for overriding the default 
behavior of 'BOOST' with 'THROTTLE'. So,

 if the check box is checked then throttle request takes precedence over boost request

 else if its un-checked then throttle takes precedence over boost

Refer to Diameter Configuration, page 55 for more information.

VoLTE Emergency Calls
The AF may include the Service-URN AVP in order to indicate that the new AF session relates to emergency traffic. If the 
CPS receives the Service-URN AVP indicating an emergency session, then CPS can prioritizing service flows relating to 
the new AF session.

Refer to Diameter Configuration, page 55 document for more information on configuring VoLTE emergency details in Rx 
Client.

Sponsored Data
CPS supports 'Sponsored Connectivity Data' over Rx interface (IMS session). Sponsored data connectivity is supported 
by CPS based on service data flows associated with one or more PCC rules if the information about the sponsor, the 
application service provider and optionally the threshold values are provided by the AF. When CPS receives the flow 
based usage thresholds from the AF then it uses the sponsor identity to generate a monitoring key. 

Operator can override the Monitoring-Key generated by CPS by specifying the desired monitoring-keys in 'Sponsored 
Profile' table under Gx Client in 'Reference Data' section. Key to this table are the 'Sponsored-Id' and 
'Application-Service-Provider-Identifier' AVP values received from the AF.
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An example configuration is given below:

CPS also supports suppressing the 'Sponsor-Identity' AVP from PCC rules generated for Sponsored Data. This 
configuration is required when the PCEF does not support 'Sponsor-Identity' AVP. In this case if CPS requests a PCEF to 
create a dedicated bearer with Sponsor-Identity then the PCEF may reject the request because it does not support the 
Sponsor-Identity AVP. So by selecting the check box shown below CPS can exclude the Sponsor-Identity AVP from the 
PCC rule definition. (By default, the value is unchecked).

Refer to Gx Clients, page 78 for more information on configuring Gx Client.
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Multi-Media Priority Services
Cisco Policy Suite provides Enhanced Multi-Media Priority Services (eMPS) for priority subscribers. CPS also prioritizes 
VoLTE/IMS calls for priority subscribers. CPS provides the ability to determine priority subscribers and provide priority 
services. There are two types of MPS: 

 Always-on: For a user with always-on MPS subscription, priority treatment is provided for all PS sessions. 

 On-demand: On-demand MPS is applied when priority treatment is explicitly requested by user with specific access 
code (MPS-Identifier).

This feature is configured through:

 Always On

— Gx Service Configuration, page 297

— Reference Data for Always-on MPS Priority, page 298

 On Demand

— On-demand MPS-Identifier, page 300

— Obtaining Highest Priority Qci using Max Function, page 300

Gx Service Configuration

EMPS Service Configuration
CPS provides a service configuration ('EMPS' under 'gx' service configuration) for defining the MPS EPS Priority, MPS 
Priority Level and IMS Signaling Priority level. This is required for Always on MPS. 

When a user configured with MPS subscription initiates a session, the priority level from the subscription data, QCI, 
Preemption Capability, and Preemption Vulnerability from MPS profile are used to set default bearer QoS. Also all 
preconfigured dynamic rules are updated to use the new priority level.

When the session is initiated from IMS APN, the IMS Signaling Priority is used as priority level if configured under 
subscription data.

The following are the steps to configure this service configuration:

1. Login to Policy Builder GUI.

2. Go to Services tab.

3. Under Use Case Templates, click Summary and then create a child Use Case Template.

Table 10 EMPS

Parameter Description

Mps Eps Priority Enabled Field to invoke Priority EPS Service. 

 1: enable

 0: disable

Mps Priority Level Indicates the priority level (Integer, range 1-15).

IMS Signaling Priority IMS signaling priority level (Integer, range 1-15).
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4. Add a Name to the template, e.g. Rx_Doc.

5. Click Add in the Service Configuration pane and add EMPS service configurations listed under 'gx' section. 

6. Go to Services Options, the newly created template (Step 4. on page 298) would be available here.

7. Create a child Service Option e.g. eMPS.

8. Click OK. The newly created service options should have the Service Configuration objects which were added 
previously at the template level.

9. Select the EMPS service configuration and configure it as per the example shown below.

Reference Data for Always-on MPS Priority
In the Policy Builder's Reference Data, a new profile Mps Profiles is added under Diameter Defaults to support eMPS 
priority. The MPS Profile provides MPS attributes required for priority service provisioning. The priority level value from 
Service configuration takes precedence over MPS Profile value. 

1. Select Reference Data tab > Diameter Defaults > Mps Profiles. 

2. In the summary window, click Mps Profile to create an Mps Profile. 

3. To add an Ims Apn, click Add, enter the Ims Apn in the field provided and click OK. 

This field can accommodate several Ims Apn that are used to match with the incoming service request for priority 
service. The values that are received by the Default Bearer QoS are looked up for a suitable Ims Apn match. If the 
APN value of a Gx session request matches IMS APN, IMS signaling priority from EMPS service is used as priority 
level. 
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4. Assign values for Always-on MPS attributes in the MPS QoS section. An example is given below.

 For information on the parameters mentioned above, refer to MPS Profile, page 101.

On receiving a request, the Ims Apn is checked up for a match, if there is suitable match then the values assigned in the 
Mps Qos section CPS selects the IMS signaling priority from EMPS service.
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On-demand MPS-Identifier 
The section, Reference Data > Diameter Defaults > Rx Profiles has a new table to support Rx initiated sessions. When 
an Rx session is initiated with an MPS-Identifier, the incoming message is mapped with input parameters such as MPS 
Id and Media Type, and the session is processed further. MPS QoS Policy table is the newly added table to the Rx Profiles 
in the Policy Builder. An example is given below.

The incoming message is mapped with the input parameters which are MPS Id and Media Type, if the parameters match 
the corresponding value from the other columns - Priority Level, Preemption Capability, Preemption Vulnerability and Qci, 
are provided to provide the necessary service. For more information, refer to Rx Profile, page 103.

Obtaining Highest Priority Qci using Max Function 
When an EPS subscription for a subscriber is configured to be always-on, and an Rx session is initiated with MPS-ID, 
the higher priority level and higher QCI is derived and applied to the default EPS. ARP of the Rx dynamic rule is derived 
from Reservation priority if present in the AAR, otherwise defaulted to the value in configuration. 

The Max function uses the following precedence order to derive the QCI values:

2 > 1 > 4 > 3 > 5 > 6 > 7 > 8 > 9

For additional information refer to 3GPP spec 29.213 (R11). 

When there are multiple Rx sessions, the default bearer and default EPS bearer QoS is updated with the highest value of 
QCI, ARP. 

 The highest value is derived from the Rx sessions and Default Bearer if subscribed to always-on MPS.

 The highest value is derived from the Rx session if not subscribed to always-on MPS. 

Rx session termination: When a Rx session terminates, and if it is the last Rx session to terminate, the default bearer and 
default EPS bearer QCI/ARP is reverted to:

 Single Rx session with MPS: revert Default Bearer to normal or always-on Qci or ARP.

 Multiple Rx sessions with different MPS: revert default bearer to highest Qci or ARP among the remaining Rx 
sessions. 

There are two main scenarios that take place during an Rx Session: 
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 On Demand without Always-on Configuration 

 On Demand with Always-on Configuration 

On Demand without Always-on Configuration

Default Bearer 
 When multiple Rx sessions are initiated with MPS-ID, the highest priority level and highest QCI is derived and applied 

to the default EPS.

 If reservation priority is not present in AAR, the priority configured for the particular MPS-ID is used. In the Rx profile 
> MPS Qos Policy table, a blank value is defined in the Media Type column, which applies to the Default Bearer. If 
the configuration is missing, default reservation priority (0) is used. 

The new Priority Level and Qci are applied to the Default Bearer QoS and also to the Gx pre-configured rules. 

Dedicated Bearer 
Priority Level of the Rx dynamic rule is derived from Reservation priority if present in the AAR from the media component 
description; otherwise the default value in the configuration is used. QCI of Rx dynamic rule is derived from the Rx profile 
configuration. Preemption Capability and Preemption Vulnerability are determined from Rx profile for each MPS-Id.

On Demand with Always-on Configuration 

Default Bearer 
When an Rx session request is received with an MPS-ID along with message level (AAR) reservation-priority: 

 The ARP priority level is derived from the highest value between reservation priority and always-on priority (or IMS 
priority if applicable).

 The value of QCI is derived from the highest value between MPS-ID specific Qci and always-on Qci. When multiple 
Rx sessions are created with MPS-ID and message level (AAR) reservation priority, 

 The ARP Priority Level is derived from highest value between session level reservation-priority (among active 
sessions) and always-on priority (or IMS priority if applicable).

 The value of Qci is derived from the highest value between MPS-ID specific Qci and always-on Qci. 

In both cases, if reservation priority is not present in the AAR, the priority configured for each MPS-Id is used. In the Rx 
profile > MPS Qos Policy table, a blank value is defined for the Media Type column, which applies to the Default Bearer. 
If the configuration is missing, default reservation priority (0) is used. 

The new Priority Level and Qci is applied to the Default Bearer QoS and also to the Gx pre-configured rules. 

Dedicated Bearer 
Priority Level of the Rx dynamic rules is derived from the highest value between always-on MPS and the reservation 
priority, if the reservation priority is defined in the AAR Media component description. 

If the reservation priority is not present in Media-Component-Description, the value of reservation priority is derived from 
the highest value between always-on MPS and from the Rx Profile configuration (based on MPS-ID and Media Type). 

Preemption Capability and Preemption Vulnerability are determined from Rx profile for each MPS-Id and Media Type. 
QCI value is derived from the higher value between MPS profile and Rx MPS profile (based on Media Type and MPS-ID).
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Account Balance Templates
Account Balance templates provide the overall structure to the data provisioned to a given subscriber. 

The following parameters can be configured under Account Balance Template:

Table 1 Account Balance Template Parameters

Parameters Description

Code Required unique name for the template.

Description Optional field to contain a brief description of the template's use case.

Units The choice of units determines functionality options within the system. For example, Time 
units such as seconds or minutes will cause the system to behave differently than Data units 
like Bytes or Megabytes. Additionally, currency is an option and can be used to account for 
usage credit in a direct manner.

Note: Balance does not do any type of currency exchange rate calculation. The values are 
stored as is and represent whatever currency the SP and their subscribers commonly use.

Default value is Bytes.
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Quota Templates
Quota templates define the specifics of how quota behaves. There are 3 basic types of quota: One Time, Recurring, and 
Rollover. Within that there are additional behavioral functions like BillCycle and Stackable, but those are just modifications 
to one of the three basic types.

This section covers the following topics:

 Recurring, page 306

 Rollover, page 308

 One Time, page 311

 BillCycle, page 314

 Thresholds, page 315

 Depletion and Exhaustion, page 318

 Charging Expired Reservations, page 318

 Credit Selection Logic for Reservations and Debits, page 318

Limiting Balance Limiting Balance refers to a Balance template that is used by a shared balance template. This 
establishes a link from the shared balance to a “limit” balance, so that Balance Manager 
knows which two balance codes it needs to reserve/charge against in the shared per user 
limit use case.

Note: The limiting MsBM account must be the MsBM account tied to the individual 
subscriber's credential. The limiting MsBM balance and quota must be provisioned in 
separate Balance/MsBM operation from the provisioning of the shared account, balance, 
and quota.

Error on Provision With 
Non Zero Balance

If a provisioning request is made (specifically any request that credits or provisions a 
subscriber balance) when there is remaining balance, i.e. non-zero amount, then the 
Balance module throws an error and does not provision the quota. 

Default value is False (unchecked). 

Thresholds

Code Unique name for the threshold object.

Amount An integer representing the amount of quota that will trigger the threshold notification.

Type Unit of calculation like Percentage or Bytes.

Group Thresholds can be associated with each other as a group. When thresholds are grouped by 
name, only messages for the first (top to bottom in the table in Policy Builder) threshold 
breached in the given threshold group will be returned. 

Trigger on Remaining This inverts the threshold function. Typically a threshold is calculated against the usage. For 
example, if a threshold is defined for 80%, by default that means 80% of quota used or 20% 
remaining. If the Trigger on Remaining check box is selected, then the function inverts and 
a threshold defined as 80% would trigger when 80% of the quota remains. 

Table 1 Account Balance Template Parameters

Parameters Description
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Recurring
Recurring quota is refreshed periodically with a specific amount each refresh. It defaults to infinite duration meaning that 
it will continue until the account is deleted from the system. However, it is possible to limit the duration of a recurring 
quota using the Recurrence Limit field. The most common time period is Monthly. Time periods defined in hours, days, 
weeks, months are possible. Initial credit and refreshed amounts by default expire at the end of the current time period.

The following parameters can be configured under Recurring Quota Template:

Table 2 Recurring Quota Template Parameters

Parameters Description

Code Unique name that identifies the quota template.

Description Optional field to contain a brief description of the template's use case.

Amount A default provisioning amount which can be overridden at the initial provision time via API or 
Policy configuration.

Note: 

 The upper limit on the amount is 1 Exabyte. 

 Future amount changes can be accomplished with the Credit API. 
306



  
Balance Services

Quota Templates
Priority Priority ranks the template so when the Balance module is determining the next credit to use 
for reservations and debits, the template with the highest rank (Positive number Integer) 
wins. 1 is the highest rank. The default of no value is lowest priority. After priority, the most 
recent end date (Next to Expire) is used to determine the next credit.

Default value is null.

Recurrence Frequency 
Amount

Integer used in conjunction with the Recurrence Frequency to determine the refresh period.

Default value is1. 

Recurrence Frequency Value used in conjunction with the Recurrence Frequency Amount to determine the refresh 
period.

Default value is Months.

Rollover Quota A Rollover Quota Template that this recurring quota will rollover unused quota to when the 
quota refreshes for the next recurrence period.

Calendar Type MsBM supports both the Gregorian and Hijra calendar. The Hijri calendar is the Islamic 
calendar which is a moon-phase based calendar. Cisco has several customers in the Middle 
East who use the Hijri calendar instead of the Gregorian calendar to determine refresh dates.

Note: The data is still stored in the database as Gregorian dates, but the Balance module 
translates those to Hijri for any processing. SPR and the Unified API do not support Hijri 
dates.

Default value is Gregorian.

Recurrence Limit Integer that determines the duration for a recurring quota. When set to 0, the duration is 
infinite. When set to any positive number, the quota will refresh that number of times and 
then stop. For example, if the Recurrence Frequency is set to 1 Month, and the Recurrence 
Limit is set to 6, then the quota will refresh 6 times. If the quota is provisioned on January 
1st, it will expire on June 30th.

Default value is 0.

Auto Rollover When selected, automatically roll unexpired quota over into a Rollover quota when the 
refresh occurs.

Note: When not checked then rollovers can only be triggered by using the RolloverCredit 
API. 

Default value is False (unchecked).

Use Rollover Expiration 
Time for Charge 
Priority

When selected, the Balance module will use the sum of recurring quota template's credit 
end date and the rollover credit's end date to determine priority for which credit to debit in 
the normal processing of charges.

Default value is False (unchecked). 

Thresholds

Code Unique name for the threshold object.

Amount An integer representing the amount of quota that will trigger the threshold notification.

Table 2 Recurring Quota Template Parameters

Parameters Description
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Note: All the dates in Balance such as start, expiration, refresh, etc. have a time element. What is set for the time element 
will affect expiration and refresh time on the given day.

Refresh Dates
There are two important dates - Last Recurring Refresh (LRR) and Next Refresh. The LRR is used to calculate the Next 
Refresh. The LRR is the value stored in the database while the Next Refresh is the value that is calculated during 
processing and is returned in API responses.

The LRR is set to the provision date by default. For a monthly recurrence frequency that means, if provisioned on the 
12th, it will refresh again on the 12th of the next month. The LRR can be overridden in a provisioning request 
(CreateBalance API). When creating quota with the CreateBalance API, set the LRR date to the day when the refresh 
would have occurred had the quota existed. For example, if the CreateBalanceRequest is sent on 01/01/2012 at 
08:00:00 (January 1st, 2012) and the intention is to have the quota refresh on the 28th of the month, then the LRR 
(lastRecurringRefresh) should be set to 28/12/2011T00:00:00 (December 28, 2011) in the request. The Balance engine 
uses the LRR to calculate the Next Refresh date, so by setting the LRR to December 28th (the previous month in relation 
to the provision) the new refresh date of January 28th, 2012 will be calculated correctly. Note that months have a variable 
number of days and will refresh accordingly.

Note: Valid date formats for API requests are explained in the Unified API documentation. Contact your Cisco Technical 
Representative for the API documentation.

Manual LRR Override
When overriding the LRR via API, make sure that the start date and end date align properly. That is, the end date must 
be the same date as what the Next Refresh date would be (LRR + recurrence frequency) when calculated by the Balance 
engine. This means that the provisioned credit will end when the new credit is created via the refresh which is how the 
system operates by default.

The refresh occurs on the next Balance action instead of on the actual Next Refresh date so that not all subscriber 
accounts refresh at the exact same moment, thus balancing load and resources. However, it should be noted that the 
date of the new credit created by the refresh will still have its dates based on the stored LRR and not on when it is actually 
refreshed by the Balance engine. The new credit will have a start date equal to the new LRR after the refresh has 
occurred. The new credit end date will be the start date + recurrence frequency. This value is also the new Next Refresh 
Date.

Rollover
Rollover quota templates are special quotas that store leftover amounts from a Recurring quota. Rollover occurs when 
the Recurring quota refreshes. Rollovers can also be triggered manually via API. The amount to rollover can be limited, 
and the total amount in the rollover quota can be limited.

Type Unit of calculation like Percentage or Bytes.

Group Thresholds can be associated with each other as a group. When thresholds are grouped by 
name, only messages for the first (top to bottom in the table in Policy Builder) threshold 
breached in the given threshold group will be returned. 

Trigger on Remaining This inverts the threshold function. Typically a threshold is calculated against the usage. For 
example, if a threshold is defined for 80%, by default that means 80% of quota used or 20% 
remaining. If the Trigger on Remaining check box is selected, then the function inverts and 
a threshold defined as 80% would trigger when 80% of the quota remains. 

Table 2 Recurring Quota Template Parameters

Parameters Description
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Rollover quota templates behaves like One Time quota templates, but should not be provisioned directly. Unlike One Time 
quotas, Rollover quotas have no default/initial amount.

The following parameters can be configured under Rollover Quota Template:

Table 3 Rollover Quota Template Parameters

Parameters Description

Code Unique name that identifies the quota template.

Description Optional field to contain a brief description of the template's use case.

Amount A default provisioning amount which can be overridden at the initial provision time via API or 
Policy configuration.

Note: Future amount changes can be accomplished with the Credit API.
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Rollover Quota Example
Assumptions:

 Assume the parent Balance Template's units are Megabytes.

 Assume the Maximum Rollover Amount is 100 MB.

 Assume the Quota Maximum Amount is 2048 MB (or 2 GB).

 Assume the current balance of the rollover quota is 1.95 GB.

 Assume the unused usage at recurring quota refresh time is 200 MB.

 Assume the Auto Rollover checkbox is checked.

Function:
 The recurring quota has 200 MB, but only 100 MB is allowed to be rolled over because the Maximum Rollover 

Amount is set to that value.

 Rolling over 100 MB would cause the total amount of the rollover quota to exceed 2 GB (Quota Maximum Amount is 
set to 2048 MB).

Priority Priority ranks the template so when the Balance module is determining the next credit to use 
for reservations and debits, the template with the highest rank (Positive number Integer) 
wins. 1 is the highest rank. The default of no value is lowest priority. After priority, the most 
recent end date (Next to Expire) is used to determine the next credit.

Default value is null.

Validity Period Amount Integer used in conjunction with the Validity Period to determine the length of time for which 
the quota is valid. 

Default value is 30.

Validity Period Units Value used in conjunction with the Validity Period Amount to determine the length of time for 
which the quota is valid. 

Default value is Days.

Maximum Rollover 
Amount

The maximum amount of quota that can be rolled over at any one time.

Quota Maximum 
Amount

The total amount of rollover the quota can contain. 

Thresholds

Code Unique name for the threshold object.

Amount An integer representing the amount of quota that will trigger the threshold notification.

Type Unit of calculation like Percentage or Bytes.

Group Thresholds can be associated with each other as a group. When thresholds are grouped by 
name, only messages for the first (top to bottom in the table in Policy Builder) threshold 
breached in the given threshold group will be returned. 

Trigger on Remaining This inverts the threshold function. Typically a threshold is calculated against the usage. For 
example, if a threshold is defined for 80%, by default that means 80% of quota used or 20% 
remaining. If the Trigger on Remaining check box is selected, then the function inverts and 
a threshold defined as 80% would trigger when 80% of the quota remains. 

Table 3 Rollover Quota Template Parameters

Parameters Description
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 Therefore, 2 GB - 1.95 GB = 50 MB, which is the amount that is actually rolled over.

Limitations and Restrictions
Rollover Quotas may experience undesirable behavior when used in conjunction with Recurring Quotas that have a 
recurrence frequency of less than 1 day.

The recurring quota and rollover quota involved in the rollover operation must be defined under the same Balance 
template. Rolling over from one Balance template to another Balance template is not supported.

Note: Do not provision rollover quotas using the Control Center. Even though Rollover quota is a special type of One Time 
quota, they are not designed for manual provisioning. They are designed to work with a Recurring quota and receive 
credits only based on the unused amounts rolled over from that Recurring quota to which they are linked.

Adjustments can be made to Rollover quota via the Credit or Debit APIs, but this is not a typical or common use case, 
and is not recommended by Cisco. 

One Time
One Time quota templates are used for one time applications like TopUp or Bonus quota that has a finite duration (start 
and end date) and amount. One Time quota does not refresh automatically. 
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The following parameters can be configured under One Time Quota Template:

Stackable Quota or MsBM Multiple Prepaid Plans
The unique feature of Stackable Quota is that although a quota instance is provisioned it does not get used until the 
subscriber activates it via their network usage. Stackable quota does not expire if it is not used. For example, if a 
subscriber has an active plan and purchases a Stackable quota package. That package will never expire as long as the 
subscriber's current active plan stays active and has valid quota. Once the first plan expires, only then will the Stackable 
quota be activated and used.

Note: Once a credit on a stackable quota is active, any changes made to the template validity period will not have an 
effect.

Table 4 One Time Quota Template Parameters

Parameters Description

Code Unique name that identifies the quota template.

Description Optional field to contain a brief description of the template's use case.

Amount A default provisioning amount which can be overridden at the initial provision time via API or 
Policy configuration.

Note: Future amount changes can be accomplished with the Credit API.

Priority Priority ranks the template so when the Balance module is determining the next credit to use 
for reservations and debits, the template with the highest rank (Positive number Integer) 
wins. 1 is the highest rank. The default of no value is lowest priority. After priority, the most 
recent end date (Next to Expire) is used to determine the next credit.

Default value is null.

Validity Period Amount Integer used in conjunction with the Validity Period to determine the length of time for which 
the quota is valid. 

Default value is 30.

Validity Period Units Value used in conjunction with the Validity Period Amount to determine the length of time for 
which the quota is valid. 

Default value is Days.

Stackable When selected the One Time quota becomes “stackable” which is explained Stackable 
Quota or MsBM Multiple Prepaid Plans, page 312. The general idea is that it is possible to 
provision a Stackable Quota multiple times, but only one instance will be active at any given 
time. The other instances will “stack up” or queue behind the active one waiting to be used. 
Essentially, it's a different way to configure priority of credit usage. 

Default value is False (unchecked).

Thresholds

Code Unique name for the threshold object.

Amount An integer representing the amount of quota that will trigger the threshold notification.

Type Unit of calculation like Percentage or Bytes.

Group Thresholds can be associated with each other as a group. When thresholds are grouped by 
name, only messages for the first (top to bottom in the table in Policy Builder) threshold 
breached in the given threshold group will be returned. 

Trigger on Remaining This inverts the threshold function. Typically a threshold is calculated against the usage. For 
example, if a threshold is defined for 80%, by default that means 80% of quota used or 20% 
remaining. If the Trigger on Remaining check box is selected, then the function inverts and 
a threshold defined as 80% would trigger when 80% of the quota remains. 
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Priority
A Stackable quota will not activate until it is needed. This is most important in cases where Stackable and non-stackable 
quotas are mixed under the same Account Balance. For example, if a non-stackable quota is selected first based on 
Priority and the Next to Expire rules, the Stackable quota will not be activated until the non-stackable quota exhausts.

Pre-Paid Data Example
A subscriber purchases 5 pre-paid blocks of data quota with a default amount of 100MB and a validity period of 10 days. 
When the subscriber connects, the first instance becomes active, meaning the start date is set to the current date and 
time and the end date is set to 10 days later. So if the subscriber connected on January 1st, the quota became valid until 
January 11th (10 days from January 1st). After the subscriber uses all 100 MB or the 10 days passes, the next instance 
of quota is activated with the start/end dates set in the same manner - the start date is the current time at activation and 
the end date is set to 10 days from that time.

Pre-Paid Time Example
A subscriber purchases a time limit package that limits both "wall clock time duration" (calendar time since the package 
was bought) and volume of fair use quota. The package does not renew automatically, however the subscriber is able to 
purchase additional pre-paid plans prior to the expiration of the current package they have. Each pre-paid package will 
automatically start upon expiration of the previous plan just as in the data example. Like the data example, if the time 
limit is reached, the next package becomes active. If a subscriber reaches the volume of fair use quota limit, the current 
plan expires and the next plan becomes active regardless of the time remaining on the previous package. If there are no 
additional pre-paid plans available upon expiration of the current active package, the subscriber is redirected to a 
self-care portal and offered more options to purchase packages.

Provisioning
Provisioning a Stackable quota sets the start time to the current system time by default, and if a start date value is passed 
in, it is set to the passed in value. If the start date passed in is in the past and another Stackable quota is currently active, 
the new quota will not be used until the currently active Stackable quota is exhausted.

Debits and Reservations
As the accounting functions operate, reservations check for active credits. When a credit expires, the system 
automatically looks to find the next credit based on various criteria including the next most recent expiration date. If the 
found credit is part of a Stackable quota and is not currently active, the system will activate it by setting the start date to 
the current date and time and setting the end date to the start date plus the validity period.

If it is necessary to activate a second stackable quota to satisfy the requested reservation amount, even if you release 
the reservation (charge zero or less than what is remaining on the first quota), the system will maintain two active 
Stackable quotas.

If no quota is active for a subscriber, a Stackable quota will not get activated until a reservation is made.

QueryBalance API
The QueryBalance API displays all credits whether the Stackable quota is active or not. The API does not provide an 
indication of whether a quota is Stackable.

Template Definition Changes
If a quota template is changed from stackable to not stackable or from not stackable to stackable, any credits for quotas 
of that quota code provisioned/credited prior to this template change will behave in the following manner:

 From Stackable to Not Stackable: Any credits on quotas of that quota type that have already been 
provisioned/credited will have those existing credits behave as a normal one time quota's credits with no expiration 
date regardless of any set validity period. Future credits will have their end dates set by the validity period.
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 From Not Stackable to Stackable: Any credits on quotas of that quota type that have already been 
provisioned/credited will have those existing credits behave as a normal one time quota's credits with the start date 
of the provision date or the start date that was passed in if it was specified and the end date that was specified or 
if not specified the start date plus validity period at provision time. Any future credits will be treated as stackable 
credits on a stackable quota.

BillCycle
BillCycle quotas were introduced in Balance 2.3.0. BillCycle is a special type of Recurring quota that handles end of 
month refresh dates better than the typical Recurring quota template. The Bill Cycle functionality aligns better with some 
customers' billing cycles and removes the recommended limitation of only using days 1 - 28 for Recurring quota 
starts/ends.

Note: The “RFAmt ignored” hint that appears on BillCycle in Policy Builder is just a reminder that the Recurrence 
Frequency Amount field is ignored if you select a Recurrence Frequency of BillCycle. Refresh happens every 1 BillCycle 
regardless. The system cannot wait 2 or more BillCycles before refreshing.

Updating BillCycle
The ChangeBillCycle API is the only way to change the BillCycle value for a subscriber.

Repurposing Recurring Quota Templates
It is possible to use BillCycle by repurposing a currently existing Recurring quota that has a recurrence frequency other 
than BillCycle. When repurposing an existing Recurring quota template and changing it to BillCycle, existing subscribers 
will have the BillCycle value set automatically at the next refresh time to the day that the quota refreshes. For example, 
if a subscriber’s quota is scheduled to refresh on the 25th, he/she will continue to use quota until the refresh date as 
normal. When the quota refreshes on the 25th, the BillCycle value will be set to 25, and the subscriber’s quota will now 
follow the BillCycle frequency rules instead of the previous recurrence rules.

Note: Repurposing works best with Recurring quota templates that have a recurrence period of 1 Month.

Monthly vs. BillCycle
Monthly and BillCycle really only differ when BillCycle is set to 29, 30, or 31. Current subscribers won’t be able to take 
advantage of 29, 30, 31 if you reuse a quota code. However, using the ChangeBillCycle API existing subscribers can 
update their BillCycle setting to 29, 30, or 31.

Any new subscribers provisioned with a repurposed quota template will start out with BillCycle functionality and a 
BillCycle value must be passed in with the CreateBalance API.

End Date and Last Recurring Refresh (LRR)
End Date will be set to 23:59:59.999 in the server's local time zone on the day before the BillCycle day. For example, if 
the BillCycle value is 15, with the server set to GMT (Zulu time), then the end date in March would be 
2013-03-14T23:59:59.999Z.

The Last Recurring Refresh (LRR), which drives the Next Refresh date that appears in API responses and drives the actual 
quota refresh trigger, will be midnight on the BillCycle day in the previous month. For example, if the BillCycle value is 
15, with the server set to GMT (Zulu time), then the LRR in the credit period before March 15th will be 
2013-02-15T00:00:00.000Z, which would display a Next Refresh date in a QueryBalance response as 
2013-03-15T00:00:00.000Z.

End Date Provisioning
The start date defaults to the date the provisioning call is made. The LRR defaults to the start date. The end date defaults 
to the start date plus one month with any necessary modifications of the day to respect the BillCycle value. The start, 
end, and LRR dates can be overridden if a start, end, or LRR date is passed in on the CreateBalance API request. 
Overriding those dates can cause Balance malfunctions if incorrectly set, so use caution!
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Month End Dates Example
Recurring Quota templates are only able to use 1-28 for refresh dates. BillCycle was an enhancement for Recurring quota 
that allows Balance to accommodate the number of days variance of months. If the subscriber's BillCycle is set to 30, 
the refresh in February will be on the 28th or 29th if a leap year, and QueryBalance API responses would show the Next 
Refresh Date as YYYY-02-28 or YYYY-02-29. And once the refresh has occurred and it's now March the system is able 
to reset the Next Refresh date back to the 30th based on the BillCycle and would show as YYYY-03-30. Compare this 
to regular Recurring quota which would change the refresh date to the 28th or 29th permanently for the rest of the year. 
Even if the refresh occurred on January 30th, when February arrived, the refresh would be set to the 28th or 29th if a 
leap year. Unlike BillCycle, once the refresh has occurred and it's now March the system does not know how to reset the 
refresh back to the 30th as is occurred in January for regular Recurring quota. The Next Refresh date would show as 
YYYY-03-28 or YYYY-03-29.

Note: All the dates in Balance such as start, expiration, refresh, etc. have a time element. What is set for the time element 
will affect expiration and refresh time on the given day.

Thresholds
Thresholds allow policy actions to be taken when a certain amount of quota has been used. Actions can be taken on 
threshold breach, unbreach, and continued breach status. Thresholds can be grouped to suppress past threshold 
breaches.

The threshold table in the Policy Builder sets thresholds that will be reported on when breached/unbreached and what 
their current amount is while breached. These messages are sent back to the policy engine from MsBM on Credit, Debit, 
Charge, and Provision functions so that policies can make decisions and take actions based on the threshold breach.

The basic conditions to use in policy configuration are:

 An OCSThresholdBreach exists

 An OCSThresholdUnbreach exists

 An OCSThresholdStatus exists

A typical action upon threshold breach is “Send a SMS notification”. To send an SMS notification, the Notifications feature 
must be installed and configured in the system.

Threshold Event Types
 OCSThresholdBreach: It occurs when a threshold is violated for the first time

 OCSThresholdUnbreach: It occurs when a credit, provision, refresh, or other action causes usage to drop back 
below a given threshold

 OCSThresholdStatus: It is the message that is sent every time an action is conducted against an account where a 
balance threshold or quota threshold is currently exceeded. This message reports the fact that the threshold is still 
breached and what the current level of the breach is.

Note: A threshold is breached when the value is greater than or equal to the threshold value.

Balance Functions That Evaluate Thresholds
 Charge: Checks thresholds of the account balance specified in the charge request and any quotas under that 

account balance whose total changed due to the charge.

 Credit: Checks the thresholds of the account balance and quota specified in the credit request.
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 Debit: Checks the thresholds of the account balance specified in the debit request and all quota codes under that 
account balance unless a quota code is specified on the debit request, in which case, it only checks the thresholds 
of that quota.

 Reserve: Checks all thresholds on the account.

 QuerySubscriber: Checks all thresholds on the account.

Reference Data vs. Subscriber Specific Thresholds

Reference Data Thresholds (RDT)
 Reference Data thresholds (RDT) are defined on the Balance or Quota Template in Policy Builder.

 RDTs are evaluated for all subscribers provisioned with the related balance or quota code whose template has the 
threshold defined.

 RDTs are stored in the reference data that the Policy Engine reads for operational configuration.

Subscriber Specific Thresholds (SST)
 Subscriber Specific thresholds (SST) are defined via API or Policy Action.

 SSTs are only applicable for the subscriber for which the SST was defined via API or Policy Action. You must defined 
the SST individually for each subscriber for which you want the threshold applicable.

 SSTs contain the same types of information as RDTs, but the information is stored on the subscriber account in the 
database.

Unique Names
Thresholds must have unique names. SSTs and RDTs must have unique names as well. The same SST name can be used 
for multiple subscribers, but that value must be unique compared to the name values for the RDTs.

Important Clarifications
 Even though both kinds of thresholds share the same types of information, there is no crossover between the two 

sets of information. RDT definition via the Policy Builder is for RDTs only. SST definition via API is for SSTs only.

 It is important to understand that the codes and information defined in Policy Builder for RDTs have no relationship 
to SSTs.

 If you use an RDT code when creating an SST, the information needs to be defined for the SST and will not read the 
RDT information just because it's the same code.

Threshold Groups
Thresholds with the same value in the Group column will be "grouped" together. When thresholds are grouped in this 
manner, only messages for the first (top to bottom in the table in Policy Builder) threshold breached in the given threshold 
group will be returned.

For example, if you define a 80 percent, a 60 percent, and 50 percent threshold and they are in descending order, top 
to bottom in the table, and put them in a threshold group named CiscoPercents, the system will only send threshold 
messages about the highest threshold breached. This helps reduce duplicate messages. For example, a subscriber's 
usage is at 62%, the subscriber will only get messages about the 60 percent threshold's status. When the usage crosses 
80% and goes to 81%, the subscriber will no longer get the 60 percent threshold's status message, but instead will get 
an 80 percent breach message and moving forward will only get 80 percent threshold status messages.

Note: Order is very important! This functionality is not based on the highest value. If there are two thresholds in a group 
say at 60 percent and 80 percent and they are ordered in the table top to bottom in ascending order, that is, 60 nearest 
the top, the subscriber will never get 80 percent threshold notifications unless you select the amount remaining option 
instead of amount used (default).
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Thresholds and Reduction of Reservation Granted Amounts
A Threshold defined on an Account Balance Template reduces the reservation amount as it nears the threshold. For 
example if the subscriber is 50 MB away from the threshold and the default reservation amount is 100 MB, the reservation 
will be reduced to 50 MB so as to not exceed the threshold.

Note: For all Balance versions/revisions built prior to 7 Jan 2014, reservation amount reduction as a threshold is 
approached only works for thresholds NOT defined as Trigger On Remaining, that is, it only works for thresholds that 
measure the amount used.

A Threshold defined on a Quota Template does NOT reduce the reservation amount as it nears the threshold.

When the reservation granted amount is reduced from the requested amount due to a threshold, the quota granted is 
reduced to the amount between the current usage level and the value where the threshold would be breached. This 
reduction continues on each successive reservation until the Default Minimum Dosage defined on the Balance Plug-in 
Configuration is reached. After that value is reached for the granted amount, the next reservation will go back to normal 
behavior and trigger the OCSThresholdBreachOccurred condition.

Soft vs. Hard Thresholds
Currently, all thresholds in CPS are “soft” thresholds. 

The difference between a soft and hard cap is that the system would still grant the minimum dosage with a soft cap; 
however with a hard cap the system will deny the quota request if the minimum dosage would breach the threshold. The 
plan is that when a hard threshold is implemented, an API call or Policy Action would have to be made to “unlock” the 
threshold to allow reservations to breach the threshold and for normal operation to resume. 

Other Threshold Information
 Thresholds are based on CHARGED amounts. Reserved amounts are not included.

 Thresholds can be defined on the Account Balance Template (monitors all child quotas as an aggregate) and the 
Quota Template (only monitors the credits of that quota).

 Thresholds are based on the total of all currently valid credits under the specified balance/quota. A “currently valid 
credit” is a credit for which its start date is before the current date and its end date is after the current date. For 
example:

a. There is a credit of 1 GB that ends on Oct 15th.

b. There is a percentage threshold at 90%.

c. The subscriber uses 900 MB of data, which triggers the threshold.

d. Another 1 GB credit is applied that ends on Oct 31st.

e. The calculated percentage against the threshold is now 55%. However, if the subscriber waits to use the network 
until after Oct 15th, then the calculated value will be 0%.

 Percentage based balance thresholds are based on the ((amount charged divided by the original amount) * 100) 
across all currently valid credits of all quotas defined under the given balance. For quota thresholds only the currently 
valid credits of that specific quota are considered.

 Using the QuerySubscriber API:

— The original amount that a threshold is compared against can be determined using the calculation of 
balanceTotal + debitedTotal + reservedTotal.

— The amount charged is the debitedTotal.
317



Balance Services

 

Quota Templates
— Therefore a percentage threshold is calculated as (debitedAmount/(balanceTotal + debitedTotal + 
reservedTotal)) * 100.

Depletion and Exhaustion
The Depleted flag is set when isExhausted is set to true and the granted quota is zero on the 
OCSCreateReservationResponse from the Balance Manager.

IsExhausted is set whenever the full requested reservation amount cannot be fulfilled.

Note: Keep in mind that in both cases these conditions may not mean that the balance is completely exhausted 
permanently. If there is more than one reservation against the balance, one of those reservations may only be partially 
charged or released altogether (either through expiration or zero charge) which will release an amount of quota which 
will again become available for use.

Depletion and Exhaustion vs. Thresholds
Depletion and Exhaustion, as discussed above, are based on BOTH Charged and Reserved amounts.

Thresholds are ONLY based on Charged amounts.

This differentiation is particularly important when using 100% or total amount used thresholds. Just because the Depleted 
flag is set to True DOES NOT mean a 100% Threshold will have been breached yet. The outstanding reservations that 
may exist when Depleted is triggered need to be FULLY charged before the Threshold Breach will occur.

Charging Expired Reservations
The Balance Plug-in Configuration contains a field called Expired Reservations Purge Time, which when set allows the 
retention and charging of expired reservations. In some systems with significant lags in usage reporting, this option 
provides a mechanism to maintain more accurate accounting.

The Expired Reservations Purge Time is how long reservations can be charged after they expire as long as quota is not 
exhausted.

 A 0 value for Expired Reservations Purge Time means it doesn’t keep any expired reservations after they expire.

 A non-zero amount is the amount of time in minutes it will keep a reservation and allow charges against said expired 
reservation.

 There is not a recommended value other than zero which is the default for legacy reasons. The value depends on 
how the system is being used, what network device is being used, and how often and how late it reports usage.

Credit Selection Logic for Reservations and Debits
Determining the next active credit to reserve against is done by the following logic:

 Credits belonging to the highest priority (lowest numerical priority value; priority 1 is highest) quotas are examined 
first.

 Credits that are next to expire are examined next. That is, credits with the soonest end date. If there are multiple 
credits with the same soonest end date, then the credit will be selected from that subset as the one with the oldest 
start date.

 If no credits with end dates are found, credits with no end date are examined, and the credit with the oldest start 
date is used first.
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Note: This logic is restricted to a given quota code when a Debit is performed with a quota code specified as opposed 
to a Debit without a quota code which will check across all the quotas defined for the subscriber to find an applicable 
credit.

Rates and Tariff Times
Rates provide a mechanism to alter how quota is billed to a customer. Typically, it's a 1 to 1 relationship. A customer 
uses 1 MB and is charged an amount, say $1, for that 1 MB. By changing the rate, the SP changes the cost that the 
subscriber pays. For example, a rate of 0.25 will charge quota at a cost of 1 MB for every 4 MB used. A rate of 2 will 
charge quota at a cost of 2 MB for every 1 MB used.

The rate is specified when the system makes a reservation. The default rate is 1. 

This section covers the following topics:

 Tariff Times, page 319

Tariff Times
Tariff Times is the CPS nomenclature for defining rates and when to apply them. To determine the current 
TariffSwitchTime, Balance takes the current time (using the time zone specified on the tariff time reference data 
configuration) and checks each switch time in order top to bottom to see if the current time matches a TariffSwitchTime. 
The first tariff switch time that matches (including the associated valid dates OR a holiday date) will be used. The time 
of the tariff switch will be the end of the current tariff period. Then the next tariff switch time is calculated, by taking the 
end of the current tariff switch time, adding one second and searching each tariff switch time (top to bottom) to find the 
first one that matches.

Tariff Times Configuration
This covers setting up rates for any component which uses Autowire Balance. Autowire Balance is the default blueplint 
for Balance that must be configured in the Policy Builder for use in the base system setup. Autowire Balance is an 
extension of the main system blueprint which Cisco engineering refers to as Autowire. 

1. In Policy Builder, select Reference Data tab > Tariff Times.

2. Create a new child.

3. Set the timezone if needed.

4. Make sure that you make rows which cover all 24 hours in a day.
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Note: A Start Time of 00:00 (midnight) is inclusive. An End Time of 00:00 (midnight) is exclusive because 00:00 
technically is the start of any given day. By using 00:00 for the end time instead of 11:59, it allows the system to account 
for all 86,400 seconds (24 hours) in a day.
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5. In Policy Builder, select Service > Use Case Templates.

6. Select Add in Service Configuration. Select BalanceRateConfiguration.

7. Choose an Account Balance Template.

8. Under the Rates List, choose a Tariff Switch Time (Key).

9. Under the Rates List, change the Rate as needed.

10. Click Add Child to add more Rate options.

11. In Policy Builder, select Services > Service Options > Rates.

12. Click Create Child Service Option.
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13. Click Add in Service Configuration. Select BalanceRateConfiguration. 

14. Click File > Publish to Runtime.

Edge Cases
It is strongly recommended that Tariff Switch Times cover all times during a 24 hour period and do not have gaps. Some 
customers use a default Tariff Switch Time entry that covers all the other times that have not been specifically defined.

Tariff Times are not allowed to cross over the midnight boundary for a given day. In practice, this means that often 2 or 
more tariff switch times must be created to cover a single logical period. For Example:

If a Tariff Switch occurs during a daylight savings time forward switch (i.e. between 2:00am and 3:00am during 'Spring 
Forward' in March), an error will occur in processing during that time since that hour is lost. Therefore, it is recommended 
that switch times NOT occur during these times on those days.

Table 5 Edge Cases Example

Name Start Time End Time Tariff Time Identifier

Nights Before Midnight 17:00 00:00 NIGHT

Nights After Midnight 00:00 07:00 NIGHT

Days 07:00 17:00 DAY
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For any given subscriber, the following illustrates the database relationship of the objects described in this chapter. 

An important point to keep in mind when looking at the data structure for MsBM is that this is a document based database 
and not a relational database. The below description attempts to describe the equivalent RDMS concepts as far as 
primary and foreign keys are concerned; however, these concepts are not the same in a document based database, and 
are included merely to assist in providing understanding since most of audiences are familiar with RDMS. 

For example, since Mongo stores data in a structure that is essentially a map of maps, there is no need for the concepts 
of a primary key (PK) or a foreign key (FK) since relationships between the data are defined by the physical structure. 
Conceptual PKs and FKs are only needed when interaction with the QNS system or when the querying is necessary and 
the full document is not retrieved.
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Note: This listing is not a complete listing of all fields (conceptually columns) in each map (conceptually table), but only 
the important fields used for data structuring or querying.

Subscriber Account
 subscriberId (PK)

— Key field to reference a given subscriber account. This account may be shared among multiple subscribers.

— Value is also stored as  _id which is a key field for the Mongo database document. These values were different 
in early versions of MsBM, but have been aligned to ensure greater system stability. The _id was originally a 
Mongo assigned UUID.

 The Subscriber Account contains all data structures related to a specific subscriber's account as it relates to MsBM. 
When you retrieve a Subscriber Account, you obtain all MsBM information for a given subscriber.

Account Balance
 accountBalanceCode (PK within the scope of a given subscriber account) 

— relates to the Account Balance Template reference data information defined in Policy Builder.

— key for Policy Engine to access this balance's information for a selected subscriber account.

 An account balance, or simply a balance as it is often referred to, is essentially a group of quotas. The idea is that a 
customer could create a balance (quota grouping) called Data and within that have several quotas defined, like 
Monthly, Topup, and Bonus. Then when the subscriber uses account, usage is charged against their Data balance 
and MsBM determines which underlying quota should be debited based on rules set up in QNS. The intent here is 
to simplify charging so that specific “buckets” do not need to be specified and necessary business rules can be 
defined once in the Policy Engine.

Quota
 quotaCode (PK within the scope of a given subscriber account)

— relates to the Quota Template reference data information defined in Policy Builder.

— key for Policy Engine to access this quota's information for a selected subscriber account.

 A quota defines the actual amount or “bucket” that can be drawn from for tracking of usage. This value internally is 
unit-less and thus can be defined to be whatever is needed in the implementation. Some units are provided in 
reference data in Policy Builder to assist users. Common usages for quota amounts are bytes of volume, seconds of 
time, but other counts can also be tracked.

Credit
 A UUID (PK) is used as a key to the map containing all the credits for a given quota.

 A UUID was selected since the data structure was defined for transactional speed and stability and was not intended 
to be queried directly. MsBM records are intended to be accessed via the Policy Engine, the provided APIs, and the 
Reporting Engine. The intent in the design of this structure was transactional usage and performance, not 
queryability. A sequence concept or other more predictable key was not used since a sequence would most likely 
be rapidly exhausted and more difficult to manage since credits are regularly created and destroyed as part of the 
normal operation of MsBM. Uniqueness and assurance of avoidance of deadlocking is the primary concern.

 Credits can be viewed as positive entries on an accounting balance sheet.
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Debit
 A UUID (PK) is used as a key to the map containing all the debits for a given credit.

 The reasoning for selection of the UUID is the same as discussed under Credit, page 324.

 Debits can be viewed as negative entries on an accounting balance sheet for a specific credit. Debits under a given 
parent credit cannot exceed the amount of the parent credit.

Reservations
 reservationId (PK)

— Also a UUID and was selected for similar reasons as discussed under Credit, page 324.

 Reservations describe an amount of conditional debiting of quota that is reserved until a network device reports that 
the quota has actually been utilized.

Reservation Debits
 reservationDebitId(PK)

— Also a UUID and was selected for similar reasons as discussed under Credit, page 324.

 reservationId (FK)

 debitId (FK)

 Reservation debits serve the purpose of providing a link between a reservation and an actual debit entry. When a 
reservation is charged, the reservation and associated reservation debits are removed and the debit linked to those 
reservation debits are made permanent. That is, as long as a debit has a linked reservation debit, that debit is not 
permanent, but only reserved in a non-committed state.

Thresholds
The Thresholds collection contains any reference data thresholds (defined in Policy Builder) that are currently breached 
or any user-defined thresholds that are specific to a given subscriber account.

The thresholds map is not utilized and may not appear in all implementations. It will only appear as needed if the related 
functionality in QNS is active.

Expired Reservations
An identical structure as Reservations is used for Expired Reservations, except that Reservation Debits do not have a link 
to Debits. Functionality for charging expired reservations, that is, creating debits, is handled in a different fashion.

The expired reservations map is not utilized and may not appear in all implementations. It will only appear as needed if 
the related functionality in QNS is active.
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Shared Quota
In CPS there are several ways to set up shared quota. SPR supports parent and child profiles, for example one parent in 
a household is the primary SPR record and all the other members of the household are set as child records of that SPR 
profile. This would allow for shared quota and is mostly configured through SPR data management. Because Balance 
and SPR can be used separately, Balance also supports shared quota use cases that are configured solely within the 
Balance module.

Shared Per User Limit Use Case
There will be two Balance accounts associated with a subscriber that is participating in a shared quota but also needs a 
per user limit on said shared quota. The first Balance account is the subscriber's personal account. This account will 
contain any balances/quotas that are only available to the subscriber. This account will also contain one balance that will 
be used for tracking the per user limit. The second Balance account is not owned by the subscriber and contains the 
shared balance/quotas.

Note: The two Balance accounts need to be provisioned separately.

The shared balance template contains a field called Limit Balance that links the shared balance to a limit balance (the 
personal account), so that the Balance module knows which two balance codes it needs to reserve/charge against in the 
shared per user limit case. Since the per use limit is tied to a quota template, only discrete per user limits are supported. 
The number of balance/quota templates defined is not limited, but the templates must be defined for each per use limit 
level. The limit quotas must be defined in a balance/quota template.

The subscriber must be provisioned with the limit balance and an associated quota with a valid amount for the per user 
limit to be enforced. An AVP must added to the subscriber profile in SPR indicating the Balance account record and the 
Balance template name of the shared quota. This is done currently for some deployments. The subscriber must have the 
AVP set up prior to per user limits being available.

If the subscriber does not have the limit balance provisioned, then the subscriber will draw from the shared balance with 
no per user limit enforced.

Hard thresholds (meaning the subscriber cannot use more than a certain amount of the shared quota) will be enforced 
by the amount provisioned in the limit balance.

Soft thresholds (meaning the subscriber can continue to use more up to the hard threshold, but something should happen 
when the soft threshold is crossed) will be supported using the threshold mechanism defined on the limit balance.

The charge and reserve function of the Balance module were enhanced with conditional logic to make new calls to handle 
the shared per user limit reservations. The new calls allow charges or reservations against two Balance accounts at the 
same time. The two Balance accounts are the shared account, as indicated by the AVP, and the subscriber's personal 
balance account (the limit balance).

Policy Engine
The Balance module exposes various policy objects that can be used to monitor the status of an account. Aptly named 
the MsBM Account Status object, it contains information about a specific balance of a given subscriber. Each of the 
subscriber's balances will have its own MsBM Account Status object in the Policy Engine during policy execution.

The Amount Remaining value on the MsBM Account Status object DOES contain the values of any current reservations.

Proration
Balance provides some limited proration capabilities but in general, proration must be handled manually via API calls 
(Credit, Debit, ExtendCredit, CreateBalance).
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Proration Example
A subscriber has 5 GB on the first plan and has used 3 GB of it. The subscriber then switches to a different plan with 2 
GB. The subscriber will start with 2 GB of available quota UNLESS the CreateBalance API overrides the initial amount. 
Setting the override amount is a manual step that is handled by the calling system, i.e. customer portal or OSS/BSS 
application.

Quota Refresh Throttling
Balance has the ability to cause a batch of quota refreshes to be staggered over a time period, which causes session 
wakes up to be staggered, which not only keeps masses of subscriber accounts from being refreshed at the same exact 
time, but also causes any other events related to a session wake up to be staggered, i.e. RARs. This concept is called 
the Callback Validity Time (CBVT). The CBVT is usually set to the time where something changes in a subscriber’s 
balances/quotas. Typically this is the expiration date of their quota. The CBVT is that time at which a session will “wake 
up” and create a new reservation of quota. This "wake up" activity triggers a quota refresh if one is valid for a recurring 
quota.

For example, let's say that 50,000 subscribers on a monthly quota have their quota set to expire at 1 AM and all have 
sessions established. Normally their quota wouldn’t refresh until they next accessed their account, i.e. had an active 
session that made a reservation or other Balance request (the refresh is retroactive however). However, some 
deployments have subscribers who always have a session, but it may not be actively using quota, i.e. idle cable modem. 
In this scenario, at 1 AM, 50,000 subscriber sessions will “wake up” and refresh their accounts which could easily cause 
a serious load spike for system resources.

To combat this problem, the Recurring Refresh Max Delay parameter defined in the Balance Plug-in Configuration, is 
used to pad the CBVT value by a random number of minutes between 0 and the parameter value. If the Recurring Refresh 
Max Delay param is set to 120, then the CBVT value on the session will be set to 1 AM plus a random number of minutes 
chosen from between 0 and 120. Now, the 50,000 sessions will not all wake up at 1 AM. Because the CBVT values are 
set to the range from 1 AM to 3 AM, at any given minute only a small percentage of the total 50,000 sessions will wake 
up and refresh.

Active Session vs. Inactive Session
Any subscriber actively using their quota will refresh immediately at 1 AM when they qualify for the refresh and will not 
have their quota refresh delayed. Only subscribers with sessions that are not actively using quota will have their refreshes 
delayed.
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First Published: June 26, 2015

Last Updated: August 14, 2015

Notification in Policy Builder relates to pushing messages from Policy Builder to subscribers. Service Providers can use 
messages to alert the subscriber to issues as well as opportunities on their network. Not only can you alert subscribers, 
but you can also send messages to any address you wish, perhaps system monitoring addresses.

Currently, Policy Builder offers following notification types:

 Apple Push Notifications, page 329

 Email Notifications, page 333

 SMS Notifications, page 337

 Real Time Notifications, page 345

 Service Option Configuration, page 349

Note: You can configure one or all notification types. By default, no notification type is configured in Policy Builder. User 
needs to configure the notifications based on your requirements.

For more information on how to configure Notification plug-in in Policy Builder, refer to Plug-in Configuration, page 31.

Apple Push Notifications

Notification Configuration
To configure CPS to send a message to a subscriber with an Apple iPhone or other iOS device, perform the following 
steps:

1. Login to Policy Builder.

2. Go to Reference Data tab > Systems > a system or a cluster > Plugin Configurations > Notification 
Configuration.

3. Click the check box next to Apple Push Notification Configuration.
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4. View the Notification Configuration screen that drops down.

The following parameters can be configured under Apple Push Notification Configuration:

5. Go to Message Configuration, page 331 to configure the message to be sent for the notification configuration done 
above.

Table 1 Apple Push Notification Configuration Parameters

Parameter Description

APNS Server Address  Apple Production: Connects to gateway.push.apple.com on port 2195.

 Apple Test: Connects to gateway.sandbox.push.apple.com on port 2195.

 Other: Uses a server address other than the standard Apple ones. It also uses the 
other gateway and server port fields defined in Other Server Gateway and Other 
Server Port fields below.

Recommendation: Other

Other Server Gateway Name of a server gateway if Other is selected as APNS Server Address.

Other Server Port Port number of the server gateway if Other is selected as APNS Server Address.

Certificate The certificate for the authorization to the gateway. You must provide a certificate file 
that is loaded into CPS.

Certificate Password Password added to the certificate when connecting to the APNS.
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Message Configuration
To create the messages for a subscriber’s Apple iPhone or the Apple iOS operating system to be sent by CPS, perform 
the following steps:

1. Select Reference Data tab > Notifications > Apple Push Notifications. 

2. From right side, click Apple Push Notification under Create Child to open the pane as shown below.
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The following parameters can be configured under Apple Push Notification:

To use Apple Push Notifications, we need to configure Service Options. For more information on the configuration, refer 
to Service Option Configuration, page 349.

Table 2 Apple Push Notification Message Configuration Parameters

Parameter Description

Name The name of the notification message. This name is used in the action phrase in the 
policy definition. Best practice is to make this short, but meaningful and unique.

Badge Default is 0 (number).

The number to display as the badge of the Apple Push Notification icon. If this property 
is absent, the badge is not changed. To remove the badge, set the value of this 
property to 0. 

Example: 1, 2, 3, ….

Sound Default is 'default'.

The name of a sound file in the application bundle. The sound in this file is played as 
an alert. If the sound file doesn't exist or default is specified as the value, the default 
alert sound is played. The audio must be in one of the audio data formats that are 
compatible with system sounds. For more information, refer to Preparing Custom Alert 
Sounds.

Example: sound1, alert7, buzzSound_A

Send Once Per Session Click this check box if you want to send the notification once per session.

Custom Fields You can add custom fields with values that can be sent to the application. 

Field Name/Field Value String

Example: 

“high_score”: “1000”

“custom_field_1”: “display1”

“custom_field_2”: “false”

For more information on custom fields, refer to the following links:

 https://developer.apple.com/library/ios/documentation/NetworkingInternet/Concep
tual/RemoteNotificationsPG/Chapters/ApplePushService.html

 http://docs.appcelerator.com/platform/latest/#!/guide/Sending_and_Scheduling_P
ush_Notifications-section-43298780_SendingandSchedulingPushNotifications-
CustomJSONpayloads

Alert This is the text that appears on the subscriber’s iPhone. If the message is too long, it 
is simply truncated. Test your messages before you place into production. 

If you want to use a string, and substitute session information, use the syntax $Name, 
for example, to insert the receiver’s name in the email. 

Alerts are limited to 160 characters. Alerts longer than that are truncated.
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Notification Configuration
To configure CPS to send an email notification to a subscriber, perform the following steps:

1. Login to Policy Builder.

2. Go to Reference Data tab > Systems > a system or a cluster > Plugin Configurations > Notification Configuration.

3. Click the check box next to Email Notification Configuration.

4. View the Notification Configuration screen that drops down.

The following parameters can be configured under Email Notification Configuration:

Table 3 Email Notification Configuration Parameters

Parameter Description

Mail Server Address URL of the mail server through which email goes through. Only IMAP email is supported 
at this time.

Login/Password Enter any login and password information needed.

Enable TLS Enables transport layer security. This option is used for connecting to services other 
than basic IMAP services, such as Google’s Gmail. 

Smtp Port Specifies the SMTP port. This option is used for connecting to services other than basic 
IMAP services, such as Google’s Gmail.
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Here is an configuration using the smtp provided by gmail as an example.

5. Go to Message Configuration, page 334 to configure the message to be sent for the notification configuration done 
above.

Message Configuration
Substitution value can be set from SPR, Balance, or the session and placed in the email body using $[variable]. 

In the following example, we are using a subscriber AVP code for email. The value “$email” is used in the body of the 
text and replaced then the email is sent. 
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We are also using $timeStamp to add the Date/Time.

The following parameters can be configured under Email Notifications:

Table 4 Email Notification Message Configuration Parameters

Parameters Description

Name Name of the message.

Message Encoding (DCS) Select the required message coding from drop-down list. Valid values are ISO-8859-1, 
US-ASCII, UTF-16 (UCS-2) and UTF-8. Default value is UTF-8.

Subject This is the subject line of the email to the subscriber. 

From Email Address The From field in the email.
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To pull the values from SPR and replace in the email, we use the service option setting from the notification:

For the timestamp, use the Value Retriever. 

For the email, select from the “Pull value from…” column. 

Reply To Email Address Who the subscriber may reply to.

Body (Text/Plain) The text of the email the subscriber receives in plain format.

Body (Text/HTML) The text of the email the subscriber receives in HTML format.

Table 4 Email Notification Message Configuration Parameters

Parameters Description
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For reference, our subscriber has a Custom Data AVP set in the details of his subscriber record. This is where the value 
is being pulled from in Control Center:

In the logs, you will see the following if you have notifications set to debug. 

Logging:
2015-05-01 14:34:46,345 [pool-2-thread-1] DEBUG c.b.n.impl.NotificationsManager.? - Email encoding : 
UTF8
2015-05-01 14:34:46,345 [pool-2-thread-1] DEBUG c.b.n.impl.NotificationsManager.? - Email Text body :
Date/Time: 1430512486305
Dear bob@cisco.com, your new session has started
2015-05-01 14:34:46,345 [pool-2-thread-1] DEBUG c.b.n.impl.NotificationsManager.? - Email HTML body : 
<br/><br/>
Date/Time: 1430512486305
<br/><br/>
<b>Dear bob@cisco.com, your new session has started. </b>

To use Email Notifications, we need to configure Service Options. For more information on the configuration, refer to 
Service Option Configuration, page 349.

SMS Notifications

Notification Configuration
To configure CPS to send an email notification to a subscriber, perform the following steps:

1. Login to Policy Builder.

2. Go to Reference Data tab > Systems > a system or a cluster > Plugin Configurations > Notification Configuration.

3. Click the check box next to SMS Notification Configuration.
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4. View the Notification Configuration screen that drops down.
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The following parameters can be configured under SMS Notification:

Other then the above mentioned parameters, the user can configure the following parameters after selecting Retry check 
box.

Table 5 SMS Notification Configuration Parameters - 1

Parameter Description

SMSC Host Address The TCP/IP address or host name of the SMPP server, that is, the URL of the SMSC host 
that pushes the SMS message.

SMSC Port The TCP/IP port on the SMPP server to which the gateway connects.

System ID The user name for the gateway to use when connecting to the SMPP server

Password The password for the gateway to use when connecting to the SMPP server.

System Type An optional login parameter used only if required by the SMPP server. The SMPP system 
administrator provides this value, usually a short text string.

Registered Delivery Optional field for some custom deployments. 

DataCoding (Advanced 
Use Only)

Optional field for some custom deployments. 

Data Coding can be used instead of the Message Encoding and the other DCS fields on 
the Notification message definition screen, but should be used with care. 

Note: If it is necessary to use a specific value in this field for data coding, then the 
message alphabet information should be included in the Data Coding value per the SMS 
specification as well as any other necessary data coding information. The result is a 
combination of the capabilities of the SMSC and is not totally controlled by QPS.

Priority Flag Optional field for some custom deployments.

Binding Type TX (transmit)

or

TRX (transceiver)

Enquire Link Time Specifies the Enquire Link Timer value. The plug-in instance performs an Enquire Link 
operation to the SMSC to keep the connection alive. The time between inquiries is 
specified by this timer value. Default value is 5000 seconds.

Reconnect If checked, CPS will check connection to the SMSC at the interval specified in the 
“Reconnect Smsc Time” field.

Reconnect Smsc Time The interval to check the connection to the SMSC, and reconnect if lost. This will check 
the primary and secondary if the secondary properties are set.
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The following parameters can be configured under Retry.

Secondary SMSC is a repeat. Secondary SMSC should only be filled out if secondary SMSC is available and required.

Go to Message Configuration, page 340 to configure the SMS message to be sent for the notification configuration done 
above.

Message Configuration
To create the SMS to be sent by CPS, perform the following steps:

1. Select Reference Data tab > Notifications > SMS Notifications. 

Table 6 SMS Notification Configuration Parameters - 2

Parameter Description

No. Of Retries Number of retries allowed to resubmit the message.

Retry Interval Interval in which message are resubmitted until success.
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2. From right side, click SMS Notification under Create Child to open the pane as shown below.

The following parameters can be configured under SMS Notification:

Table 7 SMS Notification Message Configuration Parameters

Parameter Description

Name Name of the notification message. This name is used later in the policy definition to 
send the SMS.

Source Address Source address of the SMS message.

Address TON Type of Number for the source. It defines the format of the phone numbers.

Values: ABBREVIATED, ALPHANUMERIC, INTERNATIONAL, NATIONAL, 
NETWORK_SPECIFIC, SUBSCRIBER_NUMBER, UNKNOWN
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Address NPI Numbering Plan Indicator. It defines the format of the addresses.

Values: DATA, ERMES, INTERNET, ISDN, LAND_MOBILE, NATIONAL, PRIVATE, TELEX, 
UNKNOWN, WAP

Message Class (DCS) The message class per the SMPP specification. Valid values are CLASS0, CLASS1, 
CLASS2. Default value is CLASS1.

Message Encoding (DCS) Defines the alphabet and byte encoding used for the message. Valid values are 
US-ASCII (7 bit), ISO-8859-1 (8 bit), and UTF-16 (UCS-2) which is 16 bit. Default 
value is US-ASCII.

Override Character Limit 
(Advanced)

Some SMSCs create multi-part messages for long SMS messages instead of having 
CPS create the multiple messages. This option provides such behavior by overriding 
the default single message size.

This option is for advanced use only. The reason is that if space in the message 
submitted from CPS does not allow for header information, such as the User Data 
Header (UDH), then many SMSC are not accepted the messages at all. 

Compressed (DCS) Select this check box to set whether compression is used per the SMPP specification. 
Default is false.

Use Plugin Config Data 
Coding Instead (DCS)

Select this check box when you want to use the value specified in Data Coding field 
in the Notifications Configuration screen instead of the Message Class, Message 
Encoding, Compressed, and Contain Message Class values on this screen. 

Contain Message Class Select this check box to set whether the contain message class options is used per 
the SMPP specification. Default is false.

Use Message Encoding with 
Plugin Config Data Coding

Select this check box when the “Use Plugin Config Data Coding Instead” check box 
above is checked. The check box “Use Plugin Config Data Coding Instead” must be 
true to use this value. 

This check box allows the Message Encoding value on this screen to define the byte 
conversion method that is used in conjunction with the Data Coding value in the 
Notifications Configuration screen.

By default, the byte conversion method is US-ASCII regardless of the Plugin 
Configuration’s Data Coding value. Other UTF-16 conversions may use Big Endian, 
Little Endian or Byte Order Mark (BOM). 

This field is also important for ensuring the proper division of messages, particularly 
for non-English languages, for multi-part SMS message support.

Message The text that the subscriber receives. 

SMS messages have character limits dependent on the selected DCS values. Text in 
excess of this limit triggers the submission of the multi-part messages to the SMSC. 

Table 7 SMS Notification Message Configuration Parameters

Parameter Description
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WAP Settings
WAP push over SMS has been added to facilitate another way of initiation of notification from ANDSF server to the client 
(UE).
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The following parameters can be configured under WAP Push Configuration::

For more information on WAP fields, refer to 
http://technical.openmobilealliance.org/Technical/release_program/docs/DM/V1_2_1-20080617-A/OMA-TS-DM_No
tification-V1_2_1-20080617-A.pdf.

Table 8 WAP Push Configuration Parameters

Parameter Description

Version String, version of WAP message. This can be updated to reflect changes. For 
example, 1.0, 2.0, 2.1. 

No characters are allowed. Only numbers or '.' are allowed.

UI Mode (User Interactive Mode): This field specifies the server recommendations whether the 
server wants the management session to be executed in background or show a 
notification to the user.

Values: NOT_SPECIFIED, INFORMATIVE, BACKGROUND, USER_INTERACTION

Default is NOT_SPECIFIED.

 NOT_SPECIFIED: Specifies that the server doesn't have a recommendation to this 
element. 

 INFORMATIVE: Specifies that the server recommends the client to display an 
informative notification or maybe emitting a beep sound announcing the 
beginning of the provisioning session to the device user. 

 BACKGROUND: Specifies that the server recommends the management action 
SHOULD be done as a background event. 

 USER_INTERACTION: Specifies that the server recommends the client to prompt 
the device user for acceptance of the offered management session before the 
management session takes place.

Initiator Specifies how the server has interpreted the initiation of the management action, 
either because the end user requested it or because the server has management 
actions to perform. Value from drop down is added to the WAP message and does not 
trigger any action on the CPS side. 

 Client: Specifies that the end user caused the device management session to 
start. 

 Server: Specifies that the server (operator, enterprise) caused the device 
management session to start.

Session Id Length Integer - Up to 16

SessionID Session Id is 16 bits which is 2 ASCII character according to the specification. 
However, there is no restriction on ANDSF session-id size, it can be of any length. In 
PB, session-id length is made configurable per notification template (Shown in 
snapshot above). When actual session id length is greater that the configured size 
then the notification would not be sent and an error would be logged. 

However if session is less than the configured size, then zero would be prefixed in 
order to make sure that it satisfies session-id length configured in PB. It is assumed 
that the client would strip off the prefix and send the server initiated policy pull.

ServerID String - Up to 255 Characters

The field specifies the Server Identifier of the management server. For example, 
“Server_1”, “WAP_SERVER_2”
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Real Time Notifications
To use SMS Notifications, we need to configure Service Options. For more information on the configuration, refer to 
Service Option Configuration, page 349.

Real Time Notifications
Realtime Notifications allows you to send SOAP/XML messages to a defined server when policy thresholds are breached. 
The information related to realtime notification is provided in the following feature files:

 For AIO Setup:

In /etc/broadhop/pb/features: 

— com.broadhop.client.feature.notifications 

In /etc/broadhop/pcrf/features: 

— com.broadhop.notifications.local.feature 

— com.broadhop.notifications.realtime.service.feature 

— com.broadhop.notifications.service.feature 

 For HA Setup:

In /etc/broadhop/pb/features: 

— com.broadhop.client.feature.notifications 

In /etc/broadhop/pcrf/features: 

— com.broadhop.notifications.local.feature com.broadhop.notifications.service.feature 

In /etc/broadhop/iomanagers[01/02]/features: 

— com.broadhop.notifications.realtime.service.feature

Notification Configuration
1. Login to Policy Builder.

2. Go to Reference Data tab > Systems > a system or a cluster > Plugin Configurations > Notification Configuration.

3. Click the check box next to Realtime Notification Configuration.

4. View the Notification Configuration screen that drops down.
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Real Time Notifications
The following parameters can be configured under Realtime Notification Configuration:

Go to Message Configuration, page 346 to configure the realtime notification message to be sent for the notification 
configuration done above.

Message Configuration
To create the realtime notification to be sent by CPS, perform the following steps:

1. Select Reference Data tab > Notifications > Real Time Notifications. 

2. From right side, click Real Time Notification under Create Child to open the pane as shown below.

Table 9 Realtime Notification Configuration Parameters

Parameters Description

Failed XML Directory File system path where failed notifications are stored. So when CPS 
is not able to send notification on both HTTP URL and HTTP Fallback 
URL then that notification is stored in this path.

The path to the failed XML directory needs to be created manually on 
lb's (lb01 and lb02). 

Max Storage allowed for failed XMLs (in MB) Maximum size up to which CPS can store failed notifications in the 
XML failed directory.
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The following parameters can be configured under Real Time Notification:

Text output below is an example for reference only.
<?xml version="1.0" encoding="utf-8"?>
   <soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:ser="http://localhost:8080/dataTest/services/">
   <soapenv:Header/>
   <soapenv:Body>
      <ser:NewServiceStartedRequest>
         <UserId>$userId</UserId>
         <Balance>$balance</Balance>
         <Quota>$quota</Quota>
         <Timestamp>$timeStamp</Timestamp>
      </ser:NewServiceStartedRequest>
   </soapenv:Body>
</soapenv:Envelope>

Service Option
 Adding substitute values into the message body. 

To substitute any value into your message, add the character '$' to the beginning of the variable name. For example, 
$userName.

Table 10 Realtime Notification Message Configuration Parameters

Parameter Description

Name Name of the realtime notification message.

No of Retries When CPS sends realtime notification to the provided HTTP URL 
and if it is not reachable then this field specifies how many times 
CPS should send the notification. Same is true for HTTP Fallback 
URL.

Default: 3

Retry Interval (secs) Interval during two retries.

Default: 2

Send Once Per Session If checked, realtime notifications are generated for each session 
and not for all messages within that session.

Default: Checked (true)

HTTP URL Primary URL where CPS sends realtime notifications.

HTTP Fallback URL When Primary URL is not reachable then CPS tries to send 
notification to this URL as per configured No of Retries. When 
number of retries are exhausted then it tries to send notification to 
the HTTP Fallback URL.

HTTP Post XML Parameter name (Keep this 
field if not applicable, Eg: SOAP)

For SOAP this field is not applicable and hence should be blank. 
This field specifies HTTP Post parameter name.

XML Template (Text/XML) This field has XML template, so as per configured template realtime 
notifications are generated. CPS provides values to the fields 
specified in the template from the ongoing session and for any field 
which is specified in the template but no value is found then that 
field goes as blank in the generated realtime notification.
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This set of substitute variables are used as an example for Real Time Notifications. The XML Template above has 
these four variables that we will replace with values from the session and post to the HTTP URL defined in the 
Notifications Plug-in.

 The HTTP URL is the destination of the message, and this is not set as an attribute of the subscriber like the other 
notifications. 

— $userId

— $balance

— $quota

— $timeStamp 

You assign the variables their values in the Notification Service Parameters. An example configuration is shown 
below. 

There are five values provide for the example configuration above.

— Notification To Send: Select the Real Time Notification you want from the list.

Message Parameters:

— userId: This value is pulled using the Session User Name Retriever. Use the select box from the Value Retriever 
field. 

— balance: This value is pulled using the Balance Code Retriever. Use the select box from the Value Retriever field. 

— quota: This value is pulled using the Balance Code Retriever. Use the select box from the Value Retriever field. 

— timestamp: This value is pulled using the Timestamp Retriever. Use the select box from the Value Retriever field.

For more information on service options, refer to Service Option Configuration, page 349.
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Service Option Configuration
This section provides an example Service Options configuration which can be used for SMS, EMAIL, Apple Push, and 
GMC notifications. The bodies of the messages are identical to make the service options parameters simpler to follow.

Adding substitute values into the message body. 
To substitute any value into your message, add the character '$' to the beginning of the variable name. For example, Ex. 
$userName. 

This set of substitute variables are used as an example for SMS, EMAIL, Apple Push, and GCM. 

 $timeStamp

 $userId

 $nickName, 

You assign the variables their value using the Notification Service Parameters. 

There are four values provide for the example configuration. 

1. Notification To Send: Select the Notification you want from the list.

Message Parameters:

2. Timestamp: This value is pulled using Timestamp Retriever. Use the select box from the Value Retriever field. 

3. userId: This value is pulled using Session User Name Retriever. Use the select box from the Value Retriever field. 

4. Nickname: We are filling this value using the Subscriber AVP Code action, pulling from the Custom Data attached to 
the subscriber. You can see these values in the Control Center. 
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nickName example: Custom AVP in the Control Center

Apple Push Notification Destination
By default, this notification will go the Destination set in the Notifications section under the subscriber details for the type 
of Notification being sent. 

For example, an Apple Push message will go to Apple Push Destination, and SMS to SMS, etc.
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To override the destination set for the subscriber, you can use the Override Destination field in the Service Option. 
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